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Hardware Overview of the Modem Router

1

The NETGEAR Nighthawk X8 AC5300 Tri-Band WiFi VDSL/ADSL Modem Router (Model D8500) is the next
wave in WiFi. With Tri-Band Quad Stream performance, Nighthawk delivers combined WiFi speeds of up to 5.3
Gbps. Four external active antennas combined with four internal antennas amplify and maximize WiFi range.
The X8’s powerful 1.4 GHz dual-core processor gives you a high-performance networking engine for faster
connections. Aggregate two of the Gigabit ports to double your wired speeds to network-attached storage.
Quad-Stream with MU-MIMO support allows you to enjoy simultaneous streaming to your devices for faster
speeds than traditional WiFi.
The Nighthawk X8 AC5300 Tri-Band WiFi VDSL/ADSL Modem Router (Model D8500) is compatible with most
major DSL Internet service providers and also supports cable Internet service.
This chapter contains the following sections:
•

Unpack the Modem Router on page 10

•

Top and Front Panels With LEDs and Buttons on page 10

•

Rear Panel With Ports, Buttons, and a DC Connector on page 13

•

USB Ports on the Right Panel on page 13

•

Product Label on page 14
Note For more information about the topics covered in this manual, visit the support website
at support.netgear.com.

Note In this manual, the Nighthawk X8 AC5300 Tri-Band WiFi VDSL/ADSL Modem Router
(Model D8500) is referred to as the modem router.
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Unpack the Modem Router
Your package contains the NETGEAR Nighthawk X8 AC5300 Tri-Band WiFi VDSL/ADSL Modem Router
(Model D8500), a DSL microfilter (varies by region), an Ethernet cable, a phone cable, and power adapter
(varies by region).

Figure 1. Package contents

Top and Front Panels With LEDs and Buttons
The status LEDs are located on the top of the modem router. Buttons are on the front, and the USB ports
are on the right panel.

Figure 2. Modem router top panel LEDs and front panel buttons
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Table 1. LED descriptions
LED

Description

Power
•

Solid amber. The modem router is starting.

•

Blinking amber. The firmware is upgrading or the Reset button was pressed.

•

Solid white. The modem router is ready.

•

Blinking white. The firmware is corrupted.

•

Off. Power is not supplied to the modem router.

•

Solid white. The modem router is connected to a DSL service and the DSL
connection is ready or the modem router is connected to a cable service and
the Internet connection is ready.

•

Solid amber. The modem router is not connected to a DSL service, did not
establish a DSL connection, or did not establish an Internet connection.

•

Alternating white and amber. The traffic meter is enabled and the traffic
limit is reached.

•

Off. The modem router cannot connect to the Internet, the Internet connection
failed, or the DSL link is not ready for connection.

DSL/Internet

Note After you connect a DSL cable to the modem router, it takes
about 40 seconds before the DSL/Internet LED lights.

2.4 GHz WiFi
•

Solid white. The 2.4 GHz WiFi radio is operating.

•

Blinking. The modem router is sending or receiving WiFi traffic.

•

Off. The 2.4 GHz WiFi radio is off.

•

Solid white. The 5 GHz WiFi radio is operating.

•

Blinking. The modem router is sending or receiving WiFi traffic.

•

Off. The 5 GHz WiFi radio is off.

5 GHz WiFi 1 and 5 GHz WiFi 2

Hardware Overview of the Modem Router
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Table 1. LED descriptions (Continued)
LED

Description

USB 3.0 port 1 and USB 2.0 port
2
•

Ethernet ports 1–6

Solid white. A USB device is connected to the USB port and is ready.

•

Blinking. A USB device is plugged into the USB port and is trying to connect.

•

Off. No USB device is connected to the USB port, or someone clicked the
Safely Remove Hardware button and it is now safe to remove the attached
USB device.

The LED color indicates the speed: white for Gigabit Ethernet connections and
amber for 100 Mbps or 10 Mbps Ethernet connections.
•

Solid. A powered-on device is connected to the Ethernet port.

•

Blinking. The Ethernet port is sending or receiving traffic.

•

Off. No powered-on device is connected to the Ethernet port.

Note For information about troubleshooting with the LEDs, see Troubleshoot With the LEDs
on page 250.

Table 2. Front panel button descriptions
Button

Description

LED

Pressing this button changes the LED mode.
•

Mode one. All LEDs stay on and blink.

•

Mode two. All LEDs stay on but do not blink.

•

Mode three. Only the Power LED stays on and the other LEDs are off.

WPS

Pressing this button lets you use WPS to join the WiFi network without typing the
WiFi password. For more information, see Join the WiFi Network of the Modem
Router on page 19.

WIFI

Pressing this button for two seconds turns the 2.4 GHz, 5 GHz 1, and 5 GHz 2
WiFi radios on and off.

Hardware Overview of the Modem Router
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Rear Panel With Ports, Buttons, and a DC Connector
The rear panel components are shown in the following figure.

Figure 3. Rear panel
Viewed from left to right, the rear panel contains the following components:
•

Internet port. One Gigabit Ethernet RJ-45 WAN port to connect the modem router to a cable modem.
This port is colored yellow. Use either the Internet port or the VDSL port for your Internet connection.

•

VDSL port. One RJ-11 DSL port for connecting the modem router to an ADSL or VDSL line. This port
is colored gray and is labeled VDSL but can also be used for an ADSL connection. Use either the VDSL
port or the Internet port for your Internet connection.

•

Ethernet LAN ports. Six Gigabit Ethernet RJ-45 LAN ports to connect the modem router to LAN devices.
You can use Ethernet AGGREGATE ports 1 and 2 to cable a device to the modem router that supports
Ethernet port aggregation. For information about Ethernet port aggregation, see Manage Ethernet Port
Aggregation on page 163.

•

Reset button. Pressing the Reset button returns the modem router to its factory settings. For information
about the factory settings, see Factory Settings on page 260.

•

Power On/Off button. Press the Power On/Off button to provide power to the modem router.

•

DC power connector. Connect the power adapter that came in the product package to the DC power
connector.

USB Ports on the Right Panel
Two USB ports are located on the right panel. To access the ports, open the USB port cover as shown.

Hardware Overview of the Modem Router
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Figure 4. A USB 3.0 port and a USB 2.0 port are located on the right

Product Label
The product label on the bottom panel of the modem router lists the login information, WiFi network name
(SSID), password (network key), serial number, and MAC address of the modem router, as well as other
information.

Figure 5. Modem router label
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Install and Access the Modem Router
and Its Network
This chapter describes how to install and access the modem router and its network.
The chapter contains the following sections:
•

Position Your Modem Router on page 16

•

How Active Antennas Improve WiFi Performance on page 17

•

Position the Active Antennas on page 17

•

Connect to the Modem Router on page 18

•

Set Up Your Modem Router for DSL Service on page 21

•

Set Up the Modem Router for Cable Service on page 26

•

Log In to the Modem Router After Setup to View or Change Settings on page 30

•

Change the Language on page 31

•

Access the Modem Router With NETGEAR genie Apps on page 32
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Position Your Modem Router
The modem router lets you access your network anywhere within the operating range of your WiFi network.
However, the operating distance or range of your WiFi connection can vary significantly depending on the
physical placement of your modem router. For example, the thickness and number of walls the WiFi signal
passes through can limit the range.
Additionally, other WiFi access points in and around your home might affect your modem router’s signal.
WiFi access points are routers, repeaters, WiFi range extenders, and any other device that emits a WiFi
signal for network access.
Position your modem router according to the following guidelines:
•

Place your modem router near the center of the area where your computers and other devices operate
and within line of sight to your WiFi devices.

•

Make sure that the modem router is within reach of an AC power outlet and near Ethernet cables for
wired computers.

•

Place the modem router in an elevated location, minimizing the number walls and ceilings between the
modem router and your other devices.

•

Place the modem router away from electrical devices such as these:

•

-

Ceiling fans

-

Home security systems

-

Microwaves

-

Computers

-

Base of a cordless phone

-

2.4 GHz cordless phone

-

5 GHz cordless phone

Place the modem router away from large metal surfaces, large glass surfaces, insulated walls, and
items such as these:
-

Solid metal door

-

Aluminum studs

-

Fish tanks

-

Mirrors

-

Brick

-

Concrete

If you are using adjacent access points, use different radio frequency channels to reduce interference.
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How Active Antennas Improve WiFi Performance
The growing number of WiFi devices in the home combined with the increasing demand for high-speed WiFi
connectivity places extraordinary demands on the WiFi infrastructure. To meet this demand, many WiFi
routers now use external antennas and high-power amplifiers to maximize signal power and extend WiFi
coverage throughout your home.
Increased signal power on the modem router is important, but effective WiFi connectivity requires two-way
communication between the modem router and clients such as smartphones, tablets, and laptops.The client
must acknowledge every WiFi data packet sent by the modem router. Otherwise, the modem router resends
the data packet. A strong signal from the modem router without a corresponding boost in signal from the
client to the modem router does not provide you with the full benefit.
Mobile devices continue to get smaller, while adding more features and reducing power consumption to
extend battery life. Since mobile device WiFi signal power and performance are not improving, modem
router technology is evolving to find ways to compensate and improve the client-to-modem router WiFi
signal. One passive approach to addressing this problem is to add low noise amplifiers (LNA) on the modem
router to amplify the received signal. The modem router’s external antennas transmit the received WiFi
signal to the modem router. The issues with this approach are twofold. Transmitting the signal from the
external antenna to the modem router reduces the signal strength and quality. In addition, the modem router
injects noise from other components. The received signal deteriorates and noise is injected, which reduces
the efficacy of the received transmission.
Active antennas solve these problems. Active antennas move the powered amplification component (the
LNA) to the antenna itself instead of using the modem router. This eliminates signal loss during transmission
since the active antenna directly amplifies the received signal. In addition, since no noise from the modem
router components is present in the antenna, the amplified signal is cleaner.
The modem router receives a much cleaner and less noisy signal for amplification, significantly improving
the received signal and providing a clean, powerful signal that extends WiFi coverage and performance.
Active antennas help reduce the mismatch between the sent and the received signals by compensating for
the relatively poor WiFi on the client side. This WiFi improvement is seen across all devices–new and old–but
helps mobile devices the most.

Position the Active Antennas
The modem router’s four active antennas include a built-in receiver low noise amplifier (LNA), for high-speed
WiFi connections and excellent range. Both the 2.4 GHz and the 5 GHz low band (WiFi Channels 36–48
and 52–64) use the active antennas. The 5 GHz high band (WiFi Channels 100–140 and 149–165) uses
the passive antenna.
The best position for the active antennas depends on the layout for your home or office. We recommend
the following antenna positions:

Install and Access the Modem Router and Its Network
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•

For a large single-story home (about 2,500 to 4,000 square feet in size), position all four antennas
vertically and place the router on a table.

Figure 6. Antennas positioned vertically
•

For a multilevel home, position the two antennas in the center vertically, and position the other antennas
at a 45-degree outward angle.

Figure 7. Two antennas in the center positioned vertically, the other antennas at a
45-degree outward angle

Connect to the Modem Router
During and after installation, you can connect to the modem router’s network through a wired or WiFi
connection. If you set up your computer to use a static IP address, change the settings of your computer
so that it uses Dynamic Host Configuration Protocol (DHCP).

Install and Access the Modem Router and Its Network
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Connect to the Modem Router Through an Ethernet Cable
You can connect your computer to the modem router using an Ethernet cable and join the modem router’s
local area network (LAN).

To connect your computer to the modem router with an Ethernet cable:
1. Make sure that the modem router is receiving power (its Power LED is lit).
2. Connect an Ethernet cable to an Ethernet port on your computer.
3. Connect the other end of the Ethernet cable to one of the numbered Ethernet ports.
Your computer connects to the local area network (LAN). A message might display on your computer
screen to notify you that an Ethernet cable is connected.

Join the WiFi Network of the Modem Router
Choose either the manual or the WPS method to add a WiFi device such as a WiFi-enabled computer, an
iPhone, an iPad, another mobile device, or a gaming device to the WiFi network of the modem router.

Manual Method
On the computer or mobile device that you want to connect to the modem router, you can use the software
application that manages your WiFi connections.

To connect a computer or mobile device manually to the WiFi network of the modem router:
1. Make sure that the modem router is receiving power (its Power LED is lit).
2. On the computer or mobile device that you want to connect to your modem router, open the software
application that manages your WiFi connections.
This software scans for all WiFi networks in your area.
3. Look for the modem router’s network and select it.
If you did not change the name of the network during the setup process, look for the default WiFi network
name (SSID) and select it. The default SSID is on the modem router label.

4. Enter the modem router WiFi password.
The default WiFi password (also referred to as the network key or passphrase) is also on the modem
router label.
5. Click the Connect button.
The device connects to the WiFi network of the modem router.

Install and Access the Modem Router and Its Network
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Wi-Fi Protected Setup Method
Wi-Fi Protected Setup (WPS) is a standard for easily adding computers and other devices to a home network
while maintaining security. To use WPS (Push 'N' Connect), make sure that all WiFi devices to be connected
to the network are Wi-Fi certified and support WPS. During the connection process, the client gets the
security settings from the modem router so that every device in the network supports the same security
settings.

To use WPS to connect a device to the WiFi network of the modem router:
1. Make sure that the modem router is receiving power (its Power LED is lit).
2. Check the WPS instructions for your computer or mobile device.
3. Press the WPS button of the modem router for three seconds.
4. Within two minutes, press the WPS button on your computer or mobile device, or follow the WPS
instructions that came with the computer or device.
The WPS process automatically sets up the computer or device with the network password and connects
the computer or device to the WiFi network of the modem router.
For more information, see Use WPS to Add a Device to the WiFi Network on page 96.

Types of Logins
Separate types of logins serve different purposes. This section describes the differences so that you know
which login to use when.
Types of logins:
•

ISP login. The login that your Internet service provider (ISP) gave you logs you in to your Internet
service. Your ISP gave you this login information in a letter or some other way. If you cannot find this
login information, contact your ISP.

•

WiFi network key or password.Your modem router is preset with a unique WiFi network name (SSID)
and password for WiFi access. This information is on the modem router label. Use this information to
connect a computer or mobile device to the WiFi network of the modem router.

•

Modem router login. This logs you in to the modem router’s web pages from a web browser as admin.

Automatic Internet Setup
You can use the NETGEAR installation assistant to set up the modem router automatically or you can use
the modem router’s web pages to set up the modem router manually. The installation assistant launches
the first time that you set up the Internet connection for your modem router and runs on any device with a
web browser.
The installation assistant functions with both types of Internet service that the modem router supports:
•

DSL service. You can install your modem router for DSL service (the modem router supports ADSL
and VDSL service). For more information, see Set Up Your Modem Router for DSL Service on page
21.

•

Cable service. You can install your modem router for cable service. For more information, see Set Up
the Modem Router for Cable Service on page 26.
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Note After initial installation and setup, the NETGEAR Setup Wizard is always accessible
to assist you with setting up an installation with DSL service or an installation with
cable service. For more information, see Use the Internet Setup Wizard After Initial
Setup on page 34.
Whether you install your modem router for DSL service or for cable service, you can always use the modem
router’s web pages to set up the modem router manually.
Before you start the setup process, get your ISP information and make sure that the settings that are
described here are specified for the computers and devices in the network.
When your Internet service starts, your Internet service provider (ISP) typically gives you all the information
that you need to connect to the Internet. For DSL service, you might need the following information to set
up your modem router:
•

The ISP configuration information for your DSL account

•

ISP login name and password

•

Fixed or static IP address settings (special deployment by ISP; this setting is rare)

If you cannot locate this information, ask your ISP to provide it. When your Internet connection is working,
you no longer need to launch the ISP login program on your computer to access the Internet. When you
start an Internet application, your modem router automatically logs you in.

Set Up Your Modem Router for DSL Service
You can install your modem router for DSL service or for cable service. If you use a DSL modem, follow the
procedure that is described in Cable the Modem Router for DSL Service and Access the Modem Router on
page 22. If you use a cable modem, follow the procedure that is described in Set Up the Modem Router for
Cable Service on page 26.

DSL Service
Make sure that your ADSL or VDSL service is active before you install the modem router. You need the
following information to install your DSL modem and connect to the Internet:
•

DSL user name and password. This information is included in the welcome letter that your DSL Internet
service provider (ISP) sent you when you signed up for your service. Record your DSL Internet service
account user name and password.

•

Your telephone number or DSL account number. If you do not use voice service, you can use your
DSL account number in place of a phone number.

If you do not know or cannot locate your DSL user name and password, call your DSL ISP. Be specific when
speaking with your DSL ISP. For example, you could say, “I need my DSL service user name and password.
Can you help me?”
Note If your provider says that they do not support NETGEAR services, tell them that you
need only your DSL user name and password. You do not need support.
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Cable the Modem Router for DSL Service and Access the
Modem Router
The NETGEAR installation assistant can detect the type of ISP connection and presents pages on which
you can you enter the required information. The following procedure describes common steps that you must
follow for most ISPs. For some ISPs, you might need to enter additional information. For a small number of
other ISPs, you also might need to configure less common options such as IPTV and DHCP Option 61. If
these option are required, the NETGEAR installation assistant will present them to you.
The following figure shows the cabling of your modem router for DSL service.

Figure 8. Modem router cabling for DSL service
To connect your modem router to a DSL service:
1. Install a DSL microfilter between the phone line and the phone.
The product package contains a DSL microfilter.
2. Use a phone cable to connect the microfilter to the gray DSL port on the modem router.
The product package contains a phone cable.
3. Connect the power adapter to the modem router and plug it into an electrical outlet.
Wait for the Power LED to light solid white, which takes about two minutes.
4. If the Power LED does not light, press the Power On/Off button on the back panel.
5. If the WiFi LED does not light, press the WIFI button.
6. Check the DSL/Internet LED.
If the modem router is connected to a DSL service, the DSL/Internet LED lights white.
7. Connect a computer to the modem router by one of the following methods:
•

•

Ethernet cable. Use an Ethernet cable to connect your computer to an Ethernet LAN port on the
modem router.
The product package contains an Ethernet cable.
Your computer connects to the modem router’s LAN.
WiFi. Connect to the default WiFi network of the modem router:
a. On your computer, find and select the WiFi network.
The WiFi network name (SSID) is on the modem router label.
b. Join the WiFi network and enter the WiFi password.
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The password (network key) is on the modem router label.
Your computer connects to the modem router’s WiFi network.

Note If the computer is set to a static (fixed) IP address (this setting is uncommon), either
change the computer to obtain an IP address automatically from the modem router
through DHCP, or change the IP address of the computer to a static IP address in
the 192.168.0.2–192.168.0.254 range.

8. Launch a web browser.
After a short while, the Configuring the Internet Connection page displays.

If the Configuring the Internet Connection page displays, skip to Step 11. If the page does not display,
see Step 9.
9. If the Configuring the Internet Connection page does not display, do the following:
a. In the address field of the web browser, enter www.routerlogin.net.
b. When prompted, enter admin for the user name and password for the password.
If the Configuring the Internet Connection page displays, skip to Step 11. If the page still does not display,
see Step 10.
10. If the browser cannot display the web page, do the following:
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a. Make sure that the computer is connected to one of the Ethernet LAN ports or over WiFi to the
modem router.
b. Make sure that the Power LED of the modem router lights solid white.
c. Make sure that your browser does not cache the previous page by closing and reopening the
browser.
d. Clear the browser cache.
e. If the computer is set to a static (fixed) IP address (this setting is uncommon), either change the
computer to obtain an IP address automatically from the modem router through DHCP, or change
the IP address of the computer to a static IP address in the 192.168.0.2–192.168.0.254 range.
11. On the Configuring the Internet Connection page, configure the following settings:
a. Click the Yes radio button.
b. In the STEP 1 section, from the Country menu, select the country in which you use the modem
router.
c. In the STEP 1 section, from the Internet Service Provider menu, select the Internet service provider
(ISP) that you are using.
If your ISP is not in the menu, select Other.
d. In the STEP 2 section, select the Use the Setup Wizard to detect your ADSL or VDSL settings
radio button.
12. Click the Next button.
The modem router checks the Internet connection.

13. Follow the pages and the steps that the NETGEAR installation assistant presents, which depend on the
detected type of ISP connection and configuration.
Your WiFi connection might be terminated during the detection and setup process. If this happens,
simply reconnect to the modem router and wait for the process to continue.
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During the detection and setup process, you must change the password for the modem router and
enable password recovery by selecting two questions and providing answers.

14. To change the password and enable password recovery, do the following:
a. In the New Password field, enter a new password.
The ideal password contains no dictionary words from any language and contains uppercase and
lowercase letters, numbers, and symbols. It can be up to 30 characters.
b. In the Confirm New Password field, repeat the password.
We recommend that you write down your new password or save it in some other way so you don’t
forget it.
c. From the Security Question #1 menu, select a question.
d. In the first Answer field, enter an answer that makes sense to you.
e. From the Security Question #2 menu, select a question that is different from the first one that you
selected.
f.

In the second Answer field, enter an answer that makes sense to you.

g. Click the Next button.
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When the modem router is connected to the Internet, the Congratulations! page displays, and you
successfully completed the setup process.

15. Click the Next button.
You are prompted to download and install the free NETGEAR Desktop genie app and the free
ReadySHARE Vault app.
If the Congratulations! page does not display and the modem router does not connect to the Internet, do
the following to troublehoot the connection:
1. Review all your settings and make sure that you selected the correct options and entered everything
correctly.
2. Run the NETGEAR installation assistant one more time.
3. Contact your ISP to verify that you are using the correct configuration information.
4. Read Troubleshoot the Internet Connection on page 253.
5. If problems persist, register your NETGEAR product and contact NETGEAR technical support.

Set Up the Modem Router for Cable Service
You can install your modem router for cable service or for DSL service. If you use a cable modem, follow
the procedure that is described in this section. If you use a DSL modem, follow the procedure that is described
in Set Up Your Modem Router for DSL Service on page 21.
The NETGEAR installation assistant can detect the type of ISP connection and presents pages on which
you can you enter the required information. The following procedure describes common steps that you must
follow for most ISPs. For some ISPs, you might need to enter additional information. For a small number of
other ISPs, you also might need to configure less common options such as IPTV and DHCP Option 61. If
these option are required, the NETGEAR installation assistant will present them to you.
The following figure shows the cabling of your modem router for cable service.
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Figure 9. Modem router cabling for cable service
To connect your modem router to a cable service:
1. Unplug your cable modem’s power, leaving the cable modem connected to the wall jack for your Internet
service.
2. If your cable modem includes a battery backup, remove the battery.
3. Use an Ethernet cable to connect the cable modem to the yellow Internet port on the modem router.
4. If your cable modem includes a battery backup, reinsert the battery.
5. Plug in and turn on your cable modem.
6. Connect the power adapter to the modem router and plug it into an electrical outlet.
Wait for the Power LED to light solid white, which takes about two minutes.
7. If the Power LED does not light, press the Power On/Off button on the back panel.
8. If the WiFi LEDs do not light, press the WIFI button on the front panel.
9. Connect a computer to the modem router by one of the following methods:
•

•

Ethernet cable. Use an Ethernet cable to connect your computer to an Ethernet LAN port on the
modem router.
The product package contains an Ethernet cable.
Your computer connects to the modem router’s LAN.
WiFi. Connect to the default WiFi network of the modem router:
a. On your computer, find and select the WiFi network.
The WiFi network name (SSID) is on the modem router label.
b. Join the WiFi network and enter the WiFi password.
The password (network key) is on the modem router label.
Your computer connects to the modem router’s WiFi network.

Note If the computer is set to a static (fixed) IP address (this setting is uncommon), either
change the computer to obtain an IP address automatically from the modem router
through DHCP, or change the IP address of the computer to a static IP address in
the 192.168.0.2–192.168.0.254 range.

10. Launch a web browser.
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After a short while, a page displays the message Detecting if there is an existing router in the network:

If the message displays, skip to Step 13. If the message does not display, see Step 11.
11. If the page does not display the message Detecting if there is an existing router in the network, do the
following:
a. In the address field of the web browser, enter www.routerlogin.net.
b. When prompted, enter admin for the user name and password for the password.
If a page displays the message Detecting if there is an existing router in the network, skip to Step 13.
If the message still does not display, see Step 12.
12. If the browser cannot display the web page, do the following:
a. Make sure that the computer is connected to one of the Ethernet LAN ports or over WiFi to the
modem router.
b. Make sure that the Power LED of the modem router lights solid white.
c. Make sure that your browser does not cache the previous page by closing and reopening the
browser.
d. Clear the browser cache.
e. If the computer is set to a static (fixed) IP address (this setting is uncommon), either change the
computer to obtain an IP address automatically from the modem router through DHCP, or change
the IP address of the computer to a static IP address in the 192.168.0.2–192.168.0.254 range.
13. Follow the pages and the steps that the NETGEAR installation assistant presents, which depend on the
detected connection and configuration.
Your WiFi connection might be terminated during the detection and setup process. If this happens,
simply reconnect to the modem router and wait for the process to continue.
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During the detection and setup process, you must change the password for the modem router and
enable password recovery by selecting two questions and providing answers.

If the Admin Accounting Settings page does not yet display, other pages might display and you might
need to provide more information. The pages that display depend on your type of ISP connection and
configuration.
14. To change the password and enable password recovery, do the following:
a. In the New Password field, enter a new password.
The ideal password contains no dictionary words from any language and contains uppercase and
lowercase letters, numbers, and symbols. It can be up to 30 characters.
b. In the Confirm New Password field, repeat the password.
We recommend that you write down your new password or save it in some other way so you don’t
forget it.
c. From the Security Question #1 menu, select a question.
d. In the first Answer field, enter an answer that makes sense to you.
e. From the Security Question #2 menu, select a question that is different from the first one that you
selected.
f.

In the second Answer field, enter an answer that makes sense to you.

g. Click the Next button.
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When the modem router is connected to the Internet, the Congratulations! page displays, and you
successfully completed the setup process.

15. Click the Next button.
You are prompted to download and install the free NETGEAR Desktop genie app and the free
ReadySHARE Vault app.
If the Congratulations! page does not display and the modem router does not connect to the Internet, do the
following to troublehoot the connection:
1. Review all your settings and make sure that you selected the correct options and entered everything correctly.
2. Run the NETGEAR installation assistant one more time.
3. Contact your ISP to verify that you are using the correct configuration information.
4. Read Troubleshoot the Internet Connection on page 253.
5. If problems persist, register your NETGEAR product and contact NETGEAR technical support.

Log In to the Modem Router After Setup to View or Change
Settings
After you set up the modem router for DSL service or cable service, you can view or change the settings
for the modem router.

To log in to the modem router:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
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Note You can also type http://www.routerlogin.com or http://192.168.0.1.The procedures
in this manual use http://www.routerlogin.net.
A login window opens. The nature of the login window depends on your web browser.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
Click the OK button.

The BASIC Home page displays a dashboard that lets you see the status of your Internet connection
and network at a glance. You can click any of the sections of the dashboard to view more detailed
information. The left column displays the menus, and at the top is an ADVANCED tab that you can use
to access more menus and pages.

Change the Language
By default, the language is set to Auto.

To change the language:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. In the upper right corner, select a language from the menu.
5. When prompted, click the OK button to confirm this change.
The page refreshes with the language that you selected.

Access the Modem Router With NETGEAR genie Apps
The genie app is the easy dashboard for managing, monitoring, and repairing your home network. The genie
app can help you with the following:
•

Automatically repair common WiFi network problems.

•

Easily manage modem router features such as Live Parental Controls, guest access, Internet traffic
meter, speed test, and more.

To use the genie app to access the modem router:
1. Visit the NETGEAR genie web page at NETGEAR.com/genie.
2. Follow the onscreen instructions to install the app on your smartphone, tablet, or computer.
3. Launch the genie app.
The genie app dashboard page displays.
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This chapter describes how you can manage the Internet settings of the modem router manually.
Usually, the quickest way to set up the modem router is to allow NETGEAR genie to detect the Internet connection
when you first access the modem router with a web browser. These options are described in Install and Access
the Modem Router and Its Network on page 15.You can also customize or specify your Internet settings manually.
The chapter contains the following sections:
•

Use the Internet Setup Wizard After Initial Setup on page 34

•

Manually Set Up an ADSL Internet Connection on page 36

•

Manually Set Up a VDSL Internet Connection on page 44

•

Manually Set Up a Cable Internet Connection on page 51

•

Specify an IPv6 Internet Connection on page 63

•

Manage the MTU Size on page 77
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Use the Internet Setup Wizard After Initial Setup
Whether you use DSL service or cable service, you can use the Setup Wizard to detect your Internet settings
and automatically set up your modem router.
Note The Setup Wizard is the same as the NETGEAR installation assistant, which launches
the first time you connect to your modem router.
The Setup Wizard can detect the type of ISP connection and presents pages on which you can you enter
the required information. The following procedure describes common steps that you must follow for most
ISPs, but also includes some uncommon steps that you might need to follow only for some ISPs. Other
uncommon steps such as configuring IPTV options and configuring DHCP Option 61 that are required only
for some ISPs are not included in the following procedure.

To use the Setup Wizard:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup Wizard.

5. From the Country menu, select the country in which you use the modem router.
6. From the Internet Service Provider menu, select the Internet service provider (ISP) that you are using.
If your ISP is not in the menu, select Other.
7. Select the Yes radio button.
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If you select the No radio button, you are taken to the Internet Setup page after you click the Next button.
For more information, see one of the following sections:
•

Manually Set Up an ADSL Internet Connection on page 36

•

Manually Set Up a VDSL Internet Connection on page 44

•

Manually Set Up a Cable Internet Connection on page 51

8. Click the Next button.
The Setup Wizard searches your Internet connection for servers and protocols to determine your ISP
configuration.
9. Follow the pages and the steps that the Setup Wizard presents, which depend on the detected type of
ISP connection and configuration.
Note Your WiFi connection might be terminated during the detection and setup process. If
this happens, simply reconnect to the modem router and wait for the process to
continue.
Toward the end of the detection and setup process, you can change the password for the modem router
and select two questions for password recovery.
When the modem router is connected to the Internet, the Congratulations! page displays, and you
successfully completed the setup process.

10. Click the Next button.
You are prompted to download and install the free NETGEAR Desktop genie app and the free
ReadySHARE Vault app.
If the Congratulations! page does not display and the modem router does not connect to the Internet, do the
following to troubleshoot the connection:
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1. Review all your settings and make sure that you selected the correct options and entered everything correctly.
2. Run the NETGEAR installation assistant one more time.
3. Contact your ISP to verify that you are using the correct configuration information.
4. Read Troubleshoot the Internet Connection on page 253.
5. If problems persist, register your NETGEAR product and contact NETGEAR technical support.

Manually Set Up an ADSL Internet Connection
You can view or change the modem router’s ADSL Internet connection settings manually. The following
sections describe the options that are available to you to manually set up the ADSL Internet connection:
•

Specify an ADSL Connection Without a Login on page 36

•

Specify an ADSL Connection With a Login and PPPoA or PPPoE Service on page 39
Note Some ISPs require that you register on their website before you can obtain Internet
service. Follow the directions that your ISP gave you.

Specify an ADSL Connection Without a Login
If you want to manually configure the ADSL connection settings, use the information that your ISP gave you
to connect to your Internet service. If you cannot find this information, contact your ISP. Entering incorrect
information might prevent the modem router from connecting to the Internet.

To view or specify the settings for an ADSL Internet connection that does not require a
login:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select Internet.
The Internet Setup page displays.
5. From the Select Country menu, select the country in which you use the modem router.
The Select Country menu is not available in all countries and might be masked out.
6. From the Select Internet Service Provider menu, select the Internet service provider (ISP) that you
are using.
If your ISP is not in the menu, select Other.
7. From the Transfer Mode menu, select ATM.
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8. From the DSL Mode menu, select the ADSL mode that your ISP provided you:
•
•
•
•

Auto. The modem router detects the DSL mode automatically. (This is the default setting.)
ADSL. Legacy version of ADSL.
ADSL2. Legacy version of ADSL2.
ADSL2+. ADSL2+ provides the fastest downstream rates and can interoperate with ADSL2 and
ADSL.

9. Scroll down to the Does your Internet connection require a login? section and select the No radio button.
The following figure shows the settings that display when you configure an ADSL connection without a
login.

10. Enter the ADSL settings as described in the following table.
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Field

Description

Multiplexing Method

Select LLC-BASED or VC-BASED, as indicated by your ISP.
The multiplexing method can either be virtual circuit (VC) based or logical
link control (LLC) based.

VPI

Enter a number between 0 and 255 for the virtual circuit number for the virtual
path identifier (VPI), as indicated by your ISP.
If your ISP did not provide you with a VPI setting, leave the default setting
(8). The VPI might be required not only for a VC-based connection but also
for an LLC-based connection.

VCI

Enter a number between 32 and 65535 for the virtual circuit number for the
virtual channel identifier (VCI), as indicated by your ISP.
If your ISP did not provide you with a VCI setting, leave the default setting
(35). The VCI might be required not only for a VC-based connection but also
for an LLC-based connection.

Use VLANID

Select the Use VLANID check box and enter the VLAN ID, as indicated by
your ISP.
A VLAN ID might be required if you subscribe to both Internet service and a
service such as IPTV. If your ISP did not provide you with a VLAN ID, leave
the Use VLANID check box cleared, which is the default setting.

Priority (0 ~ 7)

If your ISP provided you with a VLAN ID and a priority value, enter the priority
value, which is a number from 0 to 7.
You can enter a priority value only in combination with a VLAN ID. If your
ISP did not provide you with a priority value, leave the default setting (0).

Account Name

Enter the account name, as indicated by your ISP. This name might also be
called the host name.
If your ISP did not provide you with an account name or host name, leave
the default setting.

Domain Name

Enter the domain name, as indicated by your ISP.
If your ISP did not provide you with a domain name, leave this field blank.

Internet IP Address
Get Dynamically from ISP

Your ISP uses DHCP to assign your IP address. Your ISP automatically
assigns these addresses.

Use Static IP Address

Enter the IP address, IP subnet mask, and gateway IP address that your ISP
assigned you for static IP address service. The gateway is the ISP router to
which your modem router connects.

Use IP over ATM (IPoA)

Enter the IP address, IP subnet mask, and gateway IP address that your ISP
assigned you for IPoA service. The gateway is the ISP router to which your
modem router connects.

Domain Name Server (DNS) Address
The DNS server is used to look up site addresses based on their domain names.
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(Continued)
Field

Description

Get Automatically from ISP

Your ISP uses DHCP to assign your DNS servers. Your ISP automatically
assigns this address.

Use These DNS Servers

If you know that your ISP does not automatically transmit DNS addresses
to the modem router during login, select this option and enter the IP address
of your ISP primary DNS server. If secondary and tertiary DNS server
addresses are available, enter them also.

Router MAC Address
The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the MAC
address of the network interface card in your computer when your account is first opened. They accept traffic
only from the MAC address of that computer.
This feature allows your modem router to use your computer’s MAC address (also called cloning).
Use Default Address

Use the default MAC address.

Use Computer MAC Address

The modem router captures and uses the MAC address of the computer that
you are now using. You must use the one computer that is registered by the
ISP.

Use This MAC Address

Enter the MAC address that you want to use. By default, the field displays
the MAC address of the Internet port.

DHCP Options
Vendor Class Identifier String Enter the vendor class identifier (VCI) string, as indicated by your ISP.
(option 60)
If your ISP did not provide you with a VCI string, leave this field blank.
Client Identifier String (option Enter the client identifier (client ID) string, as indicated by your ISP.
61)
If your ISP did not provide you with a client ID string, leave this field blank.

11. Click the Apply button.
Your settings are saved.
12. Click the Test button to test your Internet connection.
If the NETGEAR website does not display within one minute, see Troubleshoot the Internet Connection
on page 253.

Specify an ADSL Connection With a Login and PPPoA or PPPoE
Service
If you want to manually configure the ADSL connection settings, use the information that your ISP gave you
to log in and connect to your Internet service. If you cannot find this information, contact your ISP. Entering
incorrect information might prevent the modem router from connecting to the Internet.
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To view or specify the settings for an ADSL Internet connection that requires a login and
uses a PPPoE or PPPoA service:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select Internet.
The Internet Setup page displays.
5. From the Select Country menu, select the country in which you use the modem router.
The Select Country menu is not available in all countries and might be masked out.
6. From the Select Internet Service Provider menu, select the Internet service provider (ISP) that you
are using.
If your ISP is not in the menu, select Other.
7. From the Transfer Mode menu, select ATM.
8. From the DSL Mode menu, select the ADSL mode that your ISP provided you:
•
•
•
•

Auto. The modem router detects the DSL mode automatically. (This is the default setting.)
ADSL. Legacy version of ADSL.
ADSL2. Legacy version of ADSL2.
ADSL2+. ADSL2+ provides the fastest downstream rates and can interoperate with ADSL2 and
ADSL.

9. Scroll down to the Does your Internet connection require a login? section and select the Yes radio
button.
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The following figure shows the settings that display when you configure an ADSL connection with a
login and PPPoE service.

10. Enter the ADSL settings as described in the following table.
Field

Description

Multiplexing Method

Select LLC-BASED or VC-BASED, as indicated by your ISP.
The multiplexing method can either be virtual circuit (VC) based or logical
link control (LLC) based.

VPI

Enter a number between 0 and 255 for the virtual circuit number for the virtual
path identifier (VPI), as indicated by your ISP.
If your ISP did not provide you with a VPI setting, leave the default setting
(8). The VPI might be required not only for a VC-based connection but also
for an LLC-based connection.
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(Continued)
Field

Description

VCI

Enter a number between 32 and 65535 for the virtual circuit number for the
virtual channel identifier (VCI), as indicated by your ISP.
If your ISP did not provide you with a VCI setting, leave the default setting
(35). The VCI might be required not only for a VC-based connection but also
for an LLC-based connection.

Use VLANID

Select the Use VLANID check box and enter the VLAN ID, as indicated by
your ISP.
A VLAN ID might be required if you subscribe to both Internet service and a
service such as IPTV. If your ISP did not provide you with a VLAN ID, leave
the Use VLANID check box cleared, which is the default setting.

Priority (0 ~ 7)

If your ISP provided you with a VLAN ID and a priority value, enter the priority
value, which is a number from 0 to 7.
You can enter a priority value only in combination with a VLAN ID. If your
ISP did not provide you with a priority value, leave the default setting (0).

Internet Service Provider

Login

Select the encapsulation, as indicated by your ISP:
•

PPPoA. Your Internet connection uses PPP over ATM.

•

PPPoE. Your Internet connection uses PPP over Ethernet.

Enter the login name that you use to log in to your Internet service, as
indicated by your ISP.
This login name is often an email address.

Password

Enter the password that you use to log in to your Internet service, as indicated
by your ISP.

Service Name (If Required)

Enter the service name that you use to log in to your Internet service, as
indicated by your ISP.
Often, a service name is not required.

Connection Mode

Select how the Internet connection functions:
•

Always On. Once the Internet connection is established, it remains
active. This is the default setting.

•

Dial on Demand. When someone attempts to connect to the Internet,
the Internet connection is established. When the idle time-out period
expires, the Internet connection is terminated.

•

Manually Connect. You must connect to the Internet manually (see
View, Establish, or Terminate the PPPoE or PPPoA Internet Connection
on page 200).
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(Continued)
Field

Description

Idle Timeout (In Minutes)

If you select Dial on Demand from the Connection Mode menu, enter the
idle time-out period in minutes.
The idle time-out specifies how long the modem router keeps the Internet
connection active when no one on the network is using the Internet
connection. The default is 5 minutes. To disable the idle time-out, enter 0.
(When you disable the idle time-out, the connection is not terminated
automatically.)

Internet IP Address
Get Dynamically from ISP

Your ISP uses DHCP to assign your IP address. Your ISP automatically
assigns these addresses.

Use Static IP Address

Enter the IP address, IP subnet mask, and gateway IP address that your ISP
assigned you for static IP address service. The gateway is the ISP router to
which your modem router connects.

Domain Name Server (DNS) Address
The DNS server is used to look up site addresses based on their domain names.
Get Automatically from ISP

Your ISP uses DHCP to assign your DNS servers. Your ISP automatically
assigns this address.

Use These DNS Servers

If you know that your ISP does not automatically transmit DNS addresses
to the modem router during login, select this option and enter the IP address
of your ISP primary DNS server. If a secondary DNS server address is
available, enter it also.

Router MAC Address
The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the MAC
address of the network interface card in your computer when your account is first opened. They accept traffic
only from the MAC address of that computer.
This feature allows your modem router to use your computer’s MAC address (also called cloning).
Use Default Address

Use the default MAC address.

Use Computer MAC Address

The modem router captures and uses the MAC address of the computer that
you are now using. You must use the one computer that is registered by the
ISP.

Use This MAC Address

Enter the MAC address that you want to use. By default, the field displays
the MAC address of the Internet port.

11. Click the Apply button.
Your settings are saved.
12. Click the Test button to test your Internet connection.
If the NETGEAR website does not display within one minute, see Troubleshoot the Internet Connection
on page 253.
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Manually Set Up a VDSL Internet Connection
You can view or change the modem router’s VDSL Internet connection settings manually. The following
sections describe the options that are available to you to manually set up the VDSL Internet connection:
•

Specify a VDSL Connection Without a Login on page 44

•

Specify a VDSL Connection With a Login and PPPoE Service on page 47
Note Some ISPs require that you register on their website before you can obtain Internet
service. Follow the directions that your ISP gave you.

Specify a VDSL Connection Without a Login
If you want to manually configure the VDSL connection settings, use the information that your ISP gave you
to connect to your Internet service. If you cannot find this information, contact your ISP. Entering incorrect
information might prevent the modem router from connecting to the Internet.

To view or specify the settings for a VDSL Internet connection that does not require a login:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select Internet.
The Internet Setup page displays.
5. From the Select Country menu, select the country in which you use the modem router.
The Select Country menu is not available in all countries and might be masked out.
6. From the Select Internet Service Provider menu, select the Internet service provider (ISP) that you
are using.
If your ISP is not in the menu, select Other.
7. From the Transfer Mode menu, select PTM.
When you select PTM from the Transfer Mode menu, the only option in the DSL Mode menu is VDSL2.
8. Scroll down to the Does your Internet connection require a login? section and select the No radio button.
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The following figure shows the settings that display when you configure a VDSL connection without a
login.

9. Enter the VDSL settings as described in the following table.
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Field

Description

Multiplexing Method

These settings are disabled because they do not apply to a VDSL connection.

VPI
VCI
Use VLANID

Select the Use VLANID check box and enter the VLAN ID, as indicated by
your ISP.
A VLAN ID might be required if you subscribe to both Internet service and a
service such as IPTV. If your ISP did not provide you with a VLAN ID, leave
the Use VLANID check box cleared, which is the default setting.

Priority (0 ~ 7)

If your ISP provided you with a VLAN ID and a priority value, enter the priority
value, which is a number from 0 to 7.
You can enter a priority value only in combination with a VLAN ID. If your
ISP did not provide you with a priority value, leave the default setting (0).

Account Name

Enter the account name, as indicated by your ISP. This name might also be
called the host name.
If your ISP did not provide you with an account name or host name, leave
the default setting.

Domain Name

Enter the domain name, as indicated by your ISP.
If your ISP did not provide you with a domain name, leave this field blank.

Internet IP Address
Get Dynamically from ISP

Your ISP uses DHCP to assign your IP address. Your ISP automatically
assigns these addresses.

Use Static IP Address

Enter the IP address, IP subnet mask, and gateway IP address that your ISP
assigned you for static IP address service. The gateway is the ISP router to
which your modem router connects.

Use IP over ATM (IPoA)

Enter the IP address, IP subnet mask, and gateway IP address that your ISP
assigned you for IPoA service. The gateway is the ISP router to which your
modem router connects.

Domain Name Server (DNS) Address
The DNS server is used to look up site addresses based on their domain names.
Get Automatically from ISP

Your ISP uses DHCP to assign your DNS servers. Your ISP automatically
assigns this address.

Use These DNS Servers

If you know that your ISP does not automatically transmit DNS addresses
to the modem router during login, select this option and enter the IP address
of your ISP primary DNS server. If secondary and tertiary DNS server
addresses are available, enter them also.
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(Continued)
Field

Description

Router MAC Address
The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the MAC
address of the network interface card in your computer when your account is first opened. They accept traffic
only from the MAC address of that computer.
This feature allows your modem router to use your computer’s MAC address (also called cloning).
Use Default Address

Use the default MAC address.

Use Computer MAC Address

The modem router captures and uses the MAC address of the computer that
you are now using. You must use the one computer that is registered by the
ISP.

Use This MAC Address

Enter the MAC address that you want to use. By default, the field displays
the MAC address of the Internet port.

DHCP Options
Vendor Class Identifier String Enter the vendor class identifier (VCI) string, as indicated by your ISP.
(option 60)
If your ISP did not provide you with a VCI string, leave this field blank.
Client Identifier String (option Enter the client identifier (client ID) string, as indicated by your ISP.
61)
If your ISP did not provide you with a client ID string, leave this field blank.

10. Click the Apply button.
Your settings are saved.
11. Click the Test button to test your Internet connection.
If the NETGEAR website does not display within one minute, see Troubleshoot the Internet Connection
on page 253.

Specify a VDSL Connection With a Login and PPPoE Service
If you want to manually configure the VDSL connection settings, use the information that your ISP gave you
to log in and connect to your Internet service. If you cannot find this information, contact your ISP. Entering
incorrect information might prevent the modem router from connecting to the Internet.

To view or specify the settings for a VDSL Internet connection that requires a login and
uses a PPPoE service:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select Internet.
The Internet Setup page displays.
5. From the Select Country menu, select the country in which you use the modem router.
The Select Country menu is not available in all countries and might be masked out.
6. From the Select Internet Service Provider menu, select the Internet service provider (ISP) that you
are using.
If your ISP is not in the menu, select Other.
7. From the Transfer Mode menu, select PTM.
When you select PTM from the Transfer Mode menu, the only option in the DSL Mode menu is VDSL2.
8. Scroll down to the Does your Internet connection require a login? section and select the Yes radio
button.
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The following figure shows the settings that display when you configure a VDSL connection with a login
and PPPoE service.

9. Enter the VDSL settings as described in the following table.
Field

Description

Multiplexing Method

These settings are disabled because they do not apply to a VDSL connection.

VPI
VCI
Use VLANID

Select the Use VLANID check box and enter the VLAN ID, as indicated by
your ISP.
A VLAN ID might be required if you subscribe to both Internet service and a
service such as IPTV. If your ISP did not provide you with a VLAN ID, leave
the Use VLANID check box cleared, which is the default setting.
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(Continued)
Field

Description

Priority (0 ~ 7)

If your ISP provided you with a VLAN ID and a priority value, enter the priority
value, which is a number from 0 to 7.
You can enter a priority value only in combination with a VLAN ID. If your
ISP did not provide you with a priority value, leave the default setting (0).

Internet Service Provider

By default, the menu selection is PPPoE for a PPP over Ethernet VDSL
connection.
The VDSL connection does not support PPP over ATM (PPPoA).

Login

Enter the login name that you use to log in to your Internet service, as
indicated by your ISP.
This login name is often an email address.

Password

Enter the password that you use to log in to your Internet service, as indicated
by your ISP.

Service Name (If Required)

Enter the service name that you use to log in to your Internet service, as
indicated by your ISP.
Often, a service name is not required.

Connection Mode

Idle Timeout (In Minutes)

Select how the Internet connection functions:
•

Always On. Once the Internet connection is established, it remains
active. This is the default setting.

•

Dial on Demand. When someone attempts to connect to the Internet,
the Internet connection is established. When the idle time-out period
expires, the Internet connection is terminated.

•

Manually Connect. You must connect to the Internet manually (see
View, Establish, or Terminate the PPPoE or PPPoA Internet Connection
on page 200).

If you select Dial on Demand from the Connection Mode menu, enter the
idle time-out period in minutes.
The idle time-out specifies how long the modem router keeps the Internet
connection active when no one on the network is using the Internet
connection. The default is 5 minutes. To disable the idle time-out, enter 0.
(When you disable the idle time-out, the connection is not terminated
automatically).

Internet IP Address
Get Dynamically from ISP

Your ISP uses DHCP to assign your IP address. Your ISP automatically
assigns these addresses.

Use Static IP Address

Enter the IP address, IP subnet mask, and gateway IP address that your ISP
assigned you for static IP address service. The gateway is the ISP router to
which your modem router connects.
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(Continued)
Field

Description

Domain Name Server (DNS) Address
The DNS server is used to look up site addresses based on their domain names.
Get Automatically from ISP

Your ISP uses DHCP to assign your DNS servers. Your ISP automatically
assigns this address.

Use These DNS Servers

If you know that your ISP does not automatically transmit DNS addresses
to the modem router during login, select this option and enter the IP address
of your ISP primary DNS server. If a secondary DNS server address is
available, enter it also.

Router MAC Address
The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the MAC
address of the network interface card in your computer when your account is first opened. They accept traffic
only from the MAC address of that computer.
This feature allows your modem router to use your computer’s MAC address (also called cloning).
Use Default Address

Use the default MAC address.

Use Computer MAC Address

The modem router captures and uses the MAC address of the computer that
you are now using. You must use the one computer that is registered by the
ISP.

Use This MAC Address

Enter the MAC address that you want to use. By default, the field displays
the MAC address of the Internet port.

10. Click the Apply button.
Your settings are saved.
11. Click the Test button to test your Internet connection.
If the NETGEAR website does not display within one minute, see Troubleshoot the Internet Connection
on page 253.

Manually Set Up a Cable Internet Connection
You can view or change the modem router’s cable Internet connection settings manually. The following
sections describe the options that are available to you to manually set up the cable Internet connection:
•

Specify a Cable Connection Without a Login on page 52

•

Specify a Cable Connection With a Login and PPPoE Service on page 55

•

Specify a Cable Connection With a Login and PPTP or L2TP Service on page 59
Note Some ISPs require that you register on their website before you can obtain Internet
service. Follow the directions that your ISP gave you.
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Specify a Cable Connection Without a Login
If you want to manually configure the cable connection settings, use the information that your ISP gave you
to connect to your Internet service. If you cannot find this information, contact your ISP. Entering incorrect
information might prevent the modem router from connecting to the Internet.

To view or specify the settings for a cable Internet connection that does not require a login:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup > WAN Setup.
The WAN Setup page displays.
5. From the WAN Preference menu, select Must use Ethernet WAN.
By default, the menu selection is Auto-Detect.
6. Click the Apply button.
Your settings are saved and the modem router restarts.
Note If you connect over WiFi to the modem router, you might need to reconnect and log
in again.

7. Select BASIC > Internet.
The Internet Setup page displays.
8. From the Select Country menu, select the country in which you use the modem router.
The Select Country menu is not available in all countries and might be masked out.
9. From the Select Internet Service Provider menu, select the Internet service provider (ISP) that you
are using.
If your ISP is not in the menu, select Other.
10. Scroll down to the Does your Internet connection require a login? section and select the No radio button.
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The following figure shows the settings that display when you configure a cable connection without a
login. The transfer mode and multiplexing method do not apply to a cable connection.

11. Enter the cable settings as described in the following table.
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Field

Description

Use VLANID

Select the Use VLANID check box and enter the VLAN ID, as indicated by
your ISP.
A VLAN ID might be required if you subscribe to both Internet service and a
service such as IPTV. If your ISP did not provide you with a VLAN ID, leave
the Use VLANID check box cleared, which is the default setting.

Priority (0 ~ 7)

If your ISP provided you with a VLAN ID and a priority value, enter the priority
value, which is a number from 0 to 7.
You can enter a priority value only in combination with a VLAN ID. If your
ISP did not provide you with a priority value, leave the default setting (0).

Account Name

Enter the account name, as indicated by your ISP. This name might also be
called the host name.
If your ISP did not provide you with an account name or host name, leave
the default setting.

Domain Name

Enter the domain name, as indicated by your ISP.
If your ISP did not provide you with a domain name, leave this field blank.

Internet IP Address
Get Dynamically from ISP

Your ISP uses DHCP to assign your IP address. Your ISP automatically
assigns these addresses.

Use Static IP Address

Enter the IP address, IP subnet mask, and gateway IP address that your ISP
assigned you for static IP address service. The gateway is the ISP router to
which your modem router connects.

Use IP over ATM (IPoA)

Enter the IP address, IP subnet mask, and gateway IP address that your ISP
assigned you for IPoA service. The gateway is the ISP router to which your
modem router connects.

Domain Name Server (DNS) Address
The DNS server is used to look up site addresses based on their domain names.
Get Automatically from ISP

Your ISP uses DHCP to assign your DNS servers. Your ISP automatically
assigns this address.

Use These DNS Servers

If you know that your ISP does not automatically transmit DNS addresses
to the modem router during login, select this option and enter the IP address
of your ISP primary DNS server. If secondary and tertiary DNS server
addresses are available, enter them also.

Router MAC Address
The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the MAC
address of the network interface card in your computer when your account is first opened. They accept traffic
only from the MAC address of that computer.
This feature allows your modem router to use your computer’s MAC address (also called cloning).
Use Default Address

Use the default MAC address.
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(Continued)
Field

Description

Use Computer MAC Address

The modem router captures and uses the MAC address of the computer that
you are now using. You must use the one computer that is registered by the
ISP.

Use This MAC Address

Enter the MAC address that you want to use. By default, the field displays
the MAC address of the Internet port.

DHCP Options
Vendor Class Identifier String Enter the vendor class identifier (VCI) string, as indicated by your ISP.
(option 60)
If your ISP did not provide you with a VCI string, leave this field blank.
Client Identifier String (option Enter the client identifier (client ID) string, as indicated by your ISP.
61)
If your ISP did not provide you with a client ID string, leave this field blank.

12. Click the Apply button.
Your settings are saved.
13. Click the Test button to test your Internet connection.
If the NETGEAR website does not display within one minute, see Troubleshoot the Internet Connection
on page 253.

Specify a Cable Connection With a Login and PPPoE Service
If you want to manually configure the cable connection settings, use the information that your ISP gave you
to connect to your Internet service. If you cannot find this information, contact your ISP. Entering incorrect
information might prevent the modem router from connecting to the Internet.

To view or specify the settings for a cable Internet connection that requires a login and
uses a PPPoE service:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup > WAN Setup.
The WAN Setup page displays.
5. From the WAN Preference menu, select Must use Ethernet WAN.
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By default, the menu selection is Auto-Detect.
6. Click the Apply button.
Your settings are saved and the modem router restarts.
Note If you connect over WiFi to the modem router, you might need to reconnect and log
in again.

7. Select BASIC > Internet.
The Internet Setup page displays.
8. From the Select Country menu, select the country in which you use the modem router.
The Select Country menu is not available in all countries and might be masked out.
9. From the Select Internet Service Provider menu, select the Internet service provider (ISP) that you
are using.
If your ISP is not in the menu, select Other.
10. Scroll down to the Does your Internet connection require a login? section and select the Yes radio
button.
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The following figure shows the settings that display when you configure a cable connection with a login
and PPPoE service. The transfer mode and multiplexing method do not apply to a cable connection.

11. Enter the cable settings as described in the following table.
Field

Description

Use VLANID

Select the Use VLANID check box and enter the VLAN ID, as indicated by
your ISP.
A VLAN ID might be required if you subscribe to both Internet service and a
service such as IPTV. If your ISP did not provide you with a VLAN ID, leave
the Use VLANID check box cleared, which is the default setting.

Priority (0 ~ 7)

If your ISP provided you with a VLAN ID and a priority value, enter the priority
value, which is a number from 0 to 7.
You can enter a priority value only in combination with a VLAN ID. If your
ISP did not provide you with a priority value, leave the default setting (0).

Internet Service Provider

From the menu, select PPPoE for a PPP over Ethernet connection.
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(Continued)
Field

Description

Login

Enter the login name that you use to log in to your Internet service, as
indicated by your ISP.
This login name is often an email address.

Password

Enter the password that you use to log in to your Internet service, as indicated
by your ISP.

Service Name (If Required)

Enter the service name that you use to log in to your Internet service, as
indicated by your ISP.
Often, a service name is not required.

Connection Mode

Idle Timeout (In Minutes)

Select how the Internet connection functions:
•

Always On. Once the Internet connection is established, it remains
active. This is the default setting.

•

Dial on Demand. When someone attempts to connect to the Internet,
the Internet connection is established. When the idle time-out period
expires, the Internet connection is terminated.

•

Manually Connect. You must connect to the Internet manually (see
View, Establish, or Terminate the PPPoE or PPPoA Internet Connection
on page 200).

If you select Dial on Demand from the Connection Mode menu, enter the
idle time-out period in minutes.
The idle time-out specifies how long the modem router keeps the Internet
connection active when no one on the network is using the Internet
connection. The default is 5 minutes. To disable the idle time-out, enter 0.
(When you disable the idle time-out, the connection is not terminated
automatically.)

Internet IP Address
Get Dynamically from ISP

Your ISP uses DHCP to assign your IP address. Your ISP automatically
assigns these addresses.

Use Static IP Address

Enter the IP address, IP subnet mask, and gateway IP address that your ISP
assigned you for static IP address service. The gateway is the ISP router to
which your modem router connects.

Domain Name Server (DNS) Address
The DNS server is used to look up site addresses based on their domain names.
Get Automatically from ISP

Your ISP uses DHCP to assign your DNS servers. Your ISP automatically
assigns this address.

Use These DNS Servers

If you know that your ISP does not automatically transmit DNS addresses
to the modem router during login, select this option and enter the IP address
of your ISP primary DNS server. If a secondary DNS server address is
available, enter it also.
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(Continued)
Field

Description

Router MAC Address
The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the MAC
address of the network interface card in your computer when your account is first opened. They accept traffic
only from the MAC address of that computer.
This feature allows your modem router to use your computer’s MAC address (also called cloning).
Use Default Address

Use the default MAC address.

Use Computer MAC Address

The modem router captures and uses the MAC address of the computer that
you are now using. You must use the one computer that is registered by the
ISP.

Use This MAC Address

Enter the MAC address that you want to use. By default, the field displays
the MAC address of the Internet port.

12. Click the Apply button.
Your settings are saved.
13. Click the Test button to test your Internet connection.
If the NETGEAR website does not display within one minute, see Troubleshoot the Internet Connection
on page 253.

Specify a Cable Connection With a Login and PPTP or L2TP
Service
If you want to manually configure the cable connection settings, use the information that your ISP gave you
to connect to your Internet service. If you cannot find this information, contact your ISP. Entering incorrect
information might prevent the modem router from connecting to the Internet.

To view or specify the settings for a cable Internet connection that requires a login and
uses a PPTP or L2TP service:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup > WAN Setup.
The WAN Setup page displays.
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5. From the WAN Preference menu, select Must use Ethernet WAN.
By default, the menu selection is Auto-Detect.
6. Click the Apply button.
Your settings are saved and the modem router restarts.
Note If you connect over WiFi to the modem router, you might need to reconnect and log
in again.

7. Select BASIC > Internet.
The Internet Setup page displays.
8. From the Select Country menu, select the country in which you use the modem router.
The Select Country menu is not available in all countries and might be masked out.
9. From the Select Internet Service Provider menu, select the Internet service provider (ISP) that you
are using.
If your ISP is not in the menu, select Other.
10. Scroll down to the Does your Internet connection require a login? section and select the Yes radio
button.
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The following figure shows the settings that display when you configure a cable connection with a login
and PPTP service. The transfer mode and multiplexing method do not apply to a cable connection.

11. Enter the cable settings as described in the following table.
Field

Description

Internet Service Provider

Select the encapsulation, as indicated by your ISP:

Login

•

PPTP. Your Internet connection uses Point-to-Point Tunneling Protocol.

•

L2TP. Your Internet connection uses Layer Two Tunneling Protocol.

Enter the login name that you use to log in to your Internet service, as
indicated by your ISP.
This login name is often an email address.
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(Continued)
Field

Description

Password

Enter the password that you use to log in to your Internet service, as indicated
by your ISP.

Connection Mode

Select how the Internet connection functions:

Idle Timeout (In Minutes)

•

Always On. Once the Internet connection is established, it remains
active. This is the default setting.

•

Dial on Demand. When someone attempts to connect to the Internet,
the Internet connection is established. When the idle time-out period
expires, the Internet connection is terminated.

•

Manually Connect. You must connect to the Internet manually (see
View, Establish, or Terminate the PPTP or L2TP Internet Connection
on page 201).

If you select Dial on Demand from the Connection Mode menu, enter the
idle time-out period in minutes.
The idle time-out specifies how long the modem router keeps the Internet
connection active when no one on the network is using the Internet
connection. The default is 5 minutes. To disable the idle time-out, enter 0.
(When you disable the idle time-out, the connection is not terminated
automatically.)

My IP Address

Enter the IP address that is assigned by your ISP to make the connection
with the ISP server.

Subnet Mask

Enter the IP subnet mask that is assigned by your ISP to make the connection
with the ISP server.

Server Address

Enter the IP address of the ISP server that your ISP gave you.

Gateway IP Address

Enter the IP address of the ISP gateway that your ISP gave you.
If your ISP did not give you a gateway IP address, leave this field blank.

Connection ID/Name

Enter the IP connection ID or name that your ISP gave you.
If your ISP did not give you a connection ID or name, leave this field blank.
(It is not common that you must enter a connection ID or name.)
Note This field displays for PPTP service only.

Internet IP Address
Get Dynamically from ISP

Your ISP uses DHCP to assign your IP address. Your ISP automatically
assigns these addresses.

Use Static IP Address

Enter the IP address, IP subnet mask, and gateway IP address that your ISP
assigned you for static IP address service. The gateway is the ISP router to
which your modem router connects.
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(Continued)
Field

Description

Domain Name Server (DNS) Address
The DNS server is used to look up site addresses based on their domain names.
Get Automatically from ISP

Your ISP uses DHCP to assign your DNS servers. Your ISP automatically
assigns this address.

Use These DNS Servers

If you know that your ISP does not automatically transmit DNS addresses
to the modem router during login, select this option and enter the IP address
of your ISP primary DNS server. If a secondary DNS server address is
available, enter it also.

Router MAC Address
The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the MAC
address of the network interface card in your computer when your account is first opened. They accept traffic
only from the MAC address of that computer.
This feature allows your modem router to use your computer’s MAC address (also called cloning).
Use Default Address

Use the default MAC address.

Use Computer MAC Address

The modem router captures and uses the MAC address of the computer that
you are now using. You must use the one computer that is registered by the
ISP.

Use This MAC Address

Enter the MAC address that you want to use. By default, the field displays
the MAC address of the Internet port.

12. Click the Apply button.
Your settings are saved.
13. Click the Test button to test your Internet connection.
If the NETGEAR website does not display within one minute, see Troubleshoot the Internet Connection
on page 253.

Specify an IPv6 Internet Connection
The modem router supports many different types of IPv6 Internet connections, for which you can specify
the settings manually.

IPv6 Internet Connections and IPv6 Addresses
The modem router can support an IPv6 Internet connection through the following connection types:
•

Auto Detect. For more information, see Use Auto Detect for an IPv6 Internet Connection on page 64.

•

6to4 tunnel. For more information, see Set Up an IPv6 6to4 Tunnel Internet Connection on page 66.
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•

Pass-through. For more information, see Set Up an IPv6 Pass Through Internet Connection on page
67.

•

Fixed. For more information, see Set Up an IPv6 Fixed Internet Connection on page 68.

•

DHCP. For more information, see Set Up an IPv6 DHCP Internet Connection on page 69.

•

PPPoE. For more information, see Set Up an IPv6 PPPoE Internet Connection on page 71.

•

Auto Config. For more information, see Use Auto Config for an IPv6 Internet Connection on page 73.

•

6rd. For more information, see Set Up an IPv6 6rd Tunnel Internet Connection on page 75.

Which connection type you must use depends on your IPv6 ISP. Follow the directions that your IPv6 ISP
gave you.
•

If your ISP did not provide details, use the 6to4 tunnel connection type (see Set Up an IPv6 6to4 Tunnel
Internet Connection on page 66).

•

If you are not sure what type of IPv6 connection the modem router uses, use the Auto Detect connection
type, which lets the modem router detect the IPv6 type that is in use (see Use Auto Detect for an IPv6
Internet Connection on page 64).

•

If your Internet connection does not use pass-through, a fixed IP address, DHCP, 6rd, or PPPoE but is
IPv6, use the Auto Config connection type, which lets the modem router autoconfigure its IPv6 connection
(see Use Auto Config for an IPv6 Internet Connection on page 73).

When you enable IPv6 and select any connection type other than IPv6 pass-through, the modem router
starts the stateful packet inspection (SPI) firewall function on the WAN interface. The modem router creates
connection records and checks every inbound IPv6 packet. If the inbound packet is not destined to the
modem router itself and the modem router does not expect to receive such a packet, or the packet is not in
the connection record, the modem router blocks this packet. This function works in two modes: In secured
mode, the modem router inspects both TCP and UDP packets. In open mode, the modem router inspects
UDP packets only.
IPv6 addresses are denoted by eight groups of hexadecimal quartets that are separated by colons. You
can reduce any four-digit group of zeros within an IPv6 address to a single zero or omit it. The following
errors invalidate an IPv6 address:
•

More than eight groups of hexadecimal quartets

•

More than four hexadecimal characters in a quartet

•

More than two colons in a row

Use Auto Detect for an IPv6 Internet Connection
To set up an IPv6 Internet connection through autodetection:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
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The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > IPv6.
The Basic Settings page displays.
5. From the Internet Connection Type menu, select Auto Detect.

The modem router automatically detects the information in the following fields:
•

Connection Type. This field indicates the connection type that is detected.

•

Router’s IPv6 Address on WAN. This field shows the IPv6 address that is acquired for the modem
router’s WAN (or Internet) interface. The number after the slash (/) is the length of the prefix, which
is also indicated by the underline (_) under the IPv6 address. If no address is acquired, the field
displays Not Available.

•

Router’s IPv6 Address on LAN. This field shows the IPv6 address that is acquired for the modem
router’s LAN interface. The number after the slash (/) is the length of the prefix, which is also indicated
by the underline (_) under the IPv6 address. If no address is acquired, the field displays Not Available.

6. Select an IP Address Assignment radio button:
•
•

Use DHCP Server. This method passes more information to LAN devices but some IPv6 systems
might not support the DHCv6 client function.
Auto Config. This is the default setting.

This setting specifies how the modem router assigns IPv6 addresses to the devices on your home
network (the LAN).
7. (Optional) Select the Use This Interface ID check box and specify the interface ID to be used for the
IPv6 address of the modem router’s LAN interface.
If you do not specify an ID here, the modem router generates one automatically from its MAC address.
8. Click the Apply button.
Your settings are saved.
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Set Up an IPv6 6to4 Tunnel Internet Connection
The remote relay router is the device to which your modem router creates a 6to4 tunnel. Make sure that the
IPv4 Internet connection is working before you apply the 6to4 tunnel settings for the IPv6 connection.

To set up an IPv6 Internet connection by using a 6to4 tunnel:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > IPv6.
The Basic Settings page displays.
5. From the Internet Connection Type menu, select 6to4 Tunnel.

The modem router automatically detects the information in the Router’s IPv6 Address on LAN field. This
field shows the IPv6 address that is acquired for the modem router’s LAN interface. The number after
the slash (/) is the length of the prefix, which is also indicated by the underline (_) under the IPv6 address.
If no address is acquired, the field displays Not Available.
6. Select a Remote 6to4 Relay Router radio button:
•
•

Auto. Your modem router uses any remote relay modem router that is available on the Internet. This
is the default setting.
Static IP Address. Enter the static IPv4 address of the remote relay modem router. Your IPv6 ISP
usually provides this address.
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7. Select an IPv6 Domain Name Server (DNS) Address radio button:
•
•

Get Automatically from ISP. Your ISP uses DHCP to assign your DNS servers. Your ISP
automatically assigns this address.
Use These DNS Servers. If you know that your ISP requires specific servers, select this option.
Enter the IP address of your ISP’s primary DNS server. If a secondary DNS server address is
available, enter it also.

8. Select an IP Address Assignment radio button:
•
•

Use DHCP Server. This method passes more information to LAN devices but some IPv6 systems
might not support the DHCv6 client function.
Auto Config. This is the default setting.

This setting specifies how the modem router assigns IPv6 addresses to the devices on your home
network (the LAN).
9. (Optional) Select the Use This Interface ID check box and specify the interface ID to be used for the
IPv6 address of the modem router’s LAN interface.
If you do not specify an ID here, the modem router generates one automatically from its MAC address.
10. Click the Apply button.
Your settings are saved.

Set Up an IPv6 Pass Through Internet Connection
In pass-through mode, the modem router works as a Layer 2 Ethernet switch with two ports (LAN and WAN
Ethernet ports) for IPv6 packets. The modem router does not process any IPv6 header packets.

To set up a pass-through IPv6 Internet connection:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > IPv6.
The Basic Settings page displays.
5. From the Internet Connection Type menu, select Pass Through.
The page adjusts, but no additional fields display.
6. Click the Apply button.
Your settings are saved.
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Set Up an IPv6 Fixed Internet Connection
To set up a fixed IPv6 Internet connection:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > IPv6.
The Basic Settings page displays.
5. From the Internet Connection Type menu, select Fixed.

6. Configure the fixed IPv6 addresses for the WAN connection:
•

IPv6 Address/Prefix Length. The IPv6 address and prefix length of the modem router’s WAN
interface.

•

Default IPv6 Gateway. The IPv6 address of the default IPv6 gateway for the modem router’s WAN
interface.

•

Primary DNS Server. The primary DNS server that resolves IPv6 domain name records for the
modem router.

•

Secondary DNS Server. The secondary DNS server that resolves IPv6 domain name records for
the modem router.
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Note If you do not specify the DNS servers, the modem router uses the DNS servers that
are configured for the IPv4 Internet connection on the Internet Setup page. (See
Manually Set Up an ADSL Internet Connection on page 36, Manually Set Up a VDSL
Internet Connection on page 44, or Manually Set Up a Cable Internet Connection on
page 51.)

7. Select an IP Address Assignment radio button:
•
•

Use DHCP Server. This method passes more information to LAN devices but some IPv6 systems
might not support the DHCv6 client function.
Auto Config. This is the default setting.

This setting specifies how the modem router assigns IPv6 addresses to the devices on your home
network (the LAN).
8. In the IPv6 Address/Prefix Length fields, specify the static IPv6 address and prefix length of the modem
router’s LAN interface.
If you do not specify an ID here, the modem router generates one automatically from its MAC address.
9. Click the Apply button.
Your settings are saved.

Set Up an IPv6 DHCP Internet Connection
To set up an IPv6 Internet connection with a DHCP server:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > IPv6.
The Basic Settings page displays.
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5. From the Internet Connection Type menu, select DHCP.

The modem router automatically detects the information in the following fields:
•

Router’s IPv6 Address on WAN. This field shows the IPv6 address that is acquired for the modem
router’s WAN (or Internet) interface. The number after the slash (/) is the length of the prefix, which
is also indicated by the underline (_) under the IPv6 address. If no address is acquired, the field
displays Not Available.

•

Router’s IPv6 Address on LAN. This field shows the IPv6 address that is acquired for the modem
router’s LAN interface. The number after the slash (/) is the length of the prefix, which is also indicated
by the underline (_) under the IPv6 address. If no address is acquired, the field displays Not Available.

6. (Optional) In the User Class (If Required) field, enter a host name.
Most people can leave this field blank, but if your ISP gave you a specific host name, enter it here.
7. (Optional) In the Domain Name (If Required) field, enter a domain name.
You can type the domain name of your IPv6 ISP. Do not enter the domain name for the IPv4 ISP here.
For example, if your ISP’s mail server is mail.xxx.yyy.zzz, type xxx.yyy.zzz as the domain name. If your
ISP provided a domain name, type it in this field. For example, Earthlink Cable might require a host
name of home, and Comcast sometimes supplies a domain name.
8. Select an IPv6 Domain Name Server (DNS) Address radio button:
•
•

Get Automatically from ISP. Your ISP uses DHCP to assign your DNS servers. Your ISP
automatically assigns this address.
Use These DNS Servers. If you know that your ISP requires specific servers, select this option.
Enter the IP address of your ISP’s primary DNS server. If a secondary DNS server address is
available, enter it also.

9. Select an IP Address Assignment radio button:
•

Use DHCP Server. This method passes more information to LAN devices but some IPv6 systems
might not support the DHCv6 client function.
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•

Auto Config. This is the default setting.

This setting specifies how the modem router assigns IPv6 addresses to the devices on your home
network (the LAN).
10. (Optional) Select the Use This Interface ID check box and specify the interface ID to be used for the
IPv6 address of the modem router’s LAN interface.
If you do not specify an ID here, the modem router generates one automatically from its MAC address.
11. Click the Apply button.
Your settings are saved.

Set Up an IPv6 PPPoE Internet Connection
To set up a PPPoE IPv6 Internet connection:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > IPv6.
The Basic Settings page displays.
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5. From the Internet Connection Type menu, select PPPoE.

The modem router automatically detects the information in the following fields:
•

Router’s IPv6 Address on WAN. This field shows the IPv6 address that is acquired for the modem
router’s WAN (or Internet) interface. The number after the slash (/) is the length of the prefix, which
is also indicated by the underline (_) under the IPv6 address. If no address is acquired, the field
displays Not Available.

•

Router’s IPv6 Address on LAN. This field shows the IPv6 address that is acquired for the modem
router’s LAN interface. The number after the slash (/) is the length of the prefix, which is also indicated
by the underline (_) under the IPv6 address. If no address is acquired, the field displays Not Available.

6. In the Login field, enter the login information for the ISP connection.
This is usually the name that you use in your email address. For example, if your main mail account is
JerAB@ISP.com, you would type JerAB in this field. Some ISPs (like Mindspring, Earthlink, and T-DSL)
require that you use your full email address when you log in. If your ISP requires your full email address,
type it in this field.
7. In the Password field, enter the password for the ISP connection.
8. In the Service Name (If Required) field, enter a service name.
If your ISP did not provide a service name, leave this field blank.
Note The default setting of the Connection Mode menu is Always On to provide a steady
IPv6 connection. The modem router never terminates the connection. If the connection
is terminated, for example, when the modem is turned off, the modem router attempts
to reestablish the connection immediately after the PPPoE connection becomes
available again.
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9. Select an IPv6 Domain Name Server (DNS) Address radio button:
•
•

Get Automatically from ISP. Your ISP uses DHCP to assign your DNS servers. Your ISP
automatically assigns this address.
Use These DNS Servers. If you know that your ISP requires specific servers, select this option.
Enter the IP address of your ISP’s primary DNS server. If a secondary DNS server address is
available, enter it also.

10. Select an IP Address Assignment radio button:
•
•

Use DHCP Server. This method passes more information to LAN devices but some IPv6 systems
might not support the DHCv6 client function.
Auto Config. This is the default setting.

This setting specifies how the modem router assigns IPv6 addresses to the devices on your home
network (the LAN).
11. (Optional) Select the Use This Interface ID check box and specify the interface ID to be used for the
IPv6 address of the modem router’s LAN interface.
If you do not specify an ID here, the modem router generates one automatically from its MAC address.
12. Click the Apply button.
Your settings are saved.

Use Auto Config for an IPv6 Internet Connection
To set up an IPv6 Internet connection through autoconfiguration:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > IPv6.
The Basic Settings page displays.
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5. From the Internet Connection Type menu, select Auto Config.

The modem router automatically detects the information in the following fields:
•

Router’s IPv6 Address on WAN. This field shows the IPv6 address that is acquired for the modem
router’s WAN (or Internet) interface. The number after the slash (/) is the length of the prefix, which
is also indicated by the underline (_) under the IPv6 address. If no address is acquired, the field
displays Not Available.

•

Router’s IPv6 Address on LAN. This field shows the IPv6 address that is acquired for the modem
router’s LAN interface. The number after the slash (/) is the length of the prefix, which is also indicated
by the underline (_) under the IPv6 address. If no address is acquired, the field displays Not Available.

6. (Optional) In the DHCP User Class (If Required) field, enter a host name.
Most people can leave this field blank, but if your ISP gave you a specific host name, enter it here.
7. (Optional) In the DHCP Domain Name (If Required) field, enter a domain name.
You can type the domain name of your IPv6 ISP. Do not enter the domain name for the IPv4 ISP here.
For example, if your ISP’s mail server is mail.xxx.yyy.zzz, type xxx.yyy.zzz as the domain name. If your
ISP provided a domain name, type it in this field. For example, Earthlink Cable might require a host
name of home, and Comcast sometimes supplies a domain name.
8. Select an IPv6 Domain Name Server (DNS) Address radio button:
•
•

Get Automatically from ISP. Your ISP uses DHCP to assign your DNS servers. Your ISP
automatically assigns this address.
Use These DNS Servers. If you know that your ISP requires specific servers, select this option.
Enter the IP address of your ISP’s primary DNS server. If a secondary DNS server address is
available, enter it also.

9. Select an IP Address Assignment radio button:
•

Use DHCP Server. This method passes more information to LAN devices but some IPv6 systems
might not support the DHCv6 client function.
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•

Auto Config. This is the default setting.

This setting specifies how the modem router assigns IPv6 addresses to the devices on your home
network (the LAN).
10. (Optional) Select the Use This Interface ID check box and specify the interface ID to be used for the
IPv6 address of the modem router’s LAN interface.
If you do not specify an ID here, the modem router generates one automatically from its MAC address.
11. Click the Apply button.
Your settings are saved.

Set Up an IPv6 6rd Tunnel Internet Connection
The 6rd protocol makes it possible to deploy IPv6 to sites using a service provider’s IPv4 network. 6rd uses
the service provider’s own IPv6 address prefix. This limits the operational domain of 6rd to the service
provider’s network and is under direct control of the service provider. The IPv6 service that is provided is
equivalent to native IPv6.
The 6rd mechanism relies on an algorithmic mapping between the IPv6 and IPv4 addresses that are assigned
for use within the service provider’s network. This mapping allows for automatic determination of IPv4 tunnel
endpoints from IPv6 prefixes, enabling stateless operation of 6rd.

To set up an IPv6 6rd tunnel connection:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > IPv6.
The Basic Settings page displays.
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5. From the Internet Connection Type menu, select 6rd Tunnel.

The modem router automatically detects the information in the Router’s IPv6 Address on LAN field.
This field shows the IPv6 address that is acquired for the modem router’s LAN interface. The number
after the slash (/) is the length of the prefix, which is also indicated by the underline (_) under the IPv6
address. If no address is acquired, the field displays Not Available.
6. In the 6rd (IPv6 Rapid Deployment) Configuration section, configure the 6rd settings:
•

6rd Prefix. Enter the IPv6 prefix that your ISP gave you.

•

6rd Prefix Length. Enter the IPv6 prefix length that your ISP gave you.

•

6rd Border Relay Address. Enter the border router’s IPv4 address that your ISP gave you.

•

6rd Address Mask Length. Enter the IPv4 mask length that your ISP gave you.

7. Select an IPv6 Domain Name Server (DNS) Address radio button:
•
•

Get Automatically from ISP. Your ISP uses DHCP to assign your DNS servers. Your ISP
automatically assigns this address.
Use These DNS Servers. If you know that your ISP requires specific servers, select this option.
Enter the IP address of your ISP’s primary DNS server. If a secondary DNS server address is
available, enter it also.

8. Select an IP Address Assignment radio button:
•
•

Use DHCP Server. This method passes more information to LAN devices but some IPv6 systems
might not support the DHCv6 client function.
Auto Config. This is the default setting.

This setting specifies how the modem router assigns IPv6 addresses to the devices on your home
network (the LAN).
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9. (Optional) Select the Use This Interface ID check box and specify the interface ID to be used for the
IPv6 address of the modem router’s LAN interface.
If you do not specify an ID here, the modem router generates one automatically from its MAC address.
10. (Optional) In the MTU Size (in bytes) field, enter the maximum transmission unit (MTU) for the IPv6
packets.
By default, the MTU for IPv6 packets is 1480 bytes.
11. Click the Apply button.
Your settings are saved.

Manage the MTU Size
The maximum transmission unit (MTU) is the largest data packet a network device transmits.

MTU Concepts
When one network device communicates across the Internet with another, the data packets travel through
many devices along the way. If a device in the data path uses a lower maximum transmission unit (MTU)
setting than the other devices, the data packets must be split or “fragmented” to accommodate the device
with the smallest MTU.
The best MTU setting for NETGEAR equipment is often the default value. In some situations, changing the
value fixes one problem but causes another.
Leave the MTU unchanged unless one of these situations occurs:
•

You experience problems connecting to your ISP or other Internet service, and the technical support of
either the ISP or NETGEAR recommends changing the MTU setting. These web-based applications
might require an MTU change:
-

A secure website that does not open or displays only part of a web page

-

Yahoo email

•

You use VPN and experience severe performance problems.

•

You used a program to optimize MTU for performance reasons and now you are experiencing connectivity
or performance problems.

If you suspect an MTU problem, a common solution is to change the MTU to 1400. If you are willing to
experiment, you can gradually reduce the MTU from the maximum value of 1500 until the problem goes
away. The following table describes common MTU sizes and applications.
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Table 3. Common MTU sizes
MTU

Application

1500

The largest Ethernet packet size. This setting is typical for connections
that do not use PPPoE or VPN and is the default value for NETGEAR
modem routers, adapters, and switches.

1492

Used in PPPoE environments.

1472

Maximum size to use for pinging. (Larger packets are fragmented.)

1468

Used in some DHCP environments.

1458

Used in PPPoA environments.

1436

Used in PPTP environments or with VPN.

Change the MTU Size
WARNING:
An incorrect MTU setting can cause Internet communication problems. For
example, you might not be able to access certain websites, frames within
websites, secure login pages, or FTP or POP servers. Change the MTU only
if you are sure that it is necessary for your ISP connection.

To change the MTU size:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup > WAN Setup.
The WAN Setup page displays.
5. Click the Apply button.
Your settings are saved.
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4

This chapter explains how the modem router manages WiFi connections for its WiFi bands and how you can
control the relevant modem router settings.
The chapter contains the following sections:
•

Tri-Band WiFi on page 80

•

Smart Connect on page 83

•

Enable or Disable Smart Connect on page 84
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Tri-Band WiFi
Tri-band WiFi delivers combined WiFi speeds of 5.3 Gbps through three dedicated WiFi bands—a 2.4 GHz
band plus two 5 GHz bands. This additional 5 GHz WiFi band allows you to double the WiFi bandwidth for
dual-band devices.

Figure 10. Tri-band WiFi doubles the available bandwidth for dual-band devices
Smart Connect intelligently selects the best WiFi band for each dual-band device to optimize connection
speed and performance based on that device’s speed and performance capabilities. This additional WiFi
bandwidth combined with the intelligence to segregate traffic based on WiFi speed and load balancing
provides the best performance for multiple WiFi devices in your home.

How Tri-Band WiFi Improves Speed and Performance
Tri-band WiFi increases the available WiFi bandwidth for your network to reduce network congestion.
Typically, a dual-band WiFi modem router shares bandwidth among all connected devices that are
downloading data at the same time. So if you are watching a Netflix movie on your Internet-enabled
large-screen TV while your kids are watching a YouTube video on a smartphone, the modem router shares
the bandwidth across these two devices. This is particularly unfair for the faster 802.11ac devices or
three-stream (3x3) 802.11n devices because their speeds are reduced to the speed of the slowest device
in the network. Even one slow device can bring down the entire network speed.
In this simplified example, the 5 GHz band is capable of a maximum speed of 1733 Mbps, but the actual
speed could be limited by the device capability. For example, an Apple MacBook Pro with support for three
streams is capable of the maximum 1300 Mbps, but the Tri-Band WiFi Connections iPhone 5S with support
for only single-stream 802.11n can achieve a maximum WiFi speed of only 150 Mbps. As more devices
connect and begin downloading, the bandwidth is shared among them as well.
The following example of shared bandwidth shows a dual-band modem router in which the GHz WiFi band
is capable of a fast 640 Mbps speed. If only one computer or device connects, the modem router can allocate
a speed of up to 640 Mbps to that connection, assuming that the device is capable of that speed. When
more devices connect to the 5 GHz band, they must share the bandwidth. If four devices connect, then the
modem router divides its 640 Mbps capacity by 5, as shown in the following figure.
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Figure 11. Dual-band WiFi network with one 5 GHz WiFi band
That means that in the network shown, a computer with a 1,300 Mbps capacity provides an effective WiFi
connection speed of 160 Mbps (1300 ÷ 5), and other devices would also see their WiFi speeds divided by
5.
Tri-band WiFi adds a second 5 GHz WiFi band to the network. This increases the available WiFi bandwidth,
which can be compared to widening the road. In addition to widening the road, using two 5 GHz bands
means that the modem router provides dedicated 5 GHz bands. That’s like tri-band WiFi connections using
two lanes in the wider road instead of one. The modem router automatically uses Smart Connect to allocate
the fastest devices to the fast lane.
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Figure 12. A tri-band network includes two dedicated 5 GHz bands
In this tri-band network, the first 5 GHz band provides a speed of 200 Mbps, and the second 5 GHz band
provides a speed of 1300 Mbps.
The slower and faster devices are separated in different WiFi connections to ensure that you get the best
speed on each device. So in the previous figure, all three mobile devices are on one 5 GHz band with a
combined maximum speed of 200 Mbps, and the other 5 GHz WiFi band is used for the faster 802.11ac
devices with a combined maximum speed of 1300 Mbps. Effectively both slower and faster devices can run
faster and the overall network speed increases by more than two times, from 640 Mbps to 1500 Mbps.

Load Balancing
The modem router uses load balancing to distribute WiFi connections among all three WiFi bands, to ensure
that both the WiFi bands are utilized. Load balancing prevents overloading a single 5 GHz band and ensures
that both the WiFi bands are utilized and device connections are spread across the two bands.
For example, if three mobile devices are connected to one 5 GHz band, the fourth device is automatically
connected to the other 5 GHz band.
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Figure 13. Load balancing
Slower devices like printers, older computers, or IP cameras connect to the 2.4 GHz band. The presence
of two 5 GH bands prevents overloading when many devices use WiFi at the same time.

Benefits of Tri-Band WiFi
The tri-band WiFi network outperforms the dual-band network in several ways:
•

More bandwidth is available.
Even with more devices connected to the network, because the connections are spread across two
different bands, each device gets a larger share of the available WiFi bandwidth.

•

Smart Connect directs WiFi traffic to the appropriate lane.
With Smart Connect, older devices do not slow down faster devices.

•

The modem router uses load balancing to avoid network congestion in each WiFi band.
With load balancing, you don’t need to share your WiFi connection with as many devices.

Smart Connect
Smart Connect balances your 5 GHz WiFi connections into two different radio bands: the 5 GHz radio 1
band and the 5 GHz radio 2 band. The modem router uses Smart Connect to choose the best radio band
for your device to give you the best WiFi performance.
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Figure 14. Smart Connect
For Smart Connect to work, both 5 GHz radio bands must use the same WiFi network name (SSID) and
network key (password). That means that when you connect to the modem router with WiFi, you see only
one 5 GHz SSID that connects to both 5 GHz radio bands.
Note If you enable Smart Connect and the SSID and passwords for both 5 GHz radio bands
do not match, the WiFi settings for 5 GHz radio 1 overwrite the WiFi settings for 5
GHz radio 2.

Enable or Disable Smart Connect
To enable or disable Smart Connect:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select Wireless.
The Wireless Setup page displays.
5. Select or clear the the Smart Connect – One Wireless Network Name (SSID) for both 5 GHz radios
check box.
Selecting this check box turns on Smart Connect and clearing this check box turns off Smart Connect.
6. Click the Apply button.
Your settings are saved.
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This chapter describes how you can manage the basic WiFi network settings of the modem router. For information
about the advanced WiFi settings, see Manage the Advanced WiFi Features on page 213.
The chapter includes the following sections:
•

Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 86

•

Use WPS to Add a Device to the WiFi Network on page 96

•

Manage the Basic WiFi Settings and WiFi Security of the Guest Network on page 98

•

Control the WiFi Radios on page 102

For information about setting up an access control list (ACL) and managing WiFi access for enhanced security,
see Allow or Block Access to Your Network on page 106.
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Manage the Basic WiFi Settings and WiFi Security of the
Main Network
The modem router comes with preset security. This means that the WiFi network name (SSID), network
key (password), and security option (encryption protocol) are preset in the factory. The preset SSID and
password are uniquely generated for every device to protect and maximize your WiFi security. You can find
the preset SSID and password on the modem router label (see Product Label on page 14).
IMPORTANT:
If you change your preset security settings, make a note of the new settings and
store the note in a safe place where you can easily find it.

View or Change the Basic WiFi Settings
You can view or change the basic WiFi settings and WiFi security. The modem router is a tri-band WiFi
access point that simultaneously supports the 2.4 GHz band for 802.11b/g/n devices and two 5 GHz bands
(5GHz-1 and 5GHz-2) for 802.11a/n/ac devices.
Tip If you change the WiFi settings of the modem router’s main network, use a wired
connection to avoid being disconnected when the new WiFi settings take effect.

To view or change the basic WiFi settings:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
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4. Select Wireless.

5. View or change the basic WiFi settings and security settings.
The following table describes the fields on the Wireless Setup page.
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Field

Description

Region Selection
Region

From the menu, select the region in which the modem router operates.
Note It might not be legal to operate the modem router in a region other than
the regions listed in the menu. If your country or region is not listed,
check with your local government agency.

Wireless Network (2.4GHz b/g/n)
Enable SSID Broadcast By default, the modem router broadcasts its SSID so that WiFi stations can detect the
WiFi name (SSID) in their scanned network lists. To turn off the SSID broadcast, clear
the Enable SSID Broadcast check box. Turning off the SSID broadcast provides
additional WiFi security, but users must know the SSID to be able to join the WiFi network
of the modem router.
Name (SSID)

The SSID is the 2.4 GHz WiFi network name. If you did not change the SSID, the default
SSID displays. The default SSID is also printed on the modem router label (see Product
Label on page 14).
Note If you change the SSID, enter a 32-character (maximum), case-sensitive
name in this field.

Channel

From the Channel menu, select Auto for automatic channel selection or select an
individual channel. The default selection is Auto.
Note In some regions, not all channels are available. Do not change the
channel unless you experience interference (shown by lost connections
or slow data transfers). If this situation occurs, experiment with different
channels to see which is the best.

Note If you use multiple WiFi access points (APs), reduce interference by
selecting different channels for adjacent APs. We recommend a channel
spacing of four channels between adjacent APs (for example, use
Channels 1 and 5, or 6 and 10).
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(Continued)
Field

Description

Mode

From the Mode menu, select one of the following modes:
•

Up to 54 Mbps. Legacy mode. This mode allows 802.11n, 802.11g, and 802.11b
devices to join the network but limits 802.11n devices to functioning at up to 54 Mbps.

•

Up to 433 Mbps. Neighbor-friendly mode for reduced interference with neighboring
WiFi networks. This mode allows 802.11n, 802.11g, and 802.11b devices to join the
network but limits 802.11n devices to functioning at up to 433 Mbps.

•

Up to 1000 Mbps. Performance mode. This mode allows 802.11n, 802.11g, and
802.11b devices to join the network and allows 802.11n devices to function at up to
1000 Mbps. This mode is the default mode.
Note WPA-PSK security supports speeds of up to 54 Mbps. Even if your
devices are capable of a higher speed, WPA-PSK security limits
their speed to 54 Mbps.

Security Options
This information applies to the 2.4 GHz WiFi network.
If you change the WiFi security, select one of the following WiFi security options for the modem router’s WiFi
network:
•

None. An open WiFi network that does not provide any security. Any WiFi device can join the WiFi network.
We recommend that you do not use an open WiFi network.

•

WEP. Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption mode that is
superseded by WPA-PSK and WPA2-PSK. The WEP option displays only if you select Up to 54 Mbps from
the Mode menu. For information about configuring WEP, see Configure WEP Legacy WiFi Security on page
94.

•

WPA2-PSK [AES]. This option is the default setting. This type of security enables WiFi devices that support
WPA2 to join the modem router’s 2.4 GHz WiFi network. If you did not change the passphrase, the default
passphrase displays. The default passphrase is printed on the modem router label (see Product Label on
page 14). WPA2 provides a secure connection but some older WiFi devices do not detect WPA2 and support
only WPA. If your network includes such older devices, select WPA-PSK [TKIP] + WPA2-PSK [AES] security.
If you change the passphrase, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the
modem router’s WiFi network, a user must enter this passphrase.

•

WPA-PSK [TKIP] + WPA2-PSK [AES]. This type of security enables WiFi devices that support either WPA
or WPA2 to join the modem router’s 2.4 GHz WiFi network. However, WPA-PSK [TKIP] is less secure than
WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.
To use this type of security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the modem
router’s WiFi network, a user must enter this passphrase.

•

WPA/WPA2 Enterprise. This type of security requires that your WiFi network can access a RADIUS server.
For information about configuring WPA/WPA2 Enterprise, see Configure WPA/WPA2 Enterprise WiFi Security
on page 92.
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(Continued)
Field

Description

Wireless Network (5GHz a/n/ac)
The modem router supports two 5 GHz bands (5GHz-1 and 5GHz-2) for 802.11a/n/ac devices. These bands can
function either independently or in a Smart Connect configuration. (For more information about Smart Connect,
see Smart Connect on page 83.)
When Smart Connect is enabled, both 5 GHz radio bands use the same WiFi network name (SSID) and network
key (password). That means that when you connect to the router with WiFi, you see only one 5 GHz SSID that
connects to both 5 GHz radio bands.
Smart Connect - One
Wireless Network Name
(SSID) for both 5GHz
radios

To let both 5 GHz bands function in a Smart Connect configuration, select this check
box and configure the settings for the 5GHz-1 band. The settings for the 5GHz-2 band
are automatically configured and are identical to those of the 5GHz-1 band. The only
exception is the channel: When Smart Connect is enabled, you can still select a channel
for the 5GHz-2 band so that each 5 GHz band supports a unique channel.
Note If you enable Smart Connect and the SSID and passwords for both 5
GHz bands do not match, the settings for the 5GHz-1 band overwrite
the settings for the 5GHz-2 band .
To let the 5GHz-1 and 5GHz-2 bands function independently, leave the check box cleared
and configure each 5 GHz band with its own settings.

Enable SSID Broadcast By default, for an SSID in the 5 GHz band, the modem router broadcasts the SSID so
that WiFi stations can detect the WiFi name (SSID) in their scanned network lists. To
turn off an SSID broadcast, clear the appropriate Enable SSID Broadcast check box.
Turning off an SSID broadcast provides additional WiFi security, but users must know
the SSID to be able to join the WiFi network of the modem router.
Name (SSID)

The SSIDs are the 5 GHz WiFi band names. If you did not change the SSID, the default
SSID displays. The default SSID is also printed on the modem router label (see Product
Label on page 14).
Note If you change the SSID, enter a 32-character (maximum), case-sensitive
name in this field.

Channel

From the Channel menu, select an individual channel for a 5 GHz SSID. The default
channel depends on your selection from the Region menu.
Note In some regions, not all channels are available. Do not change the
channel unless you experience interference (shown by lost connections
or slow data transfers). If this situation occurs, experiment with different
channels to see which is the best.

Note If you use multiple WiFi access points (APs), reduce interference by
selecting different channels for adjacent APs. We recommend a channel
spacing of four channels between adjacent APs.
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(Continued)
Field

Description

Mode

From the appropriate Mode menu, select one of the following modes for a 5 GHz SSID:
•

Up to 433 Mbps. Legacy mode. This mode allows 802.11ac, 802.11n, and 802.11a
devices to join the selected WiFi network in the 5 GHz band of the network but limits
802.11ac and 802.11n devices to functioning at up to 433 Mbps.

•

Up to 1000 Mbps. Neighbor-friendly mode for reduced interference with neighboring
WiFi networks. This mode allows 802.11ac, 802.11n, and 802.11a devices to join
the selected WiFi network in the 5 GHz band of the network but limits 802.11ac
devices to functioning at up to 1000 Mbps.

•

Up to 2165 Mbps. Performance mode. This mode allows 802.11ac, 802.11n, and
802.11a devices to join the selected WiFi network in the 5 GHz band of the network
and allows 802.11ac devices to function at up to 2165 Mbps. This mode is the default
mode.

Security Options
This information applies to the 5 GHz WiFi network.
If you change the WiFi security, select one of the following WiFi security options for the modem router’s WiFi
network:
•

None. An open WiFi network that does not provide any security. Any WiFi device can join the selected WiFi
network in the 5 GHz band of the WiFi network. We recommend that you do not use an open WiFi network.

•

WPA2-PSK [AES]. This option is the default setting. This type of security enables WiFi devices that support
WPA2 to join the selected WiFi network in the 5 GHz band of the WiFi network. If you did not change the
passphrase, the default passphrase displays. The default passphrase is printed on the modem router label
(see Product Label on page 14). WPA2 provides a secure connection but some older WiFi devices do not
detect WPA2 and support only WPA. If your network includes such older devices, select WPA-PSK [TKIP] +
WPA2-PSK [AES] security.
If you change the passphrase, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the
selected WiFi network in the 5 GHz band of the WiFi network, a user must enter this passphrase.

•

WPA-PSK [TKIP] + WPA2-PSK [AES]. This type of security enables WiFi devices that support either WPA
or WPA2 to join the selected WiFi network in the 5 GHz band of the WiFi network. However, WPA-PSK [TKIP]
is less secure than WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.
To use this type of security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the selected
WiFi network in the 5 GHz band of the WiFi network, a user must enter this passphrase.

•

WPA/WPA2 Enterprise. This type of security requires that your WiFi network can access a RADIUS server.
For information about configuring WPA/WPA2 Enterprise, see Configure WPA/WPA2 Enterprise WiFi Security
on page 92.

6. Click the Apply button.
Your settings are saved.
If you connected over WiFi to the network and you changed the SSID, you are disconnected from the
network.
7. Make sure that you can reconnect over WiFi to the network with its new settings.
If you cannot connect over WiFi, check the following:
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•

•

•
•

If your computer or mobile device is already connected to another WiFi network in your area,
disconnect it from that WiFi network and connect it to the WiFi network that the modem router
provides. Some WiFi devices automatically connect to the first open network without WiFi security
that they discover.
If your computer or mobile device is trying to connect to your network with its old settings (before
you changed the settings), update the WiFi network selection in your computer or mobile device to
match the current settings for your network.
Does your computer or mobile device display as an attached device? (See View Devices Currently
on the Network on page 201.) If it does, it is connected to the network.
Are you using the correct network name (SSID) and password?

Configure WPA/WPA2 Enterprise WiFi Security
Remote Authentication Dial In User Service (RADIUS) is an enterprise-level method for centralized
Authentication, Authorization, and Accounting (AAA) management. To enable the modem router to provide
WPA and WPA2 enterprise WiFi security, the WiFi network that the modem router provides must be able
to access a RADIUS server.
Tip If you want to change the WiFi settings of the modem router’s main network, use a wired
connection to avoid being disconnected when the new WiFi settings take effect.

To configure WPA and WPA2 enterprise security:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select Wireless.
The Wireless Setup page displays.
Note If you are configuring a guest network, select Guest Network instead. The Guest
Network Settings page displays.
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5. In the Security Options section below either the Wireless Network (2.4GHz b/g/n) section or the Wireless
Network (5GHz a/n/ac) section, select the WPA/WPA2 Enterprise radio button.

6. In the WPA/WPA2 Enterprise section, enter the settings as described in the following table.
Field

Description

Encryption Mode

From the Encryption Mode menu, select the enterprise mode:
•

WPA [TKIP] +WPA2 [AES]. This type of security enables WiFi devices
that support either WPA or WPA2 to join the modem router’s WiFi
network. This is the default mode.

•

WPA2 [AES]. WPA2 provides a secure connection but some older WiFi
devices do not detect WPA2 and support only WPA. If your network
includes such older devices, select WPA [TKIP] + WPA2 [AES] security.

Group Key Update Interval

Enter the interval in seconds after which the RADIUS group key is updated.
The default interval is 3600 seconds.

RADIUS server IP Address

Enter the IPv4 address of the RADIUS server to which the WiFi network can
connect.

RADIUS server Port

Enter the number of the port on the modem router that is used to access the
RADIUS server for authentication. The default port number is 1812.

RADIUS server Shared Secret Enter the shared secret (RADIUS password) that is used between the modem
router and the RADIUS server during authentication of a WiFi user.

7. Click the Apply button.
Your settings are saved.
8. Make sure that you can reconnect over WiFi to the network with its new security settings.
If you cannot connect over WiFi, check the following:
•

If your computer or mobile device is already connected to another WiFi network in your area,
disconnect it from that WiFi network and connect it to the WiFi network that the modem router
provides. Some WiFi devices automatically connect to the first open network without WiFi security
that they discover.
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•

•
•

If your computer or mobile device is trying to connect to your network with its old settings (before
you changed the settings), update the WiFi network selection in your computer or mobile device to
match the current settings for your network.
Does your computer or mobile device display as an attached device? (See View Devices Currently
on the Network on page 201.) If it does, it is connected to the network.
Are you using the correct network name (SSID) and password?

Configure WEP Legacy WiFi Security
Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption mode that is
superseded by WPA-PSK and WPA2-PSK. WEP limits the WiFi transmission speed to 54 Mbps (the modem
router is capable of speeds of up 1000 Mbps in the 2.4 GHz band).
Tip If you want to change the WiFi settings of the modem router’s main network, use a wired
connection to avoid being disconnected when the new WiFi settings take effect.

To configure WEP security:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select Wireless.
The Wireless Setup page displays.
5. From the Mode menu, select Up to 54 Mbps.
The page adjusts to display the WEP radio button.
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6. In the Security Options section, select the WEP radio button.

7. From the Authentication Type menu, select one of the following types:
•
•

Automatic. Clients can use either Open System or Shared Key authentication.
Shared Key. Clients can use only Shared Key authentication.

8. From the Encryption Strength menu, select the encryption key size:
•
•

64-bit. Standard WEP encryption, using 40/64-bit encryption.
128-bit. Standard WEP encryption, using 104/128-bit encryption. This selection provides higher
encryption security.

9. Specify the active key by selecting the Key 1, Key 2, Key 3, or Key 4 radio button.
Only one key can be the active key. To join the modem router’s WiFi network, a user must enter the
key value for the key that you specified as the active key.
10. Enter a value for the key:
•
•

For 64-bit WEP, enter 10 hexadecimal digits (any combination of 0–9, A–F). The key values are not
case-sensitive.
For 128-bit WEP, enter 26 hexadecimal digits (any combination of 0–9, A–F). The key values are
not case-sensitive.

11. Click the Apply button.
Your settings are saved.
12. Make sure that you can reconnect over WiFi to the network with its new security settings.
If you cannot connect over WiFi, check the following:
•

•

If your computer or mobile device is already connected to another WiFi network in your area,
disconnect it from that WiFi network and connect it to the WiFi network that the modem router
provides. Some WiFi devices automatically connect to the first open network without WiFi security
that they discover.
If your computer or mobile device is trying to connect to your network with its old settings (before
you changed the settings), update the WiFi network selection in your computer or mobile device to
match the current settings for your network.
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•
•

Does your computer or mobile device display as an attached device? (See View Devices Currently
on the Network on page 201.) If it does, it is connected to the network.
Are you using the correct WiFi network name (SSID) and password?

Use WPS to Add a Device to the WiFi Network
WPS (Wi-Fi Protected Setup) lets you connect a computer or mobile device to the modem router’s network
without entering the WiFi network passphrase or key. Instead, you use a WPS button or enter a PIN to
connect.
If you use the push button method, the computer or device that you are trying to connect must provide either
a physical button or a software button. If you use the PIN method, you must know the PIN of the computer
or device that you are trying to connect.
WPS supports WPA and WPA2 WiFi security. If your modem router network is open (no WiFi security is
set, which is not the default setting for the modem router), connecting with WPS automatically sets WPA +
WPA2 WiFi security on the modem router network and generates a random passphrase. You can view this
passphrase (see Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 86).

Use WPS With the Push Button Method
For you to use the push button method to connect a WiFi device to the modem router’s WiFi network, the
WiFi device that you are trying to connect must provide either a physical button or a software button. You
can use the physical button and software button to let a WiFi device join only the main WiFi network, not
the guest WiFi network.

To let a WiFi device join the modem router’s main WiFi network using WPS with the push
button method:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > WPS Wizard.
The page displays a description of the WPS method.
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5. Click the Next button.

By default, the Push Button (recommended) radio button is selected.
6. Either click the
button onscreen or press the WPS button on the right side panel of the modem router.
For two minutes, the modem router attempts to find the WiFi device (that is, the client) that you want to
join the modem router’s main WiFi network.
During this time, the LED on the WPS button blinks.
7. Within two minutes, go to the WiFi device and press its WPS button to join the modem router’s main
WiFi network without entering a password.
After the modem router establishes a WPS connection, the LED on the WPS button stops blinking and
the Add WPS Client page displays a confirmation message.
8. To verify that the WiFi device is connected to the modem router’s main WiFi network, select BASIC >
Attached Devices.
The WiFi device displays onscreen.

Use WPS With the PIN Method
To use the PIN method to connect a WiFi device to the modem router’s WiFi network, you must know the
PIN of the WiFi device that you are trying to connect.

To let a WiFi device join the modem router’s WiFi network using WPS with the PIN method:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > WPS Wizard.
The page displays a description of the WPS method.
5. Click the Next button.
The Add WPS Client page adjusts.
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The Push Button (recommended) radio button is selected by default.
6. Select the PIN Number radio button.

7. In the Enter Clients’ PIN field, enter the PIN number of the WiFi device.
8. Click the Next button.
For four minutes, the modem router attempts to find the WiFi device (that is, the client) that you want
to join the modem router’s main WiFi network.
During this time, the LED on the WPS button blinks.
9. Within four minutes, go to the WiFi device and use its WPS software to join the network without entering
a password.
After the modem router establishes a WPS connection, the LED on the WPS button stops blinking and
the Add WPS Client page displays a confirmation message.
10. To verify that the WiFi device is connected to the modem router’s main WiFi network, select BASIC >
Attached Devices.
The WiFi device displays onscreen.

Manage the Basic WiFi Settings and WiFi Security of the
Guest Network
A guest network allows visitors to use the Internet without using your WiFi security key. By default, the guest
WiFi network is disabled. You can enable and configure the guest WiFi network for each WiFi band. The
modem router simultaneously supports the 2.4 GHz band for 802.11n, 802.11g, and 802.11b devices and
the 5 GHz band with two separate SSIDs for 802.11ac, 802.11n, and 802.11a devices.
The WiFi mode of the guest WiFi network depends on the WiFi mode of the main WiFi network. For example,
if you configure the WiFi mode for the main WiFi network as Up to 54 Mbps in the 2.4 GHz band, the guest
WiFi network also functions in the Up to 54 Mbps mode in the 2.4 GHz band. For information about configuring
the WiFi mode, see View or Change the Basic WiFi Settings on page 86.
The modem router provides three default guest networks with the following names (SSIDs):
•

2.4 GHz band. NETGEAR-Guest

•

First 5 GHz band. NETGEAR-5G-Guest

•

Second 5 GHz band NETGEAR-5G-2-Guest
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By default, these networks are configured as open networks without security but are disabled. You can
enable one or both networks. You can also change the SSIDs for these networks.

To set up a guest network:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select Guest Network.

5. Enable the guest network and configure its WiFi settings as described in the following table.
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Field

Description

Wireless Network (2.4GHz b/g/n)
Enable Guest Network

By default, the guest WiFi network is disabled. To enable the guest WiFi network for the
2.4 GHz WiFi band, select the Enable Guest Network check box.

Enable SSID Broadcast By default, the modem router broadcasts the SSID of the 2.4 GHz WiFi band so that
WiFi stations can detect the WiFi name (SSID) in their scanned network lists. To turn off
the SSID broadcast for the 2.4 GHz WiFi band for the guest WiFi network, clear the
Enable SSID Broadcast check box.
Allow guests to see each By default, WiFi clients that are connected to the 2.4 GHz WiFi band of the guest WiFi
other and access my
network cannot access WiFi devices or Ethernet devices that are connected to the main
local network
WiFi network. To allow access to the main WiFi network, select the Allow guests to
see each other and access my local network check box.
Guest Wireless Network The SSID is the 2.4 GHz WiFi band name. If you did not change the SSID, the default
Name (SSID)
SSID displays, which is NETGEAR-Guest.
To change the SSID in the 2.4 GHz WiFi band for the guest WiFi network, enter a
32-character (maximum), case-sensitive name in this field.
Security Options
If you want to change the WiFi security, select one of the following WiFi security options for the 2.4 GHz band of
the guest WiFi network:
•

None. An open WiFi network that does not provide any security. Any WiFi device can join the 2.4 GHz band
of the guest WiFi network. This is the default setting for the guest WiFi network.

•

WEP. Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption mode that is
superseded by WPA-PSK and WPA2-PSK. The WEP option displays only if you configure the WiFi mode for
the main WiFi network as Up to 54 Mbps in the 2.4 GHz band (see View or Change the Basic WiFi Settings
on page 86). For information about configuring WEP, see Configure WEP Legacy WiFi Security on page 94.

•

WPA2-PSK [AES]. WPA2 provides a secure and fast connection but some older WiFi devices do not detect
WPA2 and support only WPA. Select WPA2-PSK [AES] security to allow 802.11n devices to connect to the
2.4 GHz band of the guest WiFi network at the fastest speed. If your network includes older devices that do
not support WPA2, select WPA-PSK [TKIP] + WPA2-PSK [AES] security.
To use WPA2 security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the 2.4 GHz
band of the guest WiFi network, a user must enter this passphrase.

•

WPA-PSK [TKIP] + WPA2-PSK [AES]. This type of security enables WiFi devices that support either WPA
or WPA2 to join the 2.4 GHz band of the guest WiFi network. However, WPA-PSK [TKIP] is less secure than
WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.
To use WPA + WPA2 security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the
2.4 GHz band of the guest WiFi network, a user must enter this passphrase.

Passphrase

The passphrase that provides users access to the guest WiFi network in the 2.4 GHZ
band. The passphrase is also referred to as the password or key.

Wireless Network (5GHz a/n/ac)
The modem router provides two SSIDs for guest access in the 5 GHz band.
Enable Guest Network

By default, the guest WiFi network is disabled. To enable the guest WiFi network for an
SSID in the 5 GHz WiFi band, select the appropriate Enable Guest Network check box.
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(Continued)
Field

Description

Enable SSID Broadcast By default, for an SSID in the 5 GHz band, the modem router broadcasts the SSID so
that WiFi stations can detect the WiFi name (SSID) in their scanned network lists. To
turn off an SSID broadcast for the 5 GHz WiFi band for the guest WiFi network, clear
the appropriate Enable SSID Broadcast check box.
Allow guests to see each By default, WiFi clients that are connected to an SSID in the 5 GHz WiFi band of the
other and access my
guest WiFi network cannot access WiFi devices or Ethernet devices that are connected
local network
to the main WiFi network.To allow access to the main WiFi network, select the appropriate
Allow guests to see each other and access my local network check box.
Guest Wireless Network The SSIDs are the 5 GHz WiFi band names. If you did not change the SSIDs, the default
Name (SSID)
SSIDs display, which are NETGEAR-5G-Guest and NETGEAR-5G-2-Guest. To change
an SSID in the 5 GHz WiFi band for the guest WiFi network, enter a 32-character
(maximum), case-sensitive name in the appropriate field.
Security Options
If you want to change the WiFi security for an SSID in the 5 GHz band, select one of the following WiFi security
options for that SSID in the guest WiFi network:
•

None. An open WiFi network that does not provide any security. Any WiFi device can join the selected WiFi
network in the 5 GHz band of the guest WiFi network. This is the default setting for the guest WiFi network.

•

WPA2-PSK [AES]. WPA2 provides a secure and fast connection but some older WiFi devices do not detect
WPA2 and support only WPA. Select WPA2-PSK [AES] security to allow 802.11ac and 802.11n devices to
connect to the selected WiFi network in the 5 GHz band of the guest WiFi network at the fastest speed. If
your network includes older devices that do not support WPA2, select WPA-PSK [TKIP] + WPA2-PSK [AES]
security.
To use WPA2 security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the selected
WiFi network in the 5 GHz band of the guest WiFi network, a user must enter this passphrase.

•

WPA-PSK [TKIP] + WPA2-PSK [AES]. This type of security enables WiFi devices that support either WPA
or WPA2 to join the selected WiFi network in the 5 GHz band of the guest WiFi network. However, WPA-PSK
[TKIP] is less secure than WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.
To use WPA + WPA2 security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the
selected WiFi network in the 5 GHz band of the guest WiFi network, a user must enter this passphrase.

Passphrase

The passphrase that provides users access to the selected WiFi network in the 5 GHz
band of the guest WiFi network. The passphrase is also referred to as the password or
key.

6. Click the Apply button.
Your settings are saved.
7. Make sure that you can reconnect over WiFi to the guest network.
If you cannot connect over WiFi, check the following:
•

If your computer or mobile device is already connected to another WiFi network in your area,
disconnect it from that WiFi network and connect it to the WiFi network that the modem router
provides. Some WiFi devices automatically connect to the first open network without WiFi security
that they discover.
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•
•

Does your computer or mobile device display as an attached device? (See View Devices Currently
on the Network on page 201.) If it does, it is connected to the network.
Are you using the correct network name (SSID) and password?

Control the WiFi Radios
The modem router provides internal WiFi radios that broadcast signals in the 2.4 GHz and 5 GHz ranges.
By default, they are on so that you can connect over WiFi to the modem router. When the WiFi radios are
off, you can still use an Ethernet cable for a LAN connection to the modem router.
You can turn the WiFi radios on and off with the WIFI button on the front panel, or you can log in to the
modem router and enable or disable the WiFi radios through the modem router web pages. If you are close
to the modem router, it might be easier to press the WIFI button. If you are away from the modem router or
already logged in, it might be easier to enable or disable the radios through the modem router web pages.
You can also turn the WiFi radios off and on based on a schedule. (See Set Up a WiFi Schedule on page
214.)

Use the WIFI Button
To turn the WiFi radios off and on with the WIFI button:
Press the WIFI button on the front panel of the modem router for two seconds.
If you turned off the WiFi radios, the 2.4 GHz and 5 GHz LEDs, the LED on the WIFI button, and the
LED on the WPS button turn off. If you turned on the WiFi radios, the 2.4 GHz and 5 GHz LEDs light
solid white and the LED on the WIFI button and the LED on the WPS button light solid blue.
Tip If you want to disable the WiFi radio or radios of the modem router, use a wired connection
to avoid being disconnected when WiFi radio or radios turn off.

Enable or Disable the WiFi Radios
If you used the WIFI button to turn off the WiFi radios, you cannot log in to the modem router over WiFi to
turn them back on. You must press the WIFI button again for two seconds to turn the WiFi radios back on.

To enable or disable the WiFi radios:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Wireless Settings.
The Wireless Settings page displays the advanced settings.
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5. Do one of the following in the Advanced Wireless Settings (2.4GHz b/g/n) section, Wireless Advanced
Settings (5GHz-1 a/n/ac), Wireless Advanced Settings (5GHz-2 a/n/ac), or all sections:
•

•

Turn off the radios. Clear the Enable Wireless Router Radio check box.
The 2.4 GHz and 5 GHz LEDs, the LED on the WIFI button, and the LED on the WPS button turn
off.
Turn on the radios. Select the Enable Wireless Router Radio check box.
The 2.4 GHz and 5 GHz LEDs light solid white and the LED on the WIFI button and the LED on the
WPS button light solid blue.

6. Click the Apply button.
Your settings are saved.
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6

The modem router comes with a built-in firewall that helps protect your home network from unwanted intrusions
from the Internet.
This chapter includes the following sections:
•

Set Up Parental Controls on page 105

•

Allow or Block Access to Your Network on page 106

•

Use Keywords to Block Internet Sites on page 111

•

Manage Simple Outbound Firewall Rules for Services and Applications on page 115

•

Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules on page 120

•

Set Up Security Event Email Notifications on page 122

For information about more advanced ways to configure Internet security, see Manage Port Forwarding and
Port Triggering on page 235.

104

AC5300 WiFi VDSL/ADSL Modem Router Model D8500

Set Up Parental Controls
The first time that you select Parental Controls from the BASIC Home page, your browser goes to the
Parental Controls website. You can learn more about parental controls or download the application.
After you set up and enable parental controls, you can change the web filtering level for each device on the
network through the network map page on the genie app.

To set up parental controls:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select Parental Controls.
The Parental Controls website opens.
5. Click the button for the app or version that you want to download and use.
6. Follow the onscreen instructions to download and install the genie app.
7. Open the genie app and select Parental Controls.
After installation, Live Parental Controls automatically starts.

8. Click the Next button, read the note, and click the Next button again.
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Because Live Parental Controls uses free OpenDNS accounts, you are prompted to log in or create a
free account.

9. Select a radio button as follows:
•
•

If you already own an OpenDNS account, leave the Yes radio button selected.
If you do not own an OpenDNS account, select the No radio button.
If you are creating an account, the Create a free OpenDNS account page displays. Do the following:
a. Complete the fields.
b. Click the Next button.

After you log on or create your account, the filtering level page displays.
10. Select the radio button for the filtering level that you want and click the Next button.
The Setup is complete page displays.
11. Click the Take me to the status screen button.
The Status page displays. Parental Controls are now set up for the modem router.
12. To enable Parental Controls, click the Enable Live Parental Controls button.
After you set up and enable Parental Controls, you can change the web filtering level for each device
on the network through the network map page of the genie app.

Allow or Block Access to Your Network
You can use access control to block or allow access of devices to your network. You define access by
selecting or specifying the MAC addresses of the wired and WiFi devices that either can access your entire
network or are blocked from accessing your entire network.

Enable and Manage Network Access Control
When you enable access control, you must select whether new devices are allowed to access the network
or are blocked from accessing the network. By default, currently connected devices are allowed to access
the network, but you can also block these devices from accessing the network.

To set up network access control:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
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3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Security > Access Control.

The previous figure shows two WiFi devices connected.
5. Select the Turn on Access Control check box.
You must select this check box before you can specify an access rule and use the Allow and Block
buttons. When the Turn on Access Control check box is cleared, all devices are allowed to connect,
even if a device is in the list of blocked devices.
6. Click the Apply button.
Your settings are saved.
7. Select an access rule for new devices:
•

•

Allow all new devices to connect. With this setting, if you add a new device, it can access your
network. You do not need to enter its MAC address on this page. We recommend that you leave this
radio button selected.
Block all new devices from connecting. With this setting, if you add a new device, before it can
access your network, you must enter its MAC address for an Ethernet connection and its MAC
address for a WiFi connection in the allowed list. For more information, see Manage Network Access
Control Lists on page 108.

The access rule does not affect previously blocked or allowed devices. It applies only to devices joining
your network in the future after you apply these settings.
8. To manage access for currently connected computers and devices, do the following:
•

If you blocked all new devices from connecting, to allow the computer or device that you are currently
using to continue to access the network, select the check box next to your computer or device in the
table, and click the Allow button.
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•

To either continue to allow or to block other computers and devices that are currently connected,
select the check box next to the computer or device in the table, and click either the Allow button or
the Block button.

9. Click the Apply button.
Your settings are saved.

Manage Network Access Control Lists
You can use access control to block or allow access to your network. An access control list (ACL) functions
with the MAC addresses of wired and WiFi devices that can either access your entire network or are blocked
from accessing your entire network.
The modem router can detect the MAC addresses of devices that are connected to the network and list the
MAC addresses of devices that were connected to the network.
Each network device owns a MAC address, which is a unique 12-character physical address, containing
the hexadecimal characters 0–9, a–f, or A–F (uppercase or lowercase) only, and separated by colons (for
example, 00:09:AB:CD:EF:01). Typically, the MAC address is on the label of the WiFi card or network
interface device. If you cannot see the label, you can display the MAC address using the network configuration
utilities of the computer. You might also find the MAC addresses through the web pages of the modem
router (see View Devices Currently on the Network on page 201).

Add Devices to or Remove Them From the Allowed List
If you set up an access list that blocks all new devices from accessing your network, you must specify which
devices are allowed to access your network.

To add or remove devices that are allowed:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Security > Access Control.
The Access Control page displays.
5. Click the View list of allowed devices not currently connected to the network link.

A table displays the detected device name, MAC address, and connection type of the devices that are
not connected but allowed to access the network.
6. To add a device to the allowed list, do the following:
a. Click the Add button.
The Add Allowed Device page displays.
b. Enter the MAC address and device name for the device that you want to allow.
c. On the Add Allowed Device page, click the Apply button.
The device is added to the allowed list on the Access Control page.
7. To remove a device from allowed list, do the following:
a. Select the check box for the device.
b. Click the Delete button.
The device is removed from the allowed list.
8. Click the Apply button.
Your settings are saved.
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Add Devices to or Remove Them From the Blocked List
If you set up an access list that allows all new devices to access your network but you want to block some
devices from accessing your network, you must specify the devices that you want to block.

To add or remove devices that are blocked:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Security > Access Control.
The Access Control page displays.
5. Click the View list of blocked devices not currently connected to the network link.

A table displays the detected device name, MAC address, and connection type of the devices that are
not connected and are blocked from accessing the network.
6. To add a device to the blocked list, do the following:
a. Click the Add button.
The Add Blocked Device page displays.
b. Enter the MAC address and device name for the device that you want to block.
c. On the Add Blocked Device page, click the Apply button.
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The device is added to the blocked list on the Access Control page.
7. To remove a device from blocked list, do the following:
a. Select the check box for the device.
b. Click the Delete button.
The device is removed from the blocked list.
8. Click the Apply button.
Your settings are saved.

Use Keywords to Block Internet Sites
You can block keywords and domains (websites) to prevent certain types of HTTP traffic from accessing
your network. By default, keyword blocking is disabled and no domains are blocked.

Set Up Blocking
You can set up blocking of specific keywords and domains to occur continuously or according to a schedule.

To set up keyword and domain blocking:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
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4. Select ADVANCED > Security > Block Sites.

5. Specify a keyword blocking option:
•

•

Per Schedule. Use keyword blocking according to a schedule that you set.
For more information, see Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules
on page 120.
Always. Use keyword blocking continuously.

6. In the Type keyword or domain name here field, enter a keyword or domain.
Here are some sample entries:
•

Specify XXX to block http://www.badstuff.com/xxx.html.

•

Specify .com if you want to allow only sites with domain suffixes such as .edu or .gov.

•

Enter a period (.) to block all Internet browsing access.

7. Click the Add Keyword button.
The keyword or domain is added to the Block sites containing these keywords or domain names
field (which is also referred to as the blocked list).
8. To add more keywords or domains, repeat Step 6 and Step 7.
The keyword list supports up to 32 entries.
9. Click the Apply button.
Your settings are saved.

Control Access to the Internet
112

AC5300 WiFi VDSL/ADSL Modem Router Model D8500

Remove a Keyword or Domain From the Blocked List
If you no longer need a keyword or domain on the blocked list, you can remove the keyword or domain.

To remove a keyword or domain from the blocked list:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Security > Block Sites.
The Block Sites page displays.
5. In the Block sites containing these keywords or domain names field, select the keyword or domain.
6. Click the Delete Keyword button.
The keyword or domain is removed from the blocked list.
7. Click the Apply button.
Your settings are saved.

Remove All Keywords and Domains From the Blocked List
You can simultaneously remove all keywords and domains from the blocked list.

To remove all keywords and domains from the blocked list:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Security > Block Sites.
The Block Sites page displays.
5. Click the Clear List button.
All keywords and domains are removed from the blocked list.
6. Click the Apply button.
Your settings are saved.
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Specify a Trusted Computer
You can exempt one trusted device from blocking and logging. The device that you exempt must be assigned
a fixed (static) IP address.

To specify a trusted device:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Security > Block Sites.

5. Scroll down and select the Allow trusted IP address to visit blocked sites check box.
6. In the Trusted IP Address field, enter the IP address of the trusted device.
The first three octets of the IP address are automatically populated and depend on the IP address that
is assigned to the modem router on the LAN Setup page.
7. Click the Apply button.
Your settings are saved.
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Manage Simple Outbound Firewall Rules for Services and
Applications
A firewall protects one network (the trusted network, such as your LAN) from another (the untrusted network,
such as the Internet), while allowing communication between the two.
The modem router provides one default outbound firewall rule: It allows all access to the Internet (that is,
the WAN). You can add simple rules to prevent access to specific services and applications on the Internet.
In addition, you can specify if a rule applies to one user, a range of users, or all users on your LAN.
The modem router lists many default services and applications that you can use in outbound rules. You can
also add an outbound firewall rule for a custom service or application.
For information about blocking specific keywords, URLs, or sites, see Use Keywords to Block Internet Sites
on page 111. This type of blocking is another aspect of the outbound firewall. For information about inbound
firewall rules, see Manage Port Forwarding and Port Triggering on page 235.
Note Service blocking means the same thing as applying outbound firewall rules.

Add an Outbound Firewall Rule
You can add an outbound firewall rule to prevent access to a specific service or application on the Internet.

To add an outbound firewall rule:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Security > Block Services.

5. In the Services Blocking section, specify how the modem router applies outbound rules:
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•

•

Per Schedule. Use keyword blocking according to a schedule that you set.
For more information, see Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules
on page 120.
Always. Use keyword blocking continuously.

6. Below the Service Table, click the Add button.

7. From the Service Type menu, select service or application to be covered by this rule.
If the service or application does not display in the list, you can add it (see Add an Outbound Firewall
Rule for a Custom Service or Application on page 117).
8. Specify which devices on your LAN are affected by the rule, based on their IP addresses:
•
•
•

Only This IP Address. Enter the required address in the fields to apply the rule to a single device
on your LAN.
IP Address Range. Enter the required addresses in the start and end fields to apply the rule to a
range of devices.
All IP Addresses. All computers and devices on your LAN are covered by this rule.
By default, the All IP Addresses radio button is selected.

9. Click the Add button.
The new rule is added to the Service Table on the Block Services page.
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Add an Outbound Firewall Rule for a Custom Service or
Application
The modem router lists many default services and applications that you can use in outbound rules. If the
service or application is not predefined, you can specify a custom service or application in an outbound rule.

To add an outbound firewall rule for a custom service or application:
1. Find out which protocol and port number or range of numbers the service or application uses.
You can usually find this information by contacting the publisher of the service or application or through
online user or news groups.
2. Launch a web browser from a computer or mobile device that is connected to the network.
3. Enter http://www.routerlogin.net.
A login window opens.
4. Enter modem router the user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
5. Select ADVANCED > Security > Block Services.

6. If this is the first time that you add an outbound firewall rule, in the Services Blocking section, specify
how the modem router applies outbound rules:
•

•

Per Schedule. Use keyword blocking according to a schedule that you set.
For more information, see Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules
on page 120.
Always. Use keyword blocking continuously.
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7. Below the Service Table, click the Add button.

8. From the Service Type menu, select User Defined.
9. Specify a new outbound rule as described in the following table.
Field

Description

Protocol

Select the protocol (TCP or UDP) that is associated with the
service or application. If you are unsure, select TCP/UDP.

Starting Port

Enter the start port for the service or application.

Ending Port

If the service or application uses a range of ports, enter the
end port for the range. If the service or application uses a
single port, repeat the port number that you entered in the
Starting Port field.

Service Type/User Defined

Enter the name of the custom service or application.

10. Specify which devices on your LAN are affected by the rule, based on their IP addresses:
•
•
•

Only This IP Address. Enter the required address in the fields to apply the rule to a single device
on your LAN.
IP Address Range. Enter the required addresses in the start and end fields to apply the rule to a
range of devices.
All IP Addresses. All computers and devices on your LAN are covered by this rule.
By default, the All IP Addresses radio button is selected.

11. Click the Add button.
The new rule is added to the Service Table on the Block Services page.

Control Access to the Internet
118

AC5300 WiFi VDSL/ADSL Modem Router Model D8500

Change an Outbound Firewall Rule
You can change an existing outbound firewall rule.

To change an outbound firewall rule:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Security > Block Services.

The previous figure shows two rules in the Service Table.
5. In the Service Table, select the radio button for the rule.
6. Click the Edit button.
The Block Services Setup page displays.
7. Change the settings.
For more information about the settings, see Add an Outbound Firewall Rule for a Custom Service or
Application on page 117.
8. Click the Accept button.
Your settings are saved. The changed rule displays in the Service Table on the Block Services page.
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Remove an Outbound Firewall Rule
You can remove an outbound firewall rule that you no longer need.

To remove an outbound firewall rule:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Security > Block Services.

The previous figure shows two rules in the Service Table.
5. In the Service Table, select the radio button for the rule.
6. Click the Delete button.
The rule is removed from the Service Table.

Set Up a Schedule for Keyword Blocking and Outbound
Firewall Rules
You can set up a schedule that you can apply to keyword blocking (see Use Keywords to Block Internet
Sites on page 111) and outbound firewall rules (see Manage Simple Outbound Firewall Rules for Services
and Applications on page 115).
If applied, the schedule specifies the days and time that keyword blocking, outbound firewall rules, or both
are active.
By default, no schedule is set and you can either enable or disable these features.
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To set up a schedule for blocking:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Security > Schedule.

5. Set up the schedule for blocking:
•

Days to Block. Select the check box for each day that you want to block access or specify that
blocking occurs on every day by selecting the Every Day check box.
By default, the Every Day check box is selected.

•

Time of Day to Block. Select a start and end time for blocking in 24-hour format or select the All
Day check box for 24-hour blocking.
By default, the All Day check box is selected.

6. From the Time Zone menu, select your time zone.
7. If you live in an area that observes daylight saving time, select the Automatically adjust for daylight
savings time check box.
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Note If the modem router synchronized its internal clock with a time server on the Internet
and you selected the correct time zone, the Current Time field displays the correct
date and time.

8. Click the Apply button.
Your settings are saved.

Set Up Security Event Email Notifications
The modem router can email you its activity logs. The log records modem router activity and security events
such as attempts to access blocked sites or services.

To set up email notifications:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Security > E-mail.

5. Select the Turn E-mail Notification On check box.
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6. In the Primary E-mail Address field, type the email address to which logs and alerts are to be sent.
This email address is also used for the From address. If this field is blank, log and alert messages are
not sent.
7. In the Secondary E-mail Address field, type an optional second email address to which logs and alerts
are to be sent.
8. In the Your Outgoing Mail Server field, enter the name of your ISP outgoing (SMTP) mail server (such
as mail.myISP.com).
You might be able to find this information in the configuration window of your email program. If you leave
this field blank, log and alert messages are not sent.
9. In the Outgoing Mail Server Port Number field, enter the port number that the mail server uses.
If you do not know the port number, leave the default port number, which is 25, or select the Auto
Detection radio button, which lets the modem router detect the port number.
10. If your outgoing email server requires authentication, select the My Mail Server requires authentication
check box, and do the following:
a. In the User Name field, type the user name for the outgoing email server.
b. In the Password field, type the password for the outgoing email server.
11. To send alerts when someone attempts to visit a blocked site, select the Send Alerts Immediately
check box.
Email alerts are sent immediately when someone attempts to visit a blocked site.
12. To send logs based on a schedule, specify these settings:
a. From Send logs according to this schedule menu, select the schedule type.
b. From the Day menu, select the day.
c. From the Time menu, select the time, and select the am or pm radio button.
13. Click the Apply button.
Your settings are saved.
Logs are sent automatically according to the schedule that you set. If the log fills before the specified
time, it is sent. After the log is sent, it is cleared from the modem router memory. If the modem router
cannot email the log and the log buffer fills, the modem router overwrites the log.
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Optimize Performance

7

This chapter describes how you can optimize the modem router’s performance and manage the traffic flows
through the modem router.
The chapter contains the following sections:
•

Use Dynamic QoS to Optimize Internet Traffic Management on page 125

•

Manage Wi-Fi Multimedia Quality of Service on page 127

•

Improve Network Connections With Universal Plug-N-Play on page 128
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Use Dynamic QoS to Optimize Internet Traffic Management
Dynamic Quality of Service (QoS) helps improve your router’s Internet traffic management capabilities
through better application and device identification, bandwidth allocation, and traffic prioritization techniques.
Dynamic QoS resolves traffic congestion when the Internet bandwidth is limited and different demands
compete for bandwidth.

Figure 15. Dynamic QoS optimizes Internet traffic by prioritizing competing demands

Enable Dynamic QoS
Because not everyone requires Dynamic QoS, it is disabled by default.

To enable Dynamic QoS:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
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4. Select Dynamic QoS.

5. Select the Enable Dynamic QoS check box.
6. Specify your Internet bandwidth.
You must specify your Internet bandwidth so that Dynamic QoS can perform bandwidth allocation and
traffic prioritization.
To allow Speedtest to detect your Internet bandwidth (recommended), do the following:
a. For more accurate Speedtest results, make sure that no other devices are accessing the Internet.
b. Click the Speedtest button.
Speedtest determines your Internet bandwidth.
7. Click the Apply button.
Your settings are saved.
A link displays on the bottom of the page to view bandwidth utilization. Clicking the link displays the
Attached Devices page. For more information, see View Devices Currently on the Network on page 201.

Enable or Disable the Automatic QoS Database Update
The modem router uses a QoS database of the most popular applications and services to implement Dynamic
QoS. By default, the modem router automatically updates this database. You can turn off this feature and
manually update the database.

To enable or disable the automatic Dynamic QoS database update:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
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A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select Dynamic QoS.
The Dynamic QoS page displays. If you are using Dynamic QoS, the Enable Dynamic QoS check box
is selected.
5. Select or clear the Automatically update performance optimization database check box.
6. Click the Apply button.
Your settings are saved.

Manually Update the Dynamic QoS Database
The modem router uses a QoS database of the most popular applications and services to implement Dynamic
QoS. By default, the modem router automatically updates this database when you enable Dynamic QoS,
but if you turned off the automatic update feature, you can manually update the database.

To manually update the Dynamic QoS database:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select Dynamic QoS.
The Dynamic QoS page displays. If you are using Dynamic QoS, the Enable Dynamic QoS check box
is selected.
5. Click the Update Now button.
The modem router checks for the newest version of the database and downloads it.
6. Click the Apply button.
Your settings are saved.

Manage Wi-Fi Multimedia Quality of Service
Wi-Fi Multimedia Quality of Service (WMM QoS) prioritizes WiFi voice and video traffic over the WiFi link.
WMM QoS is automatically enabled for the modem router.
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WMM QoS prioritizes WiFi data packets from different applications based on four access categories: voice,
video, best effort, and background. For an application to receive the benefits of WMM QoS, WMM must be
enabled for both it and the client running that application. Legacy applications that do not support WMM
and applications that do not require QoS are assigned to the best effort category, which receives a lower
priority than voice and video.

To disable WMM QoS:
1. Launch an Internet browser from a computer or mobile device that is connected to the network.
2. Type http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup > QoS Setup.
The Quality of Service page displays.
5. Click the WMM tab.
6. Clear one or more of the following check boxes.
•

Enable WMM (Wi-Fi multimedia) settings (2.4GHz b/g/n)

•

Enable WMM (Wi-Fi multimedia) settings (5GHz a/n)

•

Enable WMM (Wi-Fi multimedia) settings Second Radio (5GHz a/n)

7. Click the Apply button.
Your changes are saved.

Improve Network Connections With Universal Plug-N-Play
Universal Plug-N-Play (UPnP) helps devices such as Internet appliances and computers access the network
and connect to other devices as needed. UPnP devices can automatically discover the services from other
registered UPnP devices on the network.
If you use applications such as multiplayer gaming, peer-to-peer connections, or real-time communications
such as instant messaging or remote assistance, keep UPnP enabled, which it is by default.

To manage Universal Plug-N-Play:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
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The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > UPnP.
The UPnP page displays.
5. Select the Turn UPnP On check box.
By default, this check box is selected.You can disable or enable UPnP for automatic device configuration.
If the Turn UPnP On check box is cleared, the modem router does not allow any device to automatically
control router resources, such as port forwarding.
6. Enter the advertisement period in minutes.
The advertisement period specifies how often the modem router broadcasts its UPnP information. This
value can range from 1 to 1440 minutes. The default period is 30 minutes. Shorter durations ensure
that control points detect current device status at the expense of more network traffic. Longer durations
can compromise the freshness of the device status but can significantly reduce network traffic.
7. Enter the advertisement time to live in hops.
The time to live for the advertisement is measured in hops (steps) for each UPnP packet sent. Hops
are the steps a packet takes between routers. The number of hops can range from 1 to 255. The default
value for the advertisement time to live is 4 hops, which should be fine for most home networks. If you
notice that some devices are not being updated or reached correctly, it might be necessary to increase
this value.
8. Click the Apply button.
The UPnP Portmap Table displays the IP address of each UPnP device that is accessing the modem
router and which ports (internal and external) that device opened. The UPnP Portmap Table also displays
what type of port is open and whether that port is still active for each IP address.
9. To refresh the information in the UPnP Portmap table, click the Refresh button.
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8

This chapter describes how to access and manage a storage device attached to your modem router. ReadySHARE
lets you access and share a USB storage device connected to the modem router. (If your storage device uses
special drivers, it is not compatible.)
Note You can use a USB port on the modem router only to connect a USB storage device such
as a flash drive or hard drive or a printer. Do not connect a computer, USB modem, CD drive,
or DVD drive to a modem router USB port.
The chapter includes the following sections:
•

USB Device Requirements on page 131

•

Connect a USB Device to the Modem Router on page 131

•

Access a Storage Device Connected to the Modem Router on page 132

•

Map a USB Device to a Windows Network Drive on page 133

•

Back Up Windows Computers With ReadySHARE Vault on page 133

•

Manage Access to a Storage Device on page 134

•

Use FTP Within the Network on page 136

•

Manage Network Folders on a USB Storage Device on page 136

•

Remotely Access a USB Device Using ReadyCLOUD on page 140

•

Safely Remove a USB Device on page 142
Note For more information about ReadySHARE and ReadyCLOUD features, visit
netgear.com/readyshare.
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USB Device Requirements
The modem router works with most USB-compliant external flash and hard drives. For the most up-to-date
list of USB devices that the modem router supports, visit kbserver.netgear.com/readyshare.
Some USB external hard drives and flash drives require you to load the drivers onto the computer before
the computer can access the USB device. Such USB devices do not work with the modem router.
The modem router supports the following file system types for full read/write access:
•

FAT16

•

FAT32

•

NTFS

•

NTFS with compression format enabled

•

Ext2

•

Ext3

•

Ext4

The modem router supports the following file system types with read-only access:
•

HFS

•

HFS+

Connect a USB Device to the Modem Router
ReadySHARE lets you access and share a USB device connected to the modem router USB port. (If your
USB device uses special drivers, it is not compatible.)

Figure 16. A USB 3.0 and USB 2.0 port are located on the side of the modem router
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To connect a USB device:
1. Insert your USB storage drive into a USB port on the side panel of the modem router.
2. If your USB device uses a power supply, connect it.
You must use the power supply when you connect the USB device to the modem router.
When you connect the USB device to the modem router USB port, it might take up to two minutes before
it is ready for sharing. By default, the USB device is available to all computers on your local area network
(LAN).

Access a Storage Device Connected to the Modem Router
From a computer or device on the network, you can access a storage device that is connected to the modem
router.

Access the Storage Device From a Windows Computer
To access the storage device from a Windows computer:
1. Connect a USB storage device to a USB port on the modem router.
2. If your USB device uses a power supply, connect it.
You must use the power supply when you connect the USB device to the modem router.
When you connect the storage device to the modem router’s port, it might take up to two minutes before
the storage device is ready for sharing. By default, the device is available to all computers on your local
area network (LAN).
3. On a Windows computer that is connected to the network, select Start > Run.
4. Enter \\readyshare in the dialog box.
5. Click the OK button.
A window displays the files and folders on the device.

Access the Storage Device From a Mac
To access the storage device from a Mac:
1. Connect a USB storage device to a USB port on the modem router.
2. If your USB device uses a power supply, connect it.
You must use the power supply when you connect the USB device to the modem router.
When you connect the storage device to the modem router’s port, it might take up to two minutes before
the storage device is ready for sharing. By default, the device is available to all computers on your local
area network (LAN).
3. On a Mac that is connected to the network, launch Finder and select Go > Connect to Server.
The Connect to Server window displays.
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4. In the Server Address field, enter smb://readyshare.
5. Click the Connect button.
6. When prompted, select the Guest radio button.
7. If you set up access control on the router and you allowed your Mac to access the network, select the
Registered User radio button and enter admin for the name and password for the password.
For more information about access control, see Allow or Block Access to Your Network on page 106.
8. Click the Connect button.
A window displays the files and folders on the device.

Map a USB Device to a Windows Network Drive
To map the USB device to a Windows network drive:
1. Select Start > Run.
2. Enter \\readyshare in the dialog box.
3. Click the OK button.
A window automatically opens and displays the USB device.
4. Right-click the USB device and select Map network drive.
The Map Network Drive window opens.
5. Select the drive letter to map to the new network folder.
6. Click the Finish button.
The USB device is mapped to the drive letter that you specified.

Back Up Windows Computers With ReadySHARE Vault
The following operating systems support ReadySHARE Vault:
•

Windows 7

•

Windows 8

•

Windows 8.1

•

Windows 10

To back up your Windows computer:
1. Download ReadySHARE Vault from netgear.com/readyshare and install it on each Windows computer.
2. Launch ReadySHARE Vault.
3. Use the dashboard or the Backup tab to set up and run your backup.
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Manage Access to a Storage Device
You can specify the device name, workgroups, and network folders for a storage device connected to the
USB port on the modem router.

To specify the storage device access settings:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ReadySHARE.
The USB Storage (Basic Settings) page displays. By default, the Basic radio button is selected.
5. Click the Edit button.

The previous figure shows one USB device attached to the modem router.
6. To specify a name that is used to access the USB device or devices that are connected to the modem
router, in the Network/Device Name field, enter a name.
By default, the name is readyshare.
7. To specify a name for the workgroup that the USB device or devices are members of, in the Workgroup
field, enter a name.
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By default, the name is Workgroup. The name works only in an operating system that supports NetBIOS,
such as Microsoft Windows. If you are using a Windows workgroup rather than a domain, the workgroup
name is displayed here.
8. Enable or disable access methods by selecting or clearing the corresponding check boxes and specifying
access to the storage device as described in the following table.
Access Method

Description

Network
Enabled by default. You can type \\readyshare to access the storage device within
Neighborhood/MacShare your network. If you change the name in the Network/Device Name field from
readyshare to another name, the link changes accordingly.
HTTP

Enabled by default.You can type http://readyshare.routerlogin.net/shares to access
the USB device within your network and download or upload files. In this URL,
readyshare is the name that is specified in the Network/Device Name field. If you
change the name in the Network/Device Name field from readyshare to another
name, the link changes accordingly.
You can also click the link that is shown in the Link column. The fixed port is number
is 80.

HTTPS (via internet)

Disabled by default. If you enable this feature, remote users can type https://<public
IP address>/shares to access the USB device over the Internet. <public IP address>
is the external or public IP address that is assigned to the modem router (for example,
1.1.10.102).
This feature supports file uploading only. The default port is number 443, which you
can change.

FTP

Enabled by default.You can type ftp://readyshare.routerlogin.net/shares to access
the USB device within your network and download or upload files. In this URL,
readyshare is the name that is specified in the Network/Device Name field. If you
change the name in the Network/Device Name field from readyshare to another
name, the link changes accordingly.
You can also click the link that is shown in the Link column. The fixed port is number
is 21.

FTP (via internet)

Disabled by default. If you enable this feature, remote users can type ftp://<public IP
address>/shares to access the USB device over the Internet and download or upload
files. <public IP address> is the external or public IP address that is assigned to the
modem router (for example, 1.1.10.102).
The default port is number 21, which you can change.
If you set up Dynamic DNS (see Set Up and Manage Dynamic DNS on page 144),
you can also type a URL domain name. For example, if your domain name is MyName
and you use the NETGEAR DDNS server, you can type
ftp://MyName.mynetgear.com to access the USB device over the Internet and
download or upload files.

9. Click the Apply button.
Your settings are saved.
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Use FTP Within the Network
File Transfer Protocol (FTP) lets you send and receive large files faster.

To set up FTP access:
1. Launch a web browser from a computer or wireless device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > ReadySHARE > Advanced Settings.
The USB Storage (Advanced Settings) page displays.
5. Select the FTP check box.
6. Click the Apply button.
Your settings are saved.

Manage Network Folders on a USB Storage Device
From a computer or device on the network, you can view, add, or change network folders on a USB storage
device that is connected to a USB port on the modem router.

View Network Folders on a USB Storage Device
You can view the network folders on a USB storage device that is connected to a USB port on the modem
router.

To view or change network folders:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ReadySHARE.
The USB Storage (Basic Settings) page displays. By default, the Basic radio button is selected.
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5. Click the Edit button.

The previous figure shows one USB device attached to the modem router.
6. Scroll down to the Available Networks Folder section to view the following settings:
•

Share Name. If only one USB device is connected, the default share name is USB_Storage.
You can click the name or you can type it in the address field of your web browser. If Not Shared
is shown, the default share was deleted and no other share for the root folder exists. Click the link
to change this setting.

•

Read Access and Write Access. Show the permissions and access controls on the network folder.
All–no password (the default) allows all users to access the network folder. The password for admin
is the same one that you use to log in to the modem router.

•

Folder Name. Full path of the network folder.

•

Volume Name. Volume name from the storage device.

•

Total Space and Free Space. Show the current utilization of the storage device.

Add a Network Folder on a USB Storage Device
You can add a network folder on a USB storage device that is connected to a USB port on the modem
router.

To add a network folder:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
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3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ReadySHARE.
The USB Storage (Basic Settings) page displays. By default, the Basic radio button is selected.
5. Click the Edit button.

The previous figure shows one USB device attached to the modem router.
6. Select a device.
7. Click the Create Network Folder button.
The Add Folder window opens.
If this window does not open, your web browser might be blocking pop-ups. If it is, change the browser
settings to allow pop-ups.
8. Complete the fields.
The user name (account name) for All–no password is guest. The password for admin is the same one
that is used to log in to the modem router. By default, it is password.
9. Click the Apply button.
The folder is added on the storage device.
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Change a Network Folder on a USB Storage Device
You can change a network folder on a USB storage device that is connected to a USB port on the modem
router.

To change a network folder:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ReadySHARE.
The USB Storage (Basic Settings) page displays. By default, the Basic radio button is selected.
5. Click the Edit button.

The previous figure shows one USB device attached to the modem router.
6. Click the Edit button.
The Edit Network Folder window opens.
7. Change the settings in the fields as needed.
8. Click the Apply button.
Your settings are saved.
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Remotely Access a USB Device Using ReadyCLOUD
NETGEAR ReadyCLOUD for modem routers lets you remotely access files stored on a USB storage device
that is connected to the modem router. Before you can use ReadyCLOUD, you must create a ReadyCLOUD
account and register your modem router.
A ReadyCLOUD app is also available for Windows computers, Android mobile devices, and iOS mobile
devices. For more information about setting up ReadyCLOUD, see the ReadyCLOUD for Routers User
Manual, which is available online at downloadcenter.netgear.com.

Create a ReadyCLOUD Account
To create a ReadyCLOUD account:
1. Launch a web browser from a computer or mobile device.
2. Visit readycloud.netgear.com.
The ReadyCLOUD Welcome page displays.
3. Click the Sign In link.
The Sign In page displays.
4. Click the Create Account link.

5. Complete the fields to set up your account, and click the Create button.
You are now ready to register your router with your ReadyCLOUD account.
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Register Your Modem Router With ReadyCLOUD
After you create a ReadyCLOUD account, you must register your modem router with your ReadyCLOUD
account.

To register your modem router with your ReadyCLOUD account:
1. Visit kb.netgear.com/app/answers/detail/a_id/27323/ and check to see if your modem router supports
ReadyCLOUD.
2. Connect a USB storage device to a USB port on the modem router.
3. If your USB storage device uses a power supply, connect it.
You must use the power supply when you connect the USB storage device to the modem router.
When you connect the USB storage device to the modem router’s USB port, it might take up to two
minutes before it is ready for sharing. By default, the USB storage device is available to all computers
on your local area network (LAN).
4. Launch a web browser from a computer or mobile device that is connected to the network.
5. Enter http://www.routerlogin.net.
A login window opens.
6. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
7. Select ADVANCED > USB Functions > ReadySHARE Storage.
The ReadySHARE page displays.
8. Click the ReadyCLOUD tab.

9. Enter your ReadyCLOUD user name and password and click the Register button.
If you did not create a ReadyCLOUD account, see Create a ReadyCLOUD Account on page 140.
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The modem router is registered with ReadyCLOUD.

Note If the modem router’s Internet connection mode is set to Dial on Demand, the modem
router automatically changes the connection mode to Always On. This change is
required for ReadyCLOUD to remotely access the USB storage device.

10. After registration, visit readycloud.netgear.com.
11. Click the Sign In link, enter your ReadyCLOUD user name and password, and click the Sign In button.
The ReadyCLOUD page displays the modem router that you registered and the contents of the USB
storage device that is connected to the modem router.

Safely Remove a USB Device
Before you physically disconnect a USB device from the modem router USB port, log in to the modem router
and take the drive offline.

To remove a USB disk drive safely:
1. Launch a web browser from a computer or wireless device that is connected to the network.
2. Typehttp://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select USB Storage > Basic Settings.
The USB Settings page displays.
5. Click the Safely Remove USB Device button.
This takes the device offline.
6. Physically disconnect the USB device.
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Manage Dynamic DNS and Access
Storage Devices Through the Internet

9

With Dynamic DNS, you can use the Internet and a personal domain name to access a USB storage device
that is attached to a USB port on the modem router when you are not home. If you know the IP address of the
modem router (and the IP address did not change), you can also access the USB storage device by using the
IP address.
This chapter includes the following sections:
•

Set Up and Manage Dynamic DNS on page 144

•

Access Storage Devices Through the Internet on page 147
Note For information about how to connect the device and specify its settings, see Share a Storage
Device on page 130.
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Set Up and Manage Dynamic DNS
Internet service providers (ISPs) assign numbers called IP addresses to identify each Internet account. Most
ISPs use dynamically assigned IP addresses. This means that the IP address can change at any time. You
can use the IP address to access your network remotely, but most people do not know what their IP address
is or when this address changes.
To make it easier to connect, you can get a free account with a Dynamic DNS service that lets you use a
domain name to access your home network. To use this account, you must set up the modem router to use
Dynamic DNS. Then the modem router notifies the Dynamic DNS service provider whenever its IP address
changes. When you access your Dynamic DNS account, the service finds the current IP address of your
home network and automatically connects you.
If your ISP assigns a private WAN IP address (such as 192.168.x.x or 10.x.x.x), the Dynamic DNS service
does not work because private addresses are not routed on the Internet.

Your Personal FTP Server
With your customized free URL, you can use FTP to access your network when you are not home through
Dynamic DNS. To set up your FTP server, you must register for a NETGEAR Dynamic DNS (DDNS) service
account and specify the account settings. See Set Up a New Dynamic DNS Account on page 145.

Figure 17. You can access your network through the Internet when you are not home

Note The modem router supports basic DDNS only, and the login and password might not
be secure. You can use DDNS with a VPN tunnel for a secure connection.
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Set Up a New Dynamic DNS Account
NETGEAR offers you the opportunity to set up and register for a free Dynamic DNS account.

To set up Dynamic DNS and register for a free NETGEAR account:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Dynamic DNS.

5. Select the Use a Dynamic DNS Service check box.
6. From the Service Provider menu, select NETGEAR.
7. Select the No radio button.
8. In the Host Name field, enter the name that you want to use for your URL.
The host name is sometimes called the domain name. Your free URL includes the host name that you
specify and ends with mynetgear.com. For example, specify MyName.mynetgear.com.
9. In the Email field, enter the email address that you want to use for your account.
10. In the Password (6~32 characters) field, enter the password that you want to use for your account.
11. Click the Register button.
12. Follow the onscreen instructions to register for your NETGEAR Dynamic DNS service.

Manage Dynamic DNS and Access Storage Devices Through the Internet
145

AC5300 WiFi VDSL/ADSL Modem Router Model D8500

Specify a DNS Account That You Already Created
If you already created a Dynamic DNS account with NETGEAR, No-IP, or Dyn, you can set up the modem
router to use your account.

To set up Dynamic DNS if you already created an account:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Settings > Dynamic DNS.

5. Select the Use a Dynamic DNS Service check box.
6. From the Service Provider menu, select your provider.
7. Select the Yes radio button.
The page adjusts.
8. In the Host Name field, enter the host name (sometimes called the domain name) for your account.
9. Depending on the type of account, specify your user name or email address:
•
•

For a No-IP or Dyn account, in the User Name field, enter the user name for your account.
For a NETGEAR account, in the Email field, enter the email address for your account.

10. In the Password (6~32 characters) field, enter the password for your DDNS account.
11. Click the Apply button.
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Your settings are saved.
12. To verify that your Dynamic DNS service is enabled in the modem router, click the Show Status button.
A message displays the Dynamic DNS status.

Access Storage Devices Through the Internet
If you connect a USB storage device to the modem router, you can access the USB device through the
Internet when you are not home. After you gain access, you can use FTP to share files on the USB device.

Access Storage Devices From a Remote Computer
You can access storage devices that are attached to your modem router from a remote computer.

To access devices from a remote computer:
1. Launch a web browser on a computer that is not on your home network.
2. Connect to your modem router, on your home network:
•

•

To connect with Dynamic DNS, type the DNS name.
To use a Dynamic DNS account, you must enter the account information on the Dynamic DNS page
(see Set Up and Manage Dynamic DNS on page 144).
To connect without Dynamic DNS, type the modem router’s Internet port IP address.
You can view the modem router’s Internet IP address on the BASIC Home page.

Set Up FTP Access Through the Internet
To set up FTP access:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > ReadySHARE > Advanced Settings.
The ReadySHARE Advanced Settings page displays.
5. Select the FTP (via Internet) check box.
6. Click the Apply button.
Your settings are saved.
7. To limit access to the admin user, click the Edit button.
The Edit page displays.
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8. In the Read Access list, select admin.
9. In the Write Access list, select admin.
10. Click the Apply button.
Your settings are saved.

Use FTP to Access Storage Devices Through the Internet
If you attached a storage device to the modem router, before you can access the storage device through
the Internet with FTP, you must first set it up (see Set Up FTP Access Through the Internet on page 147).

To access a USB device with FTP from a remote computer to download or upload a file:
1. Take one of the following actions:
•
•

To download a file from a storage device connected to the modem router, launch a web browser.
To upload a file to a storage device connected to the modem router, launch an FTP client such as
Filezilla.

2. Type ftp:// and the Internet port IP address in the address field of the browser.
For example, if your IP address is 10.1.65.4, type ftp://10.1.65.4.
If you are using Dynamic DNS, type the DNS name.
For example, type ftp://MyName.mynetgear.com.
3. When prompted, log in:
•
•

To log in as admin, in the user name field, enter admin and in the password field, enter the same
password that you use to log in to the modem router.
To log in as guest, in the user name field, enter guest.

The guest user name does not need a password.
The files and folders that your account can access on the USB device display. For example, you might
see share/partition1/directory1.
4. Navigate to a location on the USB device.
5. Download or upload the file.
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Use the Router as a Media Server

10

The router comes set up to work as a ReadyDLNA media server. You can set up the router to play music from
iTunes Server and media from TiVo.
This chapter contains the following sections:
•

Specify ReadyDLNA Media Server Settings on page 150

•

Play Music From a USB Storage Device With iTunes Server on page 150

•

Play Media From a USB Device on TiVo on page 154
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Specify ReadyDLNA Media Server Settings
By default, the modem router functions as a ReadyDLNA media server, which lets you view movies and
photos on DLNA/UPnP AV–compliant media players, such as Xbox360, Playstation, and NETGEAR media
players.

To specify media server settings:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > USB Functions > ReadySHARE Storage.
The USB Storage (Advanced Settings) page displays.
5. Click the Media Server tab.
The Media Server (Settings) page displays.
6. Specify the settings:
•
•
•

Enable DLNA Media Server. Select this check box to enable this device to act as a media server.
Enable TiVo support. Select this check box if you want to play ReadyNAS media on your TiVo
device. See Play Media From a USB Device on TiVo on page 154.
Media Server Device Name. Specify the name of the media server.

7. Click the Apply button.
Your settings are saved.

Play Music From a USB Storage Device With iTunes Server
iTunes Server lets you play music with your Windows or Mac iTunes app from a storage device that is
connected to the router.You can also use the Apple Remote app from an iPhone or iPad to play music on
any AirPlay devices, such as Apple TV or AirPlay-supported receivers.
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Figure 18. Play music on a USB device with iTunes

Set Up the Modem Router’s iTunes Server With iTunes
You can play music from a USB device that is connected to your modem router with iTunes on your Windows
or Mac computer using Home Sharing. To set up Home Sharing, you need an Apple account and the latest
version of iTunes installed on your computer.

To set up the modem router’s iTunes server to play music on iTunes:
1. Connect a USB storage device to a USB port on your modem router.
2. If your USB storage device uses a power supply, connect it.
You must use the power supply when you connect the USB storage device to the modem router.
When you connect the USB storage device to the modem router’s USB port, it might take up to two
minutes before it is ready for sharing. By default, the USB storage device is available to all computers
on your local area network (LAN).
3. Launch a web browser from a computer or mobile device that is connected to the network.
4. Enter http://www.routerlogin.net.
A login window opens.
5. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
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The BASIC Home page displays.
6. Select ADVANCED > USB Functions > ReadySHARE Storage.
The USB Storage (Advanced Settings) page displays.
7. Click the Media Server tab.
The Media Server (Settings) page displays.
8. Select the Enable iTunes Media Server (Music Only) check box and click the Apply button.
Your settings are saved.
9. On your Windows or Mac computer, launch iTunes.
10. Select File > Home Sharing > Turn On Home Sharing.
The Home Sharing page displays.
11. Enter your Apple ID email address and password and click the Turn On Home Sharing button.
When Home Sharing is enabled, a Home Sharing icon

displays in iTunes.

12.
Click the Home Sharing icon
and from the menu, select the modem router.
The music that is on the USB device that is connected to the modem router displays in iTunes.

Set Up the Modem Router’s iTunes Server With the Remote
App
You can play music from a USB device that is connected to your modem router on your iPhone or iPad
using the Apple Remote app.

To set up the modem router’s iTunes server to play music on your iPhone or iPad:
1. Connect a USB storage device to a USB port on your modem router.
2. If your USB storage device uses a power supply, connect it.
You must use the power supply when you connect the USB storage device to the modem router.
When you connect the USB storage device to the modem router’s USB port, it might take up to two
minutes before it is ready for sharing. By default, the USB storage device is available to all computers
on your local area network (LAN).
3. Connect your iPhone or iPad to your modem router’s WiFi network.
4. Download the Remote app from the Apple App Store.
5.

Launch the Remote app

from your iPhone or iPad.
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6. Click the Add a Device button.

7. Specify the passcode in the modem router to set up your iTunes server:
a. Launch a web browser from a computer or mobile device that is connected to the network.
b. Enter http://www.routerlogin.net.
A login window opens.
c. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
d. Select ADVANCED > USB Functions > ReadySHARE Storage.
The USB Storage (Advanced Settings) page displays.
e. Click the Media Server tab.
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The Media Server (Settings) page displays.
f.

Select the Enable iTunes Media Server (Music Only) check box and click the Apply button.

g. Enter the passcode and click the Allow Control button.
Your settings are saved.
Your iPhone or iPad pairs with the modem router and the iTunes Server is ready. The modem router
displays in the Remote app.
8. In the Remote app, tap the modem router that your iPhone or iPad is connected to.
The music that is on the USB device that is connected to the modem router displays in the app.

Play Media From a USB Device on TiVo
You can set up your TiVo to access media files stored on a USB device that is connected to your modem
router. The TiVo must be on the same network as the modem router. This feature supports the following
file formats:
•

Video. See and play mpeg1, and mpeg2 files.

•

Music. See and play MP3 files.

•

Pictures. View images in .jpg format.

You can use the TiVo (Series 2 and up) Home Media Option to play photos and music on your Windows or
Mac computer in your TiVo user interface.

Set Up the Modem Router to Work With TiVo
To set up the modem router to work with TiVo:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > USB Functions > ReadySHARE Storage.
The USB Storage (Advanced) Settings page displays.
5. Click the Media Server tab.
The Media Server (Settings) page displays.
6. Make sure that the Enable TiVo support check box is selected.
7. If you changed the settings, click the Apply button.
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Your settings are saved.

Play Videos on TiVo
To play videos:
1. On the TiVo, select TiVo Central > My Shows.
The My Shows page displays.
2. Go to the bottom of the list and select the model number for your modem router.

Play Music or View Photos on TiVo
To play music or view photos:
1. On the TiVo, select TiVo Central > Music, Photos, & Showcases.
The Music, Photos, & Showcases page displays.
2. Select an item to play or watch.
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Share a USB Printer

11

The ReadySHARE Printer utility lets you share a USB printer that is connected to the USB port on your modem
router. You can share this USB printer among the Windows and Mac computers on your network.
For more information about the features available in the NETGEAR USB Control Center, see the ReadySHARE
Printer User Manual, which is available at downloadcenter.netgear.com.
This chapter contains the following sections:
•

Install the Printer Driver and Cable the Printer on page 157

•

Download the ReadySHARE Printer Utility on page 157

•

Install the ReadySHARE Printer Utility on page 158

•

Print Using the NETGEAR USB Control Center on page 159

•

View or Change the Status of a Printer on page 159

•

Use the Scan Feature of a Multifunction USB Printer on page 160

•

Change NETGEAR USB Control Center Settings on page 160
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Install the Printer Driver and Cable the Printer
Some USB printer manufacturers (for example, HP and Lexmark) request that you do not connect the USB
cable until the installation software prompts you to do so.

To install the driver and cable the printer:
1. On each computer on your network that shares the USB printer, install the driver software for the USB
printer.
If you cannot locate the printer driver, contact the printer manufacturer.
2. Use a USB printer cable to connect the USB printer to a modem router USB port.

Download the ReadySHARE Printer Utility
The utility works on Windows and Mac computers.

To download the utility:
1. Visit NETGEAR.com/readyshare.
2. Click the PRINT - Learn how you can print wirelessly from many devices link.
3. Click one of the following links to download the ReadySHARE Printer utility setup file:
•

Download PC installer and get started. This is the utility for Windows computers.

•

Download Mac installer and get started. This is the utility for MAC computers.

•

Download the genie App and get started. This is the utility for smartphones and tablets.

4. Follow the onscreen instructions to download the ReadySHARE Printer utility.
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Install the ReadySHARE Printer Utility
You must install the ReadySHARE Printer utility on each computer that will share the printer. After you install
it, the utility displays as NETGEAR USB Control Center on your computer.

To install the utility:
1. If necessary, unzip the ReadySHARE Printer utility setup file.
2. Double-click the ReadySHARE Printer utility setup file that you downloaded.

3. Follow the wizard instructions to install the NETGEAR USB Control Center.

4. Select a language from the menu and click the OK button.

The USB printer connected to the modem router displays in the NETGEAR USB Control Center window.
Some firewall software, such as Comodo, blocks the NETGEAR USB Control Center from accessing
the USB printer. If you do not see the USB printer displayed on the page, you can disable the firewall
temporarily to allow the utility to work.
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Print Using the NETGEAR USB Control Center
For each computer, after you click the Connect and Disconnect buttons once, the utility automatically
manages the printing queue and handling. By default, the utility starts automatically whenever you log on
to Windows and runs in the background.

To print a document using the NETGEAR USB Control Center:
1.

Click the NETGEAR USB Control Center icon
.
The NETGEAR USB Control Center page displays.

2. Select a printer and click the Connect button.
The printer status changes to Manually connected by Mycomputer. Now only the computer that you are
using can use this printer.
3. Use the print feature in your application to print your document.
The NETGEAR USB Control Center automatically connects your computer to the USB printer and prints
the document. If another computer is already connected to the printer, your print job goes into a queue
to wait to be printed.
4. If your document does not print, use the NETGEAR USB Control Center to check the printer status.
5. To release the printer so that all computers on the network can use it, click the Disconnect button.
The status changes to Available. Now any computers on the network can use the printer.
6. To exit the utility, select System > Exit.

View or Change the Status of a Printer
To view or change the status:
1.

Click the NETGEAR USB Control Center icon
.
The NETGEAR USB Control Center page displays.
The Status column shows the status for each device:
•

Available. No print jobs are in progress. You can use the USB printer from any computer in the
network.

•

Connected. Your computer is connected to the printer and will be released when your print job is
done.

•

Manually Connected by. Only the connected computer can use the printer.

•

Waiting to Connect. Your computer is not connected to the shared printer yet.

2. To print from your computer when the status shows Manually connected by another computer, do the
following:

Share a USB Printer
159

AC5300 WiFi VDSL/ADSL Modem Router Model D8500

a. Click the Connect button on your computer.
On the other user’s computer, a message displays that another user wants to connect to the printer.
b. On the other user’s computer, click the Accept button.
The printer is released from the connection and the status changes to Available.
3. To print from your computer when the status shows Waiting to Connect, do the following:
a. Click the Connect button.
The printer status changes to Manually connected by Mycomputer. Now only your computer can
use the printer.
b. To allow the printer to be shared, click the Disconnect button.
The printer is released from the connection and the status changes to Available.

Use the Scan Feature of a Multifunction USB Printer
If your USB printer supports scanning, you can also use the USB printer for scanning.

To use the scan feature of a multifunction USB printer:
1.

Click the NETGEAR USB Control Center icon
.
The NETGEAR USB Control Center page displays.

2. Make sure that the printer status shows as Available.
3. Click the Network Scanner button.
4. If a Select a Device window opens, select the scanner and click the OK button.
The scanner window opens so that you can use the USB printer for scanning.

Change NETGEAR USB Control Center Settings
You can stop the NETGEAR USB Control Center from starting automatically when you log in to Windows.
You can also change the language and specify the time-out to release the printer connection.

Turn Off Automatic Startup for NETGEAR USB Control Center
You can stop the NETGEAR USB Control Center from starting automatically when you log in to Windows.

To turn off automatic NETGEAR USB Control Center startup:
1.

Click the NETGEAR USB Control Center icon
.
The NETGEAR USB Control Center page displays.

2. Select Tools > Configuration.
The Control Center - Configuration page displays.
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3. Clear the Automatically execute when logging on Windows check box.
4. Click the OK button.
Your settings are saved.

Change the Language for the NETGEAR USB Control Center
To change the language:
1.

Click the NETGEAR USB Control Center icon
.
The NETGEAR USB Control Center page displays.

2. Select Tools > Configuration.
The Control Center - Configuration page displays.
3. From the Language menu, select a language.
4. Click the OK button.
The next time NETGEAR USB Control Center starts, the language changes.

Specify the USB Control Center Time-Out
Specify the time-out to release the printer connection.

To specify the time-out:
1.

Click the NETGEAR USB Control Center icon
.
The NETGEAR USB Control Center page displays.

2. Select Tools > Configuration.
The Control Center - Configuration page displays.
3. In the Timeout field, type the number of minutes.
The time-out is the number of minutes that a computer holds its connection to the printer when the
connection isn’t being used.
4. Click the OK button.
Your settings are saved.
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Manage the WAN and LAN Network
Settings

12

This chapter describes how you can manage the WAN and LAN network settings of the modem router.
The chapter includes the following sections:
•

Change the Physical WAN Connection Preference on page 163

•

Manage Ethernet Port Aggregation on page 163

•

Set Up a VLAN IPTV Bridge for a Port Group or VLAN Tag Group on page 166

•

Manage the WAN Security Settings on page 169

•

Set Up a Default DMZ Server on page 170

•

Manage NAT Filtering on page 171

•

Manage the SIP Application-Level Gateway on page 171

•

Manage IGMP Proxying on page 172

•

Manage the Modem Routers’s LAN IP Address Settings on page 172

•

Manage the Router Information Protocol Settings on page 174

•

Manage Reserved LAN IP Addresses on page 174

•

Manage the DHCP Server Address Pool on page 176

•

Disable the Built-In DHCP Server on page 178

•

Change the Modem Router’s Device Name on page 178

•

Set Up and Manage Custom Static Routes on page 179
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Change the Physical WAN Connection Preference
The modem router can autodetect the type of WAN connection. However, you can also set the WAN
connection preference manually to either the DSL port or the Ethernet WAN port.
Note The modem router does not support load balancing over DSL and Ethernet WAN
interfaces. Only one WAN interface (either the DLS port or the Ethernet WAN port)
can be active at any time.

To change the WAN connection preference:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup > WAN Setup.
The WAN Setup page displays.
5. From the WAN Preference menu, select a connection option:
•
•

Must use DSL WAN. The modem router uses the DSL port for a DSL WAN connection. The Internet
port is shut down.
Must use Ethernet WAN. The modem router uses the Internet port for an Ethernet WAN connection.
The DSL port is shut down.

6. Click the Apply button.
Your settings are saved.

Manage Ethernet Port Aggregation
Ethernet aggregation lets you combine two Gigabit Ethernet ports into one logical link to improve the
aggregated file transfer speed. Note that Ethernet port aggregation is also referred to as link aggregation,
teaming port, and port trunking. If a device supports Ethernet aggregation, you can use Ethernet aggregate
ports 1 and 2 on the modem router to cable the device that supports Ethernet port aggregation to the modem
router.
Note When port aggregation is enabled for Ethernet aggregate ports 1 and 2, to get the
fastest performance on other ports, for wired connections use Ethernet port 3 for the
first computer, and use Ethernet port 4, 5, or 6 for the second computer, which allows
for speeds up to 2 Gbps. When port aggregation is enabled for Ethernet aggregate
ports 1 and 2, the maximum speed between port 4, 5, and 6 is limited to 1 Gbps.
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NETGEAR ReadyNAS equipment with two Ethernet ports such as models RN100, RN200, RN300, RN500,
and RN700 desktop series and the ReadyNAS RN2000, RN3000, and RN4000 rackmount series support
Ethernet aggregation.

Figure 19. Ethernet port aggregation with a NETGEAR ReadyNAS product

Note Ethernet port aggregation and the VLAN/IPTV bridge feature are mutually exclusive.
If you want to use Ethernet port aggregation, do not set up a VLAN/IPTV bridge. For
more information, see Set Up a VLAN IPTV Bridge for a Port Group or VLAN Tag
Group on page 166.

Set Up an Ethernet Port Aggregation Link
By default, the Ethernet port aggregation option on the modem router is enabled.

To set up a Ethernet port aggregation link:
1. If you are connecting the modem router to a switch, make sure that the switch supports 802.3ad LACP.
You must configure the switch before you connect the Ethernet cables to the modem router.

WARNING:
To avoid causing broadcast looping, which can shut down your network, do
not connect an unmanaged switch to Ethernet aggregate port 1 and port 2 on
the modem router.

2. Use Ethernet cables to connect a device that supports Ethernet port aggregation, such as a NAS or
network switch, to Ethernet port 1 and port 2 on the modem router.
3. Set up Ethernet port aggregation on the device that is connected to Ethernet port 1 and port 2 on the
modem router.
For information about how to set up Ethernet port aggregation on your device, see the documentation
that came with your device.
For information about viewing the status of the Ethernet port aggregation, see View the Status of or Disable
Ethernet Port Aggregation on page 165.
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View the Status of or Disable Ethernet Port Aggregation
You can view the status of Ethernet port aggregation for a device that is connected to the designated Ethernet
aggregation ports on the modem router. The device must support Ethernet aggregation.
By default, the Ethernet port aggregation option on the modem router is enabled.You can disable this option,
for example, if you must set up a bridge. Ethernet port aggregation and the bridge feature (also referred to
as the VLAN IPTV feature) are mutually exclusive.

To view the status of the Ethernet port aggregation or disable the Ethernet port aggregation:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Ethernet Port Aggregation.

The Ethernet Port Aggregation Status displays. (The previous figure shows the status as Inactive.)
5. To disable the Ethernet port aggregation option, select the Disable radio button.
6. Click the Apply button.
Your settings are saved.
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Set Up a VLAN IPTV Bridge for a Port Group or VLAN Tag
Group
Some devices, such as an IPTV, cannot function behind the modem router’s network address translation
(NAT) service or firewall. Based on what your Internet service provider (ISP) requires, for the device to
connect to the ISP’s network directly, you can enable a bridge between the device and the modem router’s
Internet port or add new VLAN tag groups to the bridge.
The VLAN IPTV bridge feature and Ethernet port aggregation are mutually exclusive. If you need to set up
a VLAN IPTV bridge, disable Ethernet port aggregation (see View the Status of or Disable Ethernet Port
Aggregation on page 165).
Note If your ISP provides directions on how to set up a VLAN IPTV bridge for IPTV and
Internet service, follow those directions.

Set Up a VLAN IPTV Bridge for a Port Group
If the devices that are connected to the modem router’s Ethernet LAN port or WiFi network include an IPTV
device, your ISP might require you to set up a VLAN IPTV bridge for a port group for the modem router’s
Internet interface.
A VLAN IPTV bridge with a port group prevents packets that are sent between the IPTV device and the
modem router’s Internet port from being processed through the modem router’s network address translation
(NAT) service.

To configure a port group and enable the VLAN IPTV bridge:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > VLAN/IPTV Setup.
The VLAN/IPTV Setup page displays.
5. Select the Enable VLAN/IPTV Setup check box.
The page expands.
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6. Select the By bridge group radio button.

7. Select a Wired Ports check box or a Wireless check box.
•
•

If your device is connected to an Ethernet port on the modem router, select the Wired Ports check
box that corresponds to the Ethernet port on the modem router to which the device is connected.
If your device is connected to your modem router’s WiFi network, select the Wireless check box that
corresponds to the modem router’s WiFi band to which the device is connected.
Note You must select at least one Wired Ports or Wireless check box. You can select more
than one check box.

8. Click the Apply button.
Your settings are saved.

Set Up a VLAN IPTV Bridge for a VLAN Tag Group
If the devices that are connected to the modem router’s Ethernet LAN ports or WiFi network include an IPTV
device, your ISP might require you to set up a VLAN IPTV bridge for a VLAN tag group for the modem
router’s Internet interface.
If you are subscribed to IPTV service, the modem router might require VLAN tags to distinguish between
the Internet traffic and the IPTV traffic. A VLAN IPTV bridge with a VLAN tag group prevents packets that
are sent between the IPTV device and the modem router’s Internet port from being processed through the
modem router’s network address translation (NAT) service.
You can add VLAN tag groups to a bridge and assign VLAN IDs and priority values to each VLAN tag group.

To add a VLAN tag group and enable the VLAN IPTV bridge:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > VLAN/IPTV Setup.
The VLAN/IPTV Setup page displays.
5. Select the Enable VLAN/IPTV Setup check box.
6. Select the By VLAN tag group radio button.

By default, a VLAN tag group with the name Internet and VLAN ID 10 exists. All wired and WiFi ports
are members of this group and no priority is given to any member.
7. Click the Add button.

8. Specify the settings as described in the following table.
Field

Description

Name

Enter a name for the VLAN tag group.
The name can be up to 10 characters.

VLAN ID

Enter a value from 1 to 4094.
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(Continued)
Field

Description

Priority

Enter a value from 0 to 7.

Select the check box for a wired Ethernet port or WiFi port.
If your device is connected to an Ethernet port on the modem router, select the port check box that corresponds
to the Ethernet port on the modem router to which the device is connected. If your device is connected to
your modem router’s WiFi network, select the check box that corresponds to the modem router’s WiFi band
to which the device is connected.
You must select at least one Ethernet port or WiFi port. You can select more than one port.

9. Click the Add button.
The VLAN tag group is added.
10. In the Enable column of the table, make sure that the check box for the new VLAN tag group is selected.
11. Click the Apply button.
Your settings are saved.

Manage the WAN Security Settings
The WAN security settings include port scan protection and denial of service (DoS) protection, which can
protect your LAN against attacks such as Syn flood, Smurf Attack, Ping of Death, and many others. By
default, DoS protection is enabled and a port scan is rejected.
You can also enable the modem router to respond to a ping to its WAN (Internet) port. This feature allows
your modem router to be discovered. Enable this feature only as a diagnostic tool or if a specific reason
exists.

To change the default WAN security settings:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup > WAN Setup.
The WAN Setup page displays.
5. To enable a port scan and disable DoS protection, clear the Disable Port Scan and DoS Protection
check box.
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6. To enable the modem router to respond to a ping, select the Respond to Ping on Internet Port check
box.
7. Click the Apply button.
Your settings are saved.

Set Up a Default DMZ Server
The default DMZ server feature is helpful when you are using some online games and videoconferencing
applications that are incompatible with Network Address Translation (NAT).The modem router is programmed
to recognize some of these applications and to work correctly with them, but other applications might not
function well. In some cases, one local computer can run the application correctly if the IP address for that
computer is entered as the default DMZ server.

WARNING:
DMZ servers pose a security risk. A computer designated as the default DMZ
server loses much of the protection of the firewall and is exposed to exploits
from the Internet. If compromised, the DMZ server computer can be used to
attack other computers on your network.
The modem router usually detects and discards incoming traffic from the Internet that is not a response to
one of your local computers or a service or application for which you set up a port forwarding or port triggering
rule. Instead of discarding this traffic, you can direct the modem router to forward the traffic to one computer
on your network. This computer is called the default DMZ server.

To set up a default DMZ server:
1. Launch a web browser from a computer or mobile device device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup > WAN Setup.
The WAN Setup page displays.
5. Select the Default DMZ Server check box.
6. Enter the IP address of the server.
7. Click the Apply button.
Your settings are saved.
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Manage NAT Filtering
Network Address Translation (NAT) determines how the modem router processes inbound traffic. Secured
NAT protects computers on the LAN from attacks from the Internet but might prevent some Internet games,
point-to-point applications, or multimedia applications from working. Open NAT provides a much less secured
firewall but allows almost all Internet applications to work. Secured NAT is the default setting.

To change the default NAT filtering settings:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup > WAN Setup.
The WAN Setup page displays.
5. Select a NAT Filtering radio button:
•

•

Secured. Provides a secured firewall to protect the computers on the LAN from attacks from the
Internet but might prevent some Internet games, point-to-point applications, or multimedia applications
from functioning. By default, the Secured radio button is selected.
Open. Provides a much less secured firewall but allows almost all Internet applications to function.

6. Click the Apply button.
Your settings are saved.

Manage the SIP Application-Level Gateway
The application-level gateway (ALG) for the Session Initiation Protocol (SIP) is enabled by default for
enhanced address and port translation. However, some types of VoIP and video traffic might not work well
when the SIP ALG is enabled. For this reason, the modem router provides the option to disable the SIP
ALG.

To change the default SIP ALG setting:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
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4. Select ADVANCED > Setup > WAN Setup.
The WAN Setup page displays.
5. To disable the SIP ALG, select the Disable SIP ALG check box.
The SIP ALG is enabled by default.
6. Click the Apply button.
Your settings are saved.

Manage IGMP Proxying
IGMP proxying allows a computer on the local area network (LAN) to receive the multicast traffic it is interested
in from the Internet. If you do not need this feature, leave it disabled, which is the default setting.

To enable or disable IGMP proxying:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup > WAN Setup.
The WAN Setup page displays.
5. Clear or select the Disable IGMP Proxying check box.
By default, the Disable IGMP Proxying check box is selected and IGMP proxying is disabled.
6. To enable proxying for British Telecom only, clear the Disable IGMP Proxying check box and select
the Support British Telecom (BT)IGMP Proxying check box.
7. Click the Apply button.
Your settings are saved.

Manage the Modem Routers’s LAN IP Address Settings
The modem router is preconfigured to use private IP addresses on the LAN side and to act as a DHCP
server. The modem router’s default LAN IP configuration is as follows:
•

LAN IP address. 192.168.0.1 (This is the same as www.routerlogin.net and www.routerlogin.com.)

•

Subnet mask. 255.255.255.0

These addresses are part of the designated private address range for use in private networks and are
suitable for most applications. The IP address and subnet mask identify which addresses are local to a
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specific device and which must be reached through a gateway or modem router. You might want to change
these settings if you need a specific IP subnet that one or more devices on the network use, or if competing
subnets use the same IP scheme.

To change the LAN IP address settings:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup > LAN Setup.

5. In the IP Address fields, enter the LAN IP address for the modem router.
6. In the IP Subnet Mask fields, enter the LAN subnet mask for the modem router.
7. Click the Apply button.
Your settings are saved.
If you changed the LAN IP address of the modem router, you are disconnected when the changes take
effect.
To reconnect, close your browser, relaunch it, and log in to the modem router at its new LAN IP address.
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Manage the Router Information Protocol Settings
Router Information Protocol (RIP) lets the modem router exchange routing information with other routers.
By default, RIP is enabled in both directions (in and out) without a particular RIP version.

To manage the RIP settings:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup > LAN Setup.
The LAN Setup page displays.
5. From the RIP Direction menu, select the RIP direction:
•
•
•

Both. The modem router broadcasts its routing table periodically and incorporates information that
it receives. This is the default setting.
Out Only. The modem router broadcasts its routing table periodically but does not incorporate the
RIP information that it receives.
In Only. The modem router incorporates the RIP information that it receives but does not broadcast
its routing table.

6. From the RIP Version menu, select the RIP version:
•
•
•

Disabled. The RIP version is disabled. This is the default setting.
RIP-1. This format is universally supported. It is adequate for most networks, unless you are using
an unusual network setup.
RIP-2. This format carries more information. Both RIP-2B and RIP-2M send the routing data in RIP-2
format. RIP-2B uses subnet broadcasting. RIP-2M uses multicasting.

7. Click the Apply button.
Your settings are saved.

Manage Reserved LAN IP Addresses
When you specify a reserved IP address for a computer on the LAN, that computer always receives the
same IP address each time it accesses the modem router’s DHCP server.
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Reserve a LAN IP Address
You can assign a reserved IP address to a computer or server that requires permanent IP settings.

To reserve an IP address:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup > LAN Setup.
The LAN Setup page displays.
5. In the Address Reservation section, click the Add button.
The Address Reservation page displays.
6. Either select a device from the Address Reservation Table by selecting the corresponding radio button
or specify the reserved IP address information:
•
•
•

In the IP Address field, enter the IP address to assign to the computer or device.
In the MAC Address field, enter the MAC address of the computer or device.
In the Device Name field, enter the name of the computer or device.

7. Click the Add button.
The reserved address is entered into the table on the LAN Setup page.
The reserved address is not assigned until the next time the computer or device contacts the modem
router’s DHCP server. Reboot the computer or device, or access its IP configuration and force a DHCP
release and renew.

Change a Reserved IP Address
You can change a reserved IP address entry.

To change a reserved IP address entry:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
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4. Select ADVANCED > Setup > LAN Setup.
The LAN Setup page displays.
5. In the Address Reservation section, select the radio button for the reserved address.
6. Click the Edit button.
The Address Reservation page displays.
7. Change the settings.
8. Click the Apply button.
Your settings are saved.

Remove a Reserved IP Address Entry
You can remove a reserved IP address entry.

To remove a reserved IP address entry:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup > LAN Setup.
The LAN Setup page displays.
5. In the Address Reservation section, select the radio button for the reserved address.
6. Click the Delete button.
The address entry is removed.

Manage the DHCP Server Address Pool
By default, the modem router acts as a Dynamic Host Configuration Protocol (DHCP) server. The modem
router assigns IP, DNS server, and default gateway addresses to all computers that are connected to its
LAN and WiFi networks. The assigned default gateway address is the LAN address of the modem router.
These addresses must be part of the same IP address subnet as the modem router’s LAN IP address. The
default DHCP address pool is 192.168.0.2–192.168.0.254.
The modem router delivers the following parameters to any LAN device that requests DHCP:
•

An IP address from the range that you define

•

Subnet mask
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•

Gateway IP address (the modem router’s LAN IP address)

•

DNS server IP address (the modem router’s LAN IP address)

To specify the pool of IP addresses that the modem router assigns:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup > LAN Setup.

5. Make sure that the Use Router as DHCP Server check box is selected.
This check box is selected by default.
6. Specify the range of IP addresses that the modem router assigns:
•

In the Starting IP Address field, enter the lowest number in the range.
This IP address must be in the same subnet as the modem router. By default, the starting IP address
is 192.168.0.2.

•

In the Ending IP Address field, enter the number at the end of the range of IP addresses.
This IP address must be in the same subnet as the modem router. By default, the ending IP address
is 192.168.0.254.

7. Click the Apply button.
Your settings are saved.
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Disable the Built-In DHCP Server
By default, the modem router functions as a DHCP server. The modem router assigns IP, DNS server, and
default gateway addresses to all devices connected to the LAN. The assigned default gateway address is
the LAN address of the modem router.
You can use another device on your network as the DHCP server or specify the network settings of all your
computers.
Note If you disable the DHCP server and no other DHCP server is available on your network,
you must set your computer IP addresses manually so that they can access the
modem router.

To disable the built-in DHCP server:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Setup > LAN Setup.
The LAN Setup page displays.
5. Clear the Use Router as DHCP Server check box.
6. Click the Apply button.
Your settings are saved.

Change the Modem Router’s Device Name
The modem router’s device name is D8500.
This device name displays in a file manager when you browse your network.

To change the modem router’s device name:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
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4. Select ADVANCED > Setup > LAN Setup.
The LAN Setup page displays.
5. In the Device Name field, enter a new name.
6. Click the Apply button.
Your settings are saved.

Set Up and Manage Custom Static Routes
Static routes provide detailed routing information to your modem router. Typically, you do not need to add
static routes.You must configure static routes only for unusual cases such as when you use multiple routers
or multiple IP subnets on your network.
As an example of when a static route is needed, consider the following case:
•

Your primary Internet access is through an ADSL modem to an ISP.

•

You use an ISDN router on your home network for connecting to the company where you are employed.
This router’s address on your LAN is 192.168.0.100.

•

Your company’s network address is 134.177.0.0.

When you first configured your modem router, two implicit static routes were created. A default route was
created with your ISP as the gateway and a second static route was created to your local network for all
192.168.0.x addresses. With this configuration, if you attempt to access a device on the 134.177.0.0 network,
your modem router forwards your request to the ISP. The ISP forwards your request to the company where
you are employed, and the request is likely to be denied by the company’s firewall.
In this case, you must define a static route, instructing your modem router that 134.177.0.0 is accessed
through the ISDN modem router at 192.168.0.100. Here is an example:
•

Through the destination IP address and IP subnet mask, specify that this static route applies to all
134.177.x.x addresses.

•

Through the gateway IP address, specify that all traffic for these addresses is forwarded to the ISDN
modem router at 192.168.0.100.

•

A metric value of 1 works fine because the ISDN modem router is on the LAN.

Set Up a Static Route
You can add a static route to a destination IP address and specify the subnet mask, gateway IP address,
and metric.

To set up a static route:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Static Routes.
The Static Routes page displays.
5. Click the Add button.

6. To make the route private, select the Private check box.
A private static route is not reported in RIP.
7. To prevent the route from becoming active after you click the Apply button, clear the Active check box.
In some situations, you might want to set up a static route but keep it disabled until a later time. By
default, the Active check box is selected and a route becomes active after you click the Apply button.
8. Enter the settings as described in the following table.
Field

Description

Destination IP
Address

Enter the IP address for the final destination of the route.

IP Subnet Mask Enter the IP subnet mask for the final destination of the route.
If the destination is a single host, enter 255.255.255.255.
Gateway IP
Address

Enter the IP address of the gateway.

Metric

Enter a number from 1 through 15.

The IP address of the gateway must be on the same LAN segment as the modem
router.

This value represents the number of routers between your network and the destination.
Usually, a setting of 2 or 3 works, but if this is a direct connection, set it to 1.

9. Click the Apply button.
Your settings are saved. The static route is added to the table on the Static Routes page.
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Change a Static Route
You can change an existing static route.

To change a static route:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Static Routes.
The Static Routes page displays.
5. In the Static Routes table, select the radio button for the route.
6. Click the Edit button.
The page adjusts.
7. Change the settings for the route.
For more information about the settings, see Set Up a Static Route on page 179.
8. Click the Apply button.
The route is updated in the table on the Static Routes page.

Remove a Static Route
You can remove an existing static route that you no longer need.

To remove a static route:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Static Routes.
The Static Routes page displays.
5. In the Static Routes table, select the radio button for the route.
6. Click the Delete button.
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The route is removed from the table on the Static Routes page.
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This chapter describes how you can manage the settings for administering and maintaining your modem router
and monitor the network.
The chapter includes the following sections:
•

Update the Firmware of the Modem Router on page 184

•

Manage the Configuration File of the Modem Router on page 186

•

Change the admin Password on page 187

•

Set Up Password Recovery on page 188

•

Recover the admin Password on page 189

•

Return the Modem Router to Its Factory Default Settings on page 189

•

Disable LED Blinking or Turn Off LEDs on page 191

•

View the Status and Statistics of the Modem Router on page 192

•

View Devices Currently on the Network on page 201

•

Manage the Activity Log on page 203

•

Monitor and Meter Internet Traffic on page 205

•

Manage the Modem Router Remotely on page 211
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Update the Firmware of the Modem Router
The modem router firmware is stored in flash memory.
You can check to see if new firmware is available and update the modem router to the new firmware. You
can also visit the NETGEAR support website, download the firmware manually, and update the modem
router to the new firmware.

Check for New Firmware and Update the Modem Router
For you to check for new firmware, the modem router must be connected to the Internet.

To check for new firmware and update your modem router:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Administration > Router Update.
The Router Update page displays.
5. Click the Check button.
The modem router detects new firmware if any is available and displays a message asking if you want
to download and install it.
6. To download and install the new firmware, click the Yes button.
The modem router locates the firmware, downloads it, and begins the update.

WARNING:
To avoid the risk of corrupting the firmware, do not interrupt the update. For
example, do not close the browser, click a link, or load a new page. Do not
turn off the modem router. Wait until the modem router finishes restarting and
the Power LED turns solid white.
A progress bar shows the progress of the firmware upload process. The firmware upload process takes
several minutes. When the upload is complete, your modem router restarts.
7. Verify that the modem router runs the new firmware version:
a. Launch a web browser from a computer or mobile device that is connected to the network.
b. Enter http://www.routerlogin.net.
A login window opens.
c. Enter the modem router user name and password.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays. The firmware version is stated in the top right, under the Logout
button.
8. Read the new firmware release notes to determine whether you must reconfigure the modem router
after updating.

Manually Upload New Firmware and Update the Modem Router
Downloading firmware and updating the modem router are two separate tasks that are combined in the
following procedure.

To download new firmware manually and update your modem router:
1. Visit downloadcenter.netgear.com, locate the support page for your product, and download the new
firmware.
2. Read the new firmware release notes to determine whether you must reconfigure the modem router
after updating.
3. Launch a web browser from a computer or mobile device that is connected to the network.
4. Enter http://www.routerlogin.net.
A login window opens.
5. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
6. Select ADVANCED > Administration > Router Update.
The Router Update page displays.
7. Locate and select the firmware file on your computer:
a. Click the Browse button.
b. Navigate to the firmware file.
The file ends in .chk. An example of a firmware file name is D8500-V1.0.3.25_1.0.1.chk.
c. Select the firmware file.
8. Click the Upload button.

WARNING:
To avoid the risk of corrupting the firmware, do not interrupt the upload. For
example, do not close the browser, click a link, or load a new page. Do not
turn off the modem router. Wait until the modem router finishes restarting and
the Power LED turns solid white.
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A progress bar shows the progress of the firmware upload process. The firmware upload process takes
several minutes. When the upload is complete, your modem router restarts.
9. Verify that the modem router runs the new firmware version:
a. Launch a web browser from a computer or mobile device that is connected to the network.
b. Enter http://www.routerlogin.net.
A login window opens.
c. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays. The version firmware is stated in the top right, under the Logout
button.

Manage the Configuration File of the Modem Router
The configuration settings of the modem router are stored within the modem router in a configuration file.
You can back up (save) this file to your computer or restore it.

Back Up the Settings
You can save a copy of the current configuration settings.

To back up the modem router’s configuration settings:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Administration > Backup Settings.
The Backup Settings page displays.
5. Click the Back Up button.
6. Choose a location to store the file on your computer.
The name of the backup file is NETGEAR_D8500.cfg.
7. Follow the directions of your browser to save the file.
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Restore the Settings
If you backed up the configuration file, you can restore the configuration from this file.

To restore configuration settings that you backed up:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Administration > Backup Settings.
The Backup Settings page displays.
5. Click the Browse button and navigate to and select the saved configuration file.
The name of the backup file from which you can restore the configuration is NETGEAR_D8500.cfg.
6. Click the Restore button.
The configuration is uploaded to the modem router. When the restoration is complete, the modem router
reboots. This process takes about two minutes.

WARNING:
To avoid the risk of corrupting the firmware, do not interrupt the restoration.
For example, do not close the browser, click a link, or load a new page. Do
not turn off the modem router. Wait until the modem router finishes restarting
and the Power LED turns solid white.

Change the admin Password
If you used the NETGEAR installation assistant to set up the modem, you were required to change the
default password that you use to log in to the modem router to a more secure password. This is the password
that you use to log in to the modem router with the user name admin. If you did not use the NETGEAR
installation assistant, we recommend that you do change the default password. If you already changed the
password, you change it again.
The ideal password contains no dictionary words from any language and contains uppercase and lowercase
letters, numbers, and symbols. It can be up to 30 characters.
Note This admin password is not the password that you use for WiFi access. The modem
router label shows your unique WiFi network name (SSID) and password for WiFi
access.
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To change the password for the user name admin:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Administration > Set Password.

5. Enter the old password.
6. Enter the new password twice.
7. Click the Apply button.
Your settings are saved.

Set Up Password Recovery
We recommend that you enable password recovery if you change the password for the modem router user
name admin. Then you can recover the password if it is forgotten. This recovery process is supported in
Internet Explorer, Firefox, and Chrome browsers, but not in the Safari browser.

To set up password recovery:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Administration > Set Password.
The Set Password page displays.
5. Select the Enable Password Recovery check box.
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6. Select two security questions and provide answers to them.
7. Click the Apply button.
Your settings are saved.

Recover the admin Password
We recommend that you enable password recovery if you change the password for the modem router user
name admin. Then you can recover the password if it is forgotten. This recovery process is supported in
Internet Explorer, Firefox, and Chrome browsers, but not in the Safari browser. For information about setting
up password recovery, see Set Up Password Recovery on page 188.
The following procedure works only if you did set up password recovery.

To recover your password:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter www.routerlogin.net.
A login window opens.
3. Click the Cancel button.
If password recovery is enabled, you are prompted to enter the serial number of the modem router. The
serial number is on the modem router label.
4. Enter the serial number of the modem router.
5. Click the Continue button.
A page displays requesting the answers to your security questions.
6. Enter the saved answers to your security questions.
7. Click the Continue button.
A page displays your recovered password.
8. Click the Login again button.
A login window opens.
9. With your recovered password, log in to the modem router.

Return the Modem Router to Its Factory Default Settings
Under some circumstances (for example, if you lost track of the changes that you made to the modem router
settings or you move the modem router to a different network), you might want to erase the configuration
and reset the modem router to factory default settings.
If you do not know the current IP address of the modem router, first try to use an IP scanner application to
detect the IP address before you reset the modem router to factory default settings.
To reset the modem router to factory default settings, you can use either the Reset button on the back of
the modem router or the Erase function. However, if you cannot find the IP address or lost the password to
access the modem router, you must use the Reset button.
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After you reset the modem router to factory default settings, the user name is admin, the password is
password, the LAN IP address is 192.168.0.1 (which is the same as www.routerlogin.net), and the DHCP
server is enabled. For a list of factory default settings, see Factory Settings on page 260.

Use the Reset Button
CAUTION:
This process erases all settings that you configured in the modem router.

To reset the modem router to factory default settings:
1. On the back of the modem router, locate the recessed Reset button.
2. Using a straightened paper clip, press and hold the Reset button for at least five seconds.
3. Release the Reset button.
The Power LED starts blinking amber and the configuration is reset to factory default settings. When
the reset is complete, the modem router reboots. This process takes about two minutes.

WARNING:
To avoid the risk of corrupting the firmware, do not interrupt the reset. For
example, if you are connected to the modem router’s web page, do not close
the browser, click a link, or load a new page. Do not turn off the modem router.
Wait until the modem router finishes restarting and the Power LED turns solid
white.

Erase the Settings
CAUTION:
This process erases all settings that you configured in the modem router.

To erase the settings:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Administration > Backup Settings.
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The Backup Settings page displays.
5. Click the Erase button.
The configuration is reset to factory default settings. When the reset is complete, the modem router
reboots. This process takes about two minutes.

WARNING:
To avoid the risk of corrupting the firmware, do not interrupt the reset. For
example, do not close the browser, click a link, or load a new page. Do not
turn off the modem router. Wait until the modem router finishes restarting and
the Power LED turns solid white.

Disable LED Blinking or Turn Off LEDs
The LEDs on the top panel of the modem router indicate activities and behavior. You can disable LED
blinking for network communications, or turn off all LEDs except the Power LED.

To disable LED blinking or turn off the LEDs:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > LED Control Settings.

By default, the second radio button is selected, which allows standard LED behavior without blinking
when data traffic is detected.
For more information about LEDs, see Top and Front Panels With LEDs and Buttons on page 10.
5. To enable blinking when traffic is detected, select the Enable blinking on Internet LED, LAN LED,
Wireless LED and USB LED when data traffic is detected radio button.
6. To turn off all LEDs except the Power LED, select the Turn off all LEDs except Power LED radio
button.
7. Click the Apply button.
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Your settings are saved.

View the Status and Statistics of the Modem Router
You can view information about the modem router and its ports and the status of the Internet connection
and WiFi network. In addition, you can view traffic statistics for the various ports.

View Information About the Modem Router and the Internet and
WiFi Settings
You can view modem router information, the Internet port status, and WiFi settings.

To view information about the modem router and the Internet and WiFi settings:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
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The BASIC Home page displays.
4. Select ADVANCED.

The information onscreen uses the following color coding:
•

A green flag indicates that the Internet connection is fine and no problems exist. For a WiFi
network, the network is enabled and secured.

•

A red X indicates that configuration problems exist for the Internet connection or the connection
is down. For a WiFi network, the network is disabled or down.

•

An amber exclamation mark indicates that the Internet port is configured but cannot get an Internet
connection (for example, because a cable is disconnected), that a WiFi network is enabled but
unprotected, or that another situation that requires your attention occurred.

The following table describes the fields of the six panes on the ADVANCED Home page.
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Field

Description

Router Information
Hardware Version

The modem router model.

Firmware Version

The version of the modem router firmware. If you upgrade the firmware on the
modem router, the version changes.

GUI Language Version

The version of the modem router language for its web pages. If you upgrade the
firmware on modem router, the language version might change too.

LAN Port
The settings of the LAN port. For information about how to configure the LAN settings, see Manage the Modem
Routers’s LAN IP Address Settings on page 172 and Disable the Built-In DHCP Server on page 178.
MAC Address

The Media Access Control (MAC) address. This address is the unique physical
address that is assigned to the Ethernet LAN port.

IP Address

The IP address that the Ethernet LAN port uses. The default IP address is
192.168.0.1.

DHCP

Displays whether the DHCP server of the modem router is enabled for devices
that are attached to the LAN.

Internet Port
The settings of Internet port. The Internet connection can run through the DSL port with ADSL or VDSL service
or through the WAN Ethernet port with cable service. For information about how to configure the Internet settings,
see one of the following sections:
•

Set Up Your Modem Router for DSL Service on page 21

•

Set Up the Modem Router for Cable Service on page 26

•

Manually Set Up an ADSL Internet Connection on page 36

•

Manually Set Up a VDSL Internet Connection on page 44

•

Manually Set Up a Cable Internet Connection on page 51

MAC Address

The Media Access Control (MAC) address. This address is the unique physical
address that is assigned to the Internet port.

DHCP

Displays whether the DHCP client of the modem router is enabled.

Internet IP Address

The IP addresses that the Internet virtual interface and IPTV virtual interface use.
If a field does not display an address or displays 0.0.0.0 as the address, the modem
router did not obtain a connection for the interface.

IPTV IP Address
Internet Connection
IPTV Connection

The type of connections that the Internet virtual interface and IPTV virtual interface
use. A connection can be a PPPoE, PPPoA, or DHCP connection or a fixed IP
address connection. Each interface can be connected over a different type of
connection.

IP Subnet Mask

The IP subnet mask that the Internet port uses.

Domain Name Server

The IP address of the Domain Name System (DNS) server that the Internet uses.
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(Continued)
Field

Description

Wireless Settings (2.4 GHz)
The settings of the WiFi port for the 2.4 GHz band of the main network. For information about how to configure
the settings of the main network, see the following sections:
•

Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 86

•

Manage Advanced WiFi Settings on page 216

Name (SSID)

The WiFi network name for the 2.4 GHz band of the main network.

Region

The location (country).

Channel

The channel that the 2.4 GHz band of the main network uses.

Mode

The WiFi Mbps settings that the 2.4 GHz band uses for both the main network
and guest network.

Wireless AP

Displays whether the 2.4 GHz band of the main network is enabled.

Broadcast Name

Displays whether the 2.4 GHz band of the main network broadcasts its SSID.

Wi-Fi Protected Setup

Displays whether the modem router keeps its existing WiFi settings when you use
WPS to connect a device to the 2.4 GHz band of the main network:
•

Configured. The modem router keeps its existing WiFi settings. This is the
default setting.

•

Not configured.The modem router generates a random SSID and passphrase
and changes the security mode to WPA and WPA2-PSK mixed mode.
For more information, see Manage the WPS Settings on page 215.

Wireless Settings (5.0 GHz)
Wireless Settings (5.0 GHz) Second Radio
The settings of the WiFi port for the 5 GHz band of the main network. This information is provided separately for
the first and the second radio in the 5 GHz band. For information about how to configure the settings of the main
network, see the following sections:
•

Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 86

•

Manage Advanced WiFi Settings on page 216

Name (SSID)

The WiFi network name for the 5 GHz band of the main network.

Region

The location (country).

Channel

The channel that the 5 GHz band of the main network uses.

Mode

The WiFi Mbps settings that the 5 GHz band uses for both the main network and
guest network.

Wireless AP

Displays whether the 5 GHz band of the main network is enabled.
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(Continued)
Field

Description

Broadcast Name

Displays whether the 5 GHz band of the main network broadcasts its SSID.

Wi-Fi Protected Setup

Displays whether the modem router keeps its existing WiFi settings when you use
WPS to connect a device to the 5 GHz band of the main network:
•

Configured. The modem router keeps its existing WiFi settings. This is the
default setting.

•

Not configured.The modem router generates a random SSID and passphrase
and changes the security mode to WPA and WPA2-PSK mixed mode.
For more information, see Manage the WPS Settings on page 215.

Guest Network (2.4 GHz)
The settings of the WiFi port for the 2.4 GHz band of the guest network. For information about how to configure
the settings of the guest network, see Manage the Basic WiFi Settings and WiFi Security of the Guest Network
on page 98.
Name (SSID)

The WiFi network name for the 2.4 GHz band of the guest network.

Wireless AP

Displays whether the 2.4 GHz band of the guest network is enabled.
The associated WiFi LED on the modem router is not affected by the status of the
guest network.

Broadcast Name

Displays whether the 2.4 GHz band of the guest network broadcasts its SSID.

Allow guest to see each other Displays whether users of the 2.4 GHz band of the guest network are allowed to
and access my local network access the main network.
Guest Network (5.0 GHz)
Guest Network (5.0 GHz) Second Radio
The settings of the WiFi port for the 5 GHz band of the guest network. This information is provided separately for
the first and the second radio in the 5 GHz band. For information about how to configure the settings of the guest
network, see Manage the Basic WiFi Settings and WiFi Security of the Guest Network on page 98.
Name (SSID)

The WiFi network name for the 5 GHz band of the guest network.

Wireless AP

Displays whether the 5 GHz band of the guest network is enabled.
The associated WiFi LED on the modem router is not affected by the status of the
guest network.

Broadcast Name

Displays whether the 5 GHz band of the guest network broadcasts its SSID.

Allow guest to see each other Displays whether users of the 5 GHz band of the guest network are allowed to
and access my local network access the main network.

View the Traffic Statistics
You can view the traffic statistics for the ports of the modem router.
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To view the traffic statistics for the ports of the modem router:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED.
The ADVANCED Home page displays.
5. In the Internet Port pane, click the Show Statistics button.
The Show Statistics pop-up window opens.
The following table describes the fields and columns of the Show Statistics pop-up window.
Field or Column

Description

System Up Time

The time elapsed since the modem router was last restarted.

Port

The statistics for the WAN (Internet over Ethernet) port, LAN (Ethernet) ports,
WLAN b/g/n port, and WLAN a/n/ac port. For each port, the page displays the
information that is described in this table.

Status

The link status of the port.

TxPkts

The number of packets that were transmitted on this port since reset or manual
clear.

RxPkts

The number of packets that were received on this port since reset or manual clear.

Collisions

The number of packets that collided on this port since reset or manual clear.

Tx B/s

The number of bytes per second that were transmitted on this port since reset or
manual clear.

Rx B/s

The number of bytes per second that were received on this port since reset or
manual clear.

Up Time

The time elapsed since this port acquired the link.

ADSL Link
The page displays the ADSL link information that is described in this table.
Connection Speed

The downstream and upstream connection speed rates in Mbps.

Line Attenuation

The downstream and upstream line attenuation (LATN) in dB.The LATN expresses
the signal quality.
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(Continued)
Field or Column

Description

Noise Margin

The downstream and upstream signal-to-noise ratio margin (SNRM) in dB. The
SNRM expresses the signal quality in relation to interference.

Poll Interval

The interval at which the statistics are updated on this page.

Change the Traffic Statistics Polling Frequency
You can change the polling frequency or stop traffic polling.

To change the traffic statistics polling frequency or stop polling:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED.
The ADVANCED Home page displays.
5. In the Internet Port pane, click the Show Statistics button.
A pop-up window displays.
6. Change the polling frequency or stop polling:
•

To change the polling frequency, do the following:
a. In the Poll Interval field, enter a time in seconds.
b. Click the Set Interval button.

•

To stop polling, click the Stop button.

View, Renew, or Release the TCP/IP Internet Connection
You can view information about a TCP/IP Internet connection of the modem router and renew or release
such a connection. This information displays only if the modem router connects to the ISP network over a
TCP/IP connection. Such a connection usually functions over an Ethernet WAN connection.
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To view the status of the TCP/IP Internet connection or renew or release the TCP/IP Internet
connection:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED.
The ADVANCED Home page displays.
5. In the Internet Port pane, click the Connection Status button.
The Connection Status pop-up window opens. The fields that display depend on the type of Internet
connection.
The following table describes the fields for a TCP/IP connection with DHCP.
Field

Description

IP Address

The IP address that is assigned by the ISP to the modem router.

Subnet Mask

The subnet mask that is assigned by the ISP to the modem router.

Default Gateway

The IP address of the default gateway of the ISP that the modem router communicates
with.

DHCP Server

The IP address of the DHCP server of the ISP that issues the IP address to the modem
router.

DNS Server

The IP address of the Domain Name System (DNS) server of the ISP that provides
translation of network names to IP addresses.

Lease Obtained

The time at which the modem router obtained the DHCP lease. (The type of DHCP
connection determines whether this field displays onscreen.)

Lease Expires

The time at which the DHCP lease expires. (The type of DHCP connection determines
whether this field displays onscreen.)

6. To renew the Internet connection when the connection is active, click the Renew button.
7. To terminate the Internet connection when the connection is active, click the Release button.
8. Click the Close Window button.
The pop-up window closes.
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View, Establish, or Terminate the PPPoE or PPPoA Internet
Connection
You can view information about a PPPoE or PPPoA Internet connection of the modem router and establish
or terminate such a connection. This information displays only if the modem router connects to the ISP
network over a PPPoE or PPPoA connection. A PPPoE connection can function over an ADSL, VDSL, or
cable connection. A PPPoA connection can function only over a VDSL connection.

To view the status of the PPPoE or PPPoA Internet connection or establish or terminate the
PPPoE or PPPoA Internet connection:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED.
The ADVANCED Home page displays.
5. In the Internet Port pane, click the Connection Status button.
The Connection Status pop-up window opens. The fields that display depend on the type of Internet
connection.
The following table describes the fields for a PPPoE connection.
Field

Description

Connection Time

The time elapsed since the connection was established.

Connection Status

The status can be Connected or Disconnected.

Negotiation

The negotiation can be a series of dashes, which indicates that the connection is not
established, or successful (Success).

Authentication

The authentication can be a series of dashes, which indicates that the connection is
not established, or successful (Success).

IP Address

The IP address that is assigned by the ISP to the modem router.

Subnet Mask

The subnet mask that is assigned by the ISP to the modem router.

6. To establish the Internet connection when the connection is down, click the Connect button.
7. To terminate the Internet connection when the connection is active, click the Disconnect button.
8. Click the Close Window button.
The pop-up window closes.
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View, Establish, or Terminate the PPTP or L2TP Internet
Connection
You can view information about a PPTP or L2TP Internet connection of the modem router and establish or
terminate such a connection. This information displays only if the modem router connects to the ISP network
over a PPTP or L2TP connection. A PPTP or L2TP connection can function only over an Ethernet WAN
connection.

To view the status of the PPTP or L2TP Internet connection or establish or terminate the
PPTP or L2TP Internet connection:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED.
The ADVANCED Home page displays.
5. In the Internet Port pane, click the Connection Status button.
The Connection Status pop-up window opens. The fields that display depend on the type of Internet
connection.
Field

Description

IP Address

The IP address that is assigned by the ISP to the modem router.

Subnet Mask

The subnet mask that is assigned by the ISP to the modem router.

6. To establish the Internet connection when the connection is down, click the Connect button.
7. To terminate the Internet connection when the connection is active, click the Disconnect button.
8. Click the Close Window button.
The pop-up window closes.

View Devices Currently on the Network
You can view the active wired and WiFi devices in both the network to which the modem router is connected
and the modem router network. If you do not recognize a WiFi device, it might be an intruder.

To display the wired and WiFi devices:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
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A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select Attached Devices.

Wired devices are connected to the modem router with Ethernet cables. WiFi devices are connected to
the modem router through the WiFi network, in either the 2.4 GHz band or one of the 5 GHz bands.
Devices that are connected over a VPN connection are listed separately.
The following table describes the fields that can be displayed.
Field

Description

Wired and WiFi devices
Status

The status of the device in the network (Allowed or Blocked). This field is displayed only
when access control is enabled.

Connection
Type

The type of connection for the device.

Device Name

The device name, if detected.

IP Address

The IP address that the modem router assigned to the device when it joined the network.
This address can change when a device is disconnected and rejoins the network.

MAC Address

The unique MAC address. The MAC address does not change and is usually shown on the
product label.

VPN Client Devices
Device Name

The device name, if detected.

Remote IP
Address

The IP address at the remote end of the VPN tunnel.
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(Continued)
Field

Description

Local IP
Address

The IP address at the local of the VPN tunnel, that is, the IP address on the modem router.

Connection
Time

The period since the connection was established.

5. To edit selected information that is displayed for an attached device, do the following:
a. Select the check box for the device in the table.
b. Click the Edit button.
The Edit Device page displays.
c. Change the settings as needed.
d. Click the Apply button.
Your settings are saved and the Edit Device page closes.
6. To refresh the information onscreen, click the Refresh button.
The information onscreen is updated.

Manage the Activity Log
The log is a detailed record of the websites that users on your network accessed or attempted to access
and many other router actions. Up to 256 entries are stored in the log. You can manage which activities are
logged.

View, Email, or Clear the Logs
In addition to viewing the logs, you can email them and clear them.

To view, email, or clear the logs:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
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4. Select ADVANCED > Administration > Logs.

The Logs page shows the following information:
•

Action. The action that occurred, such as whether Internet access was blocked or allowed.

•

Source. The name, IP address, or MAC address of the target device, application, or website for
this log entry.

•

Target. The name, IP address, or MAC address of the target device, application, or website for this
log entry.

•

Date and Time. The date and time at which the action occurred.

5. To refresh the log entries onscreen, click the Refresh button.
6. To clear the log entries, click the Clear Log button.
7. To email the log immediately, click the Send Log button.
The modem router emails the logs to the address that you specified (see Set Up Security Event Email
Notifications on page 122).

Specify Which Activities Are Logged
You can specify which activities are logged. These activities display in the log and are forwarded to the
syslog server if you enabled the syslog server function.

To manage which activities are logged:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
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3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Administration > Logs.
The Logs page displays.
5. Select the check boxes that correspond to the activities that you want to be logged.
By default, all check boxes are selected.
6. Clear the check boxes that correspond to the activities that you do not want to be logged.
7. Click the Apply button.
Your settings are saved.

Monitor and Meter Internet Traffic
Traffic metering allows you to monitor the volume of Internet traffic that passes through the modem router
Internet port. With the traffic meter utility, you can set limits for traffic volume, set a monthly limit, and get a
live update of traffic usage.

Start the Traffic Meter Without Traffic Volume Restrictions
You can monitor the traffic volume without setting a limit.

To start or restart the traffic meter without configuring traffic volume restrictions:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.

Manage the Modem Router and Monitor the Traffic
205

AC5300 WiFi VDSL/ADSL Modem Router Model D8500

4. Select ADVANCED > Advanced Setup > Traffic Meter.

5. Select the Enable Traffic Meter check box.
By default, no traffic limit is specified and the traffic volume is not controlled.
6. In the Traffic Counter section, set the traffic counter to begin at a specific time and date.
7. To start the traffic counter immediately, click the Restart Counter Now button.
8. Click the Apply button.
Your settings are saved and the modem router restarts.
The Internet Traffic Statistics section helps you to monitor the data traffic. For more information, see
View the Internet Traffic Volume and Statistics on page 206.

View the Internet Traffic Volume and Statistics
If you enabled the traffic meter (see Start the Traffic Meter Without Traffic Volume Restrictions on page 205),
you can view the Internet traffic volume and statistics.

To view the Internet traffic volume and statistics shown by the traffic meter:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
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4. Select ADVANCED > Advanced Setup > Traffic Meter.
The Traffic Meter page displays.
5. Scroll down to the Internet Traffic Statistics section.
The Internet Traffic Statistics section displays when the traffic counter was started and what the traffic
balance is. The table displays information about the connection time and traffic volume in MB.
6. To refresh the information onscreen, click the Refresh button.
The information is updated.
7. To display more information about the data traffic and to change the polling interval, click the Traffic
Status button.
The Traffic Status pop-up window displays.

Restrict Internet Traffic by Volume
You can record and restrict the traffic by volume in MB. This is useful when your ISP measures your traffic
in volume.

To record and restrict the Internet traffic by volume:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
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4. Select ADVANCED > Advanced Setup > Traffic Meter.

5. Select the Enable Traffic Meter check box.
6. Select the Traffic volume control by radio button.
7. From the corresponding menu, select an option:
•
•

Download only. The restriction is applied to incoming traffic only.
Both Directions. The restriction is applied to both incoming and outgoing traffic.

8. In the Monthly Limit field, enter how many MBytes (MB) per month are allowed.
9. If your ISP charges you for extra data volume when you make a new connection, enter the extra data
volume in MB in the Round up data volume for each connection by field.
10. In the Traffic Counter section, set the traffic counter to begin at a specific time and date.
11. In the Traffic Control section, enter a value in minutes to specify when the modem router issues a warning
message before the monthly limit in hours is reached.
This setting is optional. The modem router issues a warning when the balance falls below the number
of minutes that you enter. By default, the value is 0 and no warning message is issued.
12. Select one or more of the following actions to occur when the limit is reached:
•
•

Turn the Internet LED to flashing white/amber. This setting is optional. When the traffic limit is
reached, the Internet LED blinks alternating white and amber.
Disconnect and disable the Internet connection. This setting is optional. When the traffic limit is
reached, the Internet connection is disconnected and disabled.

13. Click the Apply button.
Your settings are saved and the modem router restarts.
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The Internet Traffic Statistics section helps you to monitor the data traffic. For more information, see
View the Internet Traffic Volume and Statistics on page 206.

Restrict Internet Traffic by Connection Time
You can record and restrict the traffic by connection time. This is useful when your ISP measures your
connection time.

To record and restrict the Internet traffic by time:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Traffic Meter.

5. Select the Enable Traffic Meter check box.
6. Select the Connection time control radio button.
Note The modem router must be connected to the Internet for you to be able to select the
Connection time control radio button.
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7. In the Monthly Limit field, enter how many hours per month are allowed.
Note The modem router must be connected to the Internet for you to be able to enter
information in the Monthly Limit field.

8. In the Traffic Counter section, set the traffic counter to begin at a specific time and date.
9. In the Traffic Control section, enter a value in minutes to specify when the modem router issues a warning
message before the monthly limit in hours is reached.
This setting is optional. The modem router issues a warning when the balance falls under the number
of minutes that you enter. By default, the value is 0 and no warning message is issued.
10. Select one or more of the following actions to occur when the limit is reached:
•
•

Turn the Internet LED to flashing white/amber. This setting is optional. When the traffic limit is
reached, the Internet LED alternates blinking white and amber.
Disconnect and disable the Internet connection. This setting is optional. When the traffic limit is
reached, the Internet connection is disconnected and disabled.

11. Click the Apply button.
Your settings are saved and the modem router restarts.
The Internet Traffic Statistics section helps you to monitor the data traffic. For more information, see
View the Internet Traffic Volume and Statistics on page 206.

Unblock the Traffic Meter After the Traffic Limit Is Reached
If you configured the traffic meter to disconnect and disable the Internet connection after the traffic limit is
reached, you cannot access the Internet until you unblock the traffic meter.

CAUTION:
If your ISP set a traffic limit, your ISP might charge you for the overage traffic.

To unblock the traffic meter:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Traffic Meter.
The Traffic Meter page displays.
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5. In the Traffic Control section, clear the Disconnect and disable the Internet connection check box.
6. Click the Apply button.
Your settings are saved and the modem router restarts.

Manage the Modem Router Remotely
The remote management feature lets you access your modem router securely over the Internet to view or
change its settings. You must know the modem router’s WAN IP address to use this feature.
For information about a different type of remote access, that is, remote access using Dynamic DNS, see
Access Storage Devices Through the Internet on page 147.
Note Be sure to change the password for the user name admin to a secure password. The
ideal password contains no dictionary words from any language and contains
uppercase and lowercase letters, numbers, and symbols. It can be up to 30 characters.
See Change the admin Password on page 187.

To set up remote management:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Remote Management.

5. Select the Turn Remote Management On check box.
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6. In the Allow Remote Access By section, specify the external IP addresses to be allowed to access the
modem router’s remote management.
Note For enhanced security, restrict access to as few external IP addresses as practical.
Select one of the following radio buttons and configure the options accordingly:
•
•
•

To allow access from a single IP address on the Internet, select the Only This Computer radio
button. Enter the IP address to be allowed access.
To allow access from a range of IP addresses on the Internet, select the IP Address Range radio
button. Enter a beginning and ending IP address to define the allowed range.
To allow access from any IP address on the Internet, select the Everyone radio button. This radio
button is selected by default.

7. Specify the port number for accessing the modem router’s web pages.
The default is 8443, which is a common alternate for HTTPS. For greater security, enter a custom port
number for accessing the modem router’s web pages remotely. Choose a number from 1024 to 65535,
but do not use the number of any common service port.
8. Click the Apply button.
Your settings are saved.
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This chapter describes how you can manage the advanced WiFi features of the modem router. For information
about the basic WiFi settings, see Manage the Basic WiFi Network Settings on page 85.
The chapter includes the following sections:
•

Set Up a WiFi Schedule on page 214

•

Manage the WPS Settings on page 215

•

Manage Advanced WiFi Settings on page 216

•

Manage Implicit Beamforming on page 218

•

Manage Airtime Fairness on page 218

•

Manage MU-MIMO on page 219

•

Set Up a WiFi Bridge Between the Modem Router and a WiFi Router or Access Point on page 219

•

Use the Modem Router as a WiFi Access Point Only on page 222

For information about setting up an access control list (ACL) and managing WiFi access for enhanced security,
see Manage Network Access Control Lists on page 108.
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Set Up a WiFi Schedule
You can use this feature to turn off the WiFi signal from your modem router at times when you do not need
a WiFi connection. For example, you might turn it off for the weekend if you leave town. You can set up a
separate WiFi schedule for each WiFi band.
Note You can set up a WiFi schedule only if the modem router is connected to the Internet
and synchronizes its internal clock with a time server on the Internet. For more
information about whether the modem router synchronizes its clock, see Set Up a
Schedule for Keyword Blocking and Outbound Firewall Rules on page 120.

To set up the WiFi schedule for a WiFi band:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Wireless Settings.
5. In the Wireless Settings section for the 2.4 GHz band or one of the 5 GHz bands, click the Add a new
period button.

6. Use the menus, radio buttons, and check boxes to set up a period during which you want to turn off the
WiFi signal and specify whether the schedule is recurrent.
7. Click the Apply button.
The Advanced Wireless Settings page displays.
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8. Select the Turn off wireless signal by schedule check box to activate the schedule.
9. Click the Apply button.
Your settings are saved.

Manage the WPS Settings
Wi-Fi Protected Setup (WPS) lets you join the WiFi network without typing the WiFi password. You can
change the WPS default settings.

To manage WPS settings:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Wireless Settings.
The Wireless Settings page displays.
5. Scroll down to the bottom of the page.

The Router’s PIN field displays the fixed PIN that you use to configure the modem router’s WiFi settings
from another platform through WPS.
6. To disable the PIN, clear the Enable Router’s PIN check box.
By default, the Enable Router’s PIN check box is selected and the modem router’s PIN is enabled. For
enhanced security, you can disable the modem router’s PIN by clearing the Enable Router’s PIN check
box. However, when you disable the modem router’s PIN, WPS is not disabled because you can still
use the physical WPS button.
Note The PIN function might temporarily be disabled automatically if the modem router
detects suspicious attempts to break into the modem router’s WiFi settings by using
the router’s PIN through WPS. You can configure the number of times a failed PIN
connection is allowed before the PIN function is disabled.
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7. To allow the WiFi settings to be changed automatically when you use WPS, clear one or more of the
Keep Existing Wireless Settings check boxes.
By default, all three Keep Existing Wireless Settings check boxes are selected. We recommend that
you leave these check boxes selected. If you clear a check box, the next time a new WiFi client uses
WPS to connect to the modem router, the modem router’s associated WiFi settings change to an
automatically generated random SSID and passphrase. For information about viewing this SSID and
passphrase, see View or Change the Basic WiFi Settings on page 86.
Clear a Keep Existing Wireless Settings check box only if you want to allow the WPS process to
change the associated SSID and passphrase for WiFi access.

WARNING:
If you clear a Keep Existing Wireless Settings check box and use WPS to add
a computer or mobile device to the modem router’s WiFi network, the
associated SSID and passphrase are automatically generated and other WiFi
devices that are already connected to the modem router’s WiFi network might
be disconnected.

8. Click the Apply button.
Your settings are saved.

Manage Advanced WiFi Settings
For most WiFi networks, the advanced WiFi settings work fine and you do not need to change the settings.
Tip If you want to change the WiFi settings of the modem router’s main network, use a wired
connection to avoid being disconnected when the new WiFi settings take effect.

To manage the advanced WiFi settings:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
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4. Select ADVANCED > Advanced Setup > Wireless Settings.

5. Enter the settings as described in the following table.
Except where indicated, the descriptions in the table apply to both the Advanced Wireless Settings
(2.4GHz b/g/n) section, Advanced Wireless Settings (5GHz-1 a/n/ac) section, and Advanced Wireless
Settings (5GHz-2 a/n/ac) section.
Field

Description

Enable 20/40 MHz
Coexistence

By default, 20/40 MHz coexistence is enabled to prevent interference between
WiFi networks in your environment at the expense of the WiFi speed. If no other
WiFi networks are present in your environment, you can clear the Enable 20/40
MHz Coexistence check box to increase the WiFi speed to the maximum supported
speed.
20/40 MHz coexistence applies to the 2.4 GHz band only.

Fragmentation Length
(256-2346)
CTS/RTS Threshold (1-2347)
Preamble Mode

The fragmentation length (the default is 2346), the CTS/RTS threshold (the default
is 2347), and the preamble mode (the default is Long Preamble) are reserved for
WiFi testing and advanced configuration only.
Do not change these settings unless directed by NETGEAR support or unless you
are sure what the consequences are. Incorrect settings might disable the WiFi
function of the modem router unexpectedly.

6. Click the Apply button.
Your settings are saved.
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Manage Implicit Beamforming
Implicit beamforming contrasts with explicit beamforming, which means the modem router actively tracks
clients and directs power to the modem router antenna closest to the client. Explicit beamforming works
whether or not the client supports beamforming. Implicit beamforming means that the modem router can
use information from client devices that support beamforming to improve the WiFi speed, reliability, and
range. This feature is enabled by default, but you can disable it.

To disable implicit beamforming:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Wireless Settings.
The Wireless Settings page displays.
5. Scroll to the bottom of the page and clear the Enable Implicit BEAMFORMING check box.
6. Click the Apply button.
Your settings are saved.
If you connected over WiFi to the network, you are disconnected from the network and must reconnect.

Manage Airtime Fairness
Airtime fairness ensures that all clients receive equal time on the network. Network resources are divided
by time, so if five clients are connected, they each get one-fifth of the network time. The advantage of this
feature is that your slowest clients do not control network responsiveness. This feature is enabled by default,
but you can disable it.

To disable airtime fairness:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Wireless Settings.
The Wireless Settings page displays.
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5. Scroll to the bottom of the page and clear the Enable AIRTIME FAIRNESS check box.
6. Click the Apply button.
Your settings are saved.
If you connected over WiFi to the network, you are disconnected from the network and must reconnect.

Manage MU-MIMO
Multi-user multiple-input and multiple-output (MU-MIMO) improves performance when multiple
MU-MIMO-capable WiFi clients transfer data at the same time. WiFi clients must support MU-MIMO, and
they must be connected to a 5 GHz WiFi band. This feature is enabled by default, but you can disable it.

To disable MU-MIMO:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Wireless Settings.
The Wireless Settings page displays.
5. Scroll to the bottom of the page and clear the Enable MU-MIMO check box.
6. Click the Apply button.
Your settings are saved.
If you connected over WiFi to the network, you are disconnected from the network and must reconnect.

Set Up a WiFi Bridge Between the Modem Router and a
WiFi Router or Access Point
You can use the modem router as a WiFi bridge and connect multiple devices with WiFi, for example, at
the faster 802.11ac speed. To do this, you need a WiFi router or access point (AP) in addition to the modem
router: One device is connected to the Internet over a DSL or cable modem and the other one functions as
a WiFi bridge.You can connect the modem router to the Internet modem and use the router or AP as a WiFi
bridge (assuming that the router or AP is capable of functioning as a WiFi bridge), or the other way
around—connect the router or AP to the Internet modem, and use the modem router as a WiFi bridge. Of
course, you can also use two D8500 modem routers for such a setup.
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Figure 20. WiFi Bridge mode setup with two D8500 modem routers
Setting up a WiFi bridge with two modem routers offers the following benefits:
•

You can take advantage of gigabit WiFi speeds on current devices.

•

Use gigabit WiFi for applications such as video and gaming.

•

Connect multiple devices such as a NAS, Smart TV, NeoTV, Blu-ray player, and game consoles at
gigabit WiFi speeds using a WiFi link.

•

Avoid the need for separate WiFi adapters for each device.

For example, you could install the first modem router in a room such as a home office where your Internet
connection is located.
Then set up the second modem router as a WiFi bridge and place it in a different room such as the room
where your home entertainment center is located. Cable the modem router that functions as a WiFi bridge
to your Smart TV, DVR, game console, or Blu-ray player, and use its 802.11ac WiFi connection to the first
modem router.
The modem router that is connected to the Internet modem does not require any special setup because the
modem router that functions as a WiFi bridge connects to an existing SSID as a WiFi client, just like any
other WiFi clients.

To set up a modem router as a WiFi bridge:
1. Make a note of the WiFi settings of the other modem router that is connected to the Internet modem.
You must know the SSID, WiFi security mode, WiFi password, and operating frequency (either 2.4 GHz
or 5 GHz).
2. Launch a web browser from a computer or mobile device that is connected to the network of the modem
router that you are setting up as a WiFi bridge.
3. Enter http://www.routerlogin.net.
A login window opens.
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4. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Wireless Settings.
The Wireless Settings page displays.
6. Scroll to the very bottom and select the use other operation mode check box.
7. Select the Enable Bridge mode radio button.

8. Click the setup bridge mode wireless settings button.

9. To change the name of the modem router, enter a new name in the Device Name field.
By default, the device name is D8500. If you set up the modem router as a WiFi bridge and you want
to distinguish it from the name of the modem router that is connected to the Internet modem, you could,
for example, change the name to D8500 bridge.
10. Enter the WiFi settings of the modem router that is connected to the Internet modem (that is, the other
modem router):
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a. From the Choose a Wireless Network menu, select the WiFi band that the other modem router is
using.
For 802.11ac mode, both modem routers must use the same 5 GHz band.
b. In the Name (SSID) field, enter the WiFi network name (SSID) that the other modem router is using.
In the previous figure, the SSID name NETGEAR32 is just an example.
c. In the Security Options section, select the radio button for the WiFi security that the other modem
router is using.
d. If prompted, type the passphrase (the WiFi password that you must use to connect with WiFi to the
other modem router).
11. Click the Apply button.
Your settings are saved.
12. To let the modem router that functions as the WiFi bridge get an IP address dynamically from the modem
router that is connected to the Internet modem, leave the Get dynamically from existing router radio
button selected.
We recommend that you leave the Get dynamically from existing router radio button selected.
However, if you are sure that you must use a static IP address, you can specify a static IP address from
your other modem router LAN IP address pool. To specify static IP address for the modem router that
functions as the WiFi bridge, do the following:
a. Select the Use fixed IP Address (not recommended) radio button.
A pop-up window opens.
b. Enter all static IP addresses.
13. Click the Apply button.
Your settings are saved. The modem router restarts with a new IP address.
14. To reconnect, close your browser, relaunch it, and log in to the modem router by entering
http://www.routerlogin.net.
When the modem router functions as a WiFi bridge, you cannot change its WiFi settings, that is, the
settings on the Wireless Settings page (BASIC > Wireless) are masked out. However, if you want to
reverse the configuration, you can disable the WiFi bridge option on the advanced Wireless Settings
page (ADVANCED > Advanced Setup > Wireless Settings).

Use the Modem Router as a WiFi Access Point Only
By default, the modem router functions as both a router and a WiFi access point (AP). You can set up the
modem router to function in AP mode and let it operate in the same local network as another router. When
the modem router functions in AP mode, many router-related features are disabled.
Tip If you want to change the modem router’s function, use a wired connection to avoid being
disconnected when the new function takes effect.
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To change the modem router to AP mode:
1. Use an Ethernet cable to connect the yellow Internet port on the rear panel of the modem router to a
LAN port on the other router.
2. Launch a web browser from a computer or mobile device that is connected to the network.
3. Enter http://www.routerlogin.net.
A login window opens.
4. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Wireless AP.
The Wireless Access Point page displays.
6. Select the Enable AP Mode check box.

7. Scroll down and select the radio button for the IP address setting that you want to use:
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•
•

Get dynamically from existing router. The other router on the network assigns an IP address to
the modem router while the modem router functions in access point mode. This is the default setting.
Enable fixed IP settings on this device (not recommended). Use this setting if you want to
manually assign a specific IP address to the modem router while it functions in access point mode.
Using this option effectively requires advanced network experience.
Note To avoid interference with other routers or gateways on your network, we recommend
that you use different WiFi settings on each router. You can also turn off the WiFi
radio on the other router or gateway and use the modem router only for WiFi client
access.

8. Click the Apply button.
The IP address of the modem router changes, and you are disconnected.
9. To reconnect, close and restart your web browser and enter http://www.routerlogin.net.
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15

You can use OpenVPN software to remotely access your modem router using virtual private networking (VPN).
This chapter explains how to set up and use VPN access.
The chapter includes the following sections:
•

Set Up a VPN Connection on page 226

•

Use a VPN Tunnel on a Windows Computer on page 230

•

Use VPN to Access the Modem Router’s USB Device and Media From a Windows Computer on page 232

•

Use VPN to Access Your Internet Service at Home on page 232
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Set Up a VPN Connection
A virtual private network (VPN) lets you use the Internet to securely access your network when you aren’t
home.

Figure 21. VPN provides a secure tunnel between your home network and a remote computer
This type of VPN access is called a client-to-gateway tunnel. The computer is the client, and the modem
router is the gateway. To use the VPN feature, you must log in to the modem router and enable VPN, and
you must install and run VPN client software on the computer.
Note The modem router currently does not support iOS or Android VPN client software.
VPN uses DDNS or a static IP address to connect with your modem router.
To use a DDNS service, register for an account with a host name (sometimes called a domain name). You
use the host name to access your network. The modem router supports these accounts: NETGEAR, No-IP,
and Dyn.
If your Internet service provider (ISP) assigned a static WAN IP address (such as 50.196.x.x or 10.x.x.x)
that never changes to your Internet account, the VPN can use that IP address to connect to your home
network.

Specify VPN Service in the Modem Router
You must specify the VPN service settings in the modem router before you can use a VPN connection.

To specify the VPN service:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > VPN Service.
The VPN Service page displays.
5. Select the Enable VPN Service check box.
By default, the VPN uses the UDP service type and uses port 12974. If you want to customize the service
type and port, we recommend that you change these settings before you install the OpenVPN software.
6. To change the service type, scroll down and select the TCP radio button.
7. To change the port, scroll down to the Service Port field, and type the port number that you want to
use.
Note For information about configuring the type of access, see Use VPN to Access Your
Internet Service at Home on page 232.

8. Click the Apply button.
Your settings are saved. VPN is enabled in the modem router, but you must install and set up OpenVPN
software on your computer before you can use a VPN connection (see Install OpenVPN Software on a
Windows Computer on page 227 and Install OpenVPN Software on a Mac Computer on page 229).

Install OpenVPN Software on a Windows Computer
You must install OpenVPN software on each computer that you plan to use for VPN connections to your
modem router.

To install VPN client software on a Windows computer:
1. Launch a web browser from a computer or mobile device device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > VPN Service.
The VPN Service page displays.
5. Make sure that the Enable VPN Service check box is selected.
For more information, see Specify VPN Service in the Modem Router on page 226.
6. Click the For Windows button to download the OpenVPN configuration files.
Step 17 provides information about what to do with the downloaded OpenVPN configuration files.
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7. To download the OpenVPN client utility, visit openvpn.net/index.php/download/community-downloads.html.
8. In the Windows Installer section of the page, double-click the openVPN-install-xxx.exe link.
9. Download the file.
10. To install the OpenVPN client utility on your computer, click the openVPN-install-xxx.exe file.

11. Click the Next button.
12. Read the License Agreement and click the I Agree button.

13. Leave the check boxes selected as shown in the previous figure, and click the Next button.
14. To specify the destination folder, click the Browse button, select a destination folder, and click the Next
button.

15. Click the Install button.
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The window displays the progress of the installation and then displays the final installation window.

16. Click the Finish button.
17. Unzip the configuration files that you downloaded in Step 6 and copy them to the folder in which the
OpenVPN client utility is installed on your computer.
If your device is a Windows 64-bit system, the OpenVPN client utility is installed by default in the
C:\Program files\OpenVPN\config\ folder.
18. Modify the VPN interface name to NETGEAR-VPN:
a. In Windows, select Start > Control Panel > Network and Internet > Network Connections (or
Network and Sharing Center).
The network information displays.
b. In the local area connection list, find the local area connection with the device name TAP-Windows
Adapter.
c. Select the local area connection and change its name (not its device name) to NETGEAR-VPN.
If you do not change the VPN interface name, the VPN tunnel connection will fail.
For more information about using OpenVPN on a Windows computer, visit
openvpn.net/index.php/open-source/documentation/howto.html#quick.

Install OpenVPN Software on a Mac Computer
You must install Open VPN software on each computer that you plan to use for VPN connections to your
modem router.

To install VPN client software on a Mac computer:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > VPN Service.
The VPN Service page displays.
5. Make sure that the Enable VPN Service check box is selected.
For more information, see Specify VPN Service in the Modem Router on page 226.
6. Click the For non-Windows button to download the OpenVPN configuration files.
Step 9 provides information about what to do with the downloaded OpenVPN configuration files.
7. To download the OpenVPN client utility for Mac OS X, visit https://tunnelblick.net/.
8. Download and install the file.
9. Unzip the configuration files that you downloaded in Step 6 and copy them to the folder in which the
OpenVPN client utility is installed on your computer.
The client utility must be installed by a user with administrative privileges.
For more information about using OpenVPN on a Mac computer, visit
openvpn.net/index.php/access-server/docs/admin-guides/183-how-to-connect-to-access-server-from-a-mac.html.

Use a VPN Tunnel on a Windows Computer
After you set up the modem router to use VPN and install the OpenVPN application on your computer, you
can open a VPN tunnel from your computer to your modem router over the Internet.
For the VPN tunnel to work, the local LAN IP address of the remote router must use a different LAN IP
scheme from that of the local LAN where your VPN client computer is connected. If both networks use the
same LAN IP scheme, when the VPN tunnel is established, you cannot access your home router or your
home network with the OpenVPN software.
The default LAN IP address scheme for the modem router is 192.x.x.x. The most common IP schemes are
192.x.x.x, 172.x.x.x, and 10.x.x.x. If you experience a conflict, change the IP scheme either for your home
network or for the network with the client VPN computer. For information about changing these settings,
see Manage the Modem Routers’s LAN IP Address Settings on page 172.
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To open a VPN tunnel:
1. Launch the OpenVPN application with administrator privileges.

The OpenVPN icon displays in the Windows taskbar.
Tip You can create a shortcut to the VPN program, then use the shortcut to access the settings
and select the run as administrator check box. Then every time you use this shortcut,
OpenVPN automatically runs with administrator privileges.

2. Right-click the OpenVPN icon.

3. Select Connect.
The VPN connection is established. You can do the following:
•

Launch a web browser and log in to your modem router.

•

Use Windows file manager to access the modem router’s USB device and download files.
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Use VPN to Access the Modem Router’s USB Device and
Media From a Windows Computer
To access a USB device and download files:
1. In Windows file manager, select the Network folder.

The network resources display. The ReadySHARE icon is in the Computer section and the remote
ReadyDLNA: D8500 icon is in the Media Devices section (if DLNA is enabled in the modem router).
2. If the icons do not display, click the Refresh button to update the page.
If the local LAN and the remote LAN are using the same IP scheme, the remote icon does not display
in the Media Devices section and the D8500 (Gateway) icon does not display in the Network Infrastructure
section.
3. To access the USB device, click the ReadySHARE icon.
4. To access media on the modem router’s network, click the ReadyDLNA: D8500 icon.

Use VPN to Access Your Internet Service at Home
When you are away from home and you access the Internet, you usually use a local Internet service provider.
For example, at a coffee shop you might be given a code that lets you use the coffee shop’s Internet service
account to surf the web.
The modem router lets you use a VPN connection to access your own Internet service when you are away
from home. You might want to do this if you travel to a geographic location that does not support all the
Internet services that you use at home. For example, your Netflix account might work at home but not in a
different country.

Set Up VPN Client Internet Access in the Modem Router
By default, the modem router is set up to allow VPN connections only to your home network, but you can
change the settings to allow Internet access. Accessing the Internet remotely through a VPN might be slower
than accessing the Internet directly.

Use VPN to Access Your Network
232

AC5300 WiFi VDSL/ADSL Modem Router Model D8500

To allow VPN clients to use your home Internet service:
1. Launch a web browser from a computer or mobile device device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > VPN Service.
The VPN page displays.
5. Select the Enable VPN Service radio button.
6. Scroll down to the Clients will use this VPN connection to access section, and select the All sites on
the Internet & Home Network radio button.
When you access the Internet with the VPN connection, instead of using a local Internet service, you
use the Internet service from your home network.
Note By default, the Auto radio button is selected, which lets the modem router use an
automatic detection system that enables VPN access only for necessary services
and sites and might not include full Internet access.

7. Click the Apply button.
Your settings are saved.
8. Click the For Windows or For non-Windows button and download the configuration files for your VPN
clients.
9. Unzip the configuration files and copy them to the folder where the VPN client is installed on your device.
For a client device with Windows 64-bit system, the VPN client is installed at C:\Program
files\OpenVPN\config\ by default.

Block VPN Client Internet Access in the Modem Router
By default, the modem router is set up to allow VPN connections only to your home network, not to the
Internet service for your home network. If you changed this setting to allow Internet access, you can change
it back.

To allow VPN clients to access only your home network:
1. Launch a web browser from a computer or mobile device device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
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The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > VPN Service.
The VNP page displays.
5. Select the Enable VPN Service radio button.
6. Scroll down to the Clients will use this VPN connection to access section, and select the Home Network
only radio button.
7. Click the Apply button.
Your settings are saved.

Use a VPN Tunnel to Access Your Internet Service at Home
To access your Internet service:
1. Set up the modem router to allow VPN access to your Internet service.
See Set Up VPN Client Internet Access in the Modem Router on page 232.
2. On your computer, launch the OpenVPN application.
The OpenVPN icon displays in the Windows taskbar.
3. Right-click the icon and select Connect.
4. When the VPN connection is established, launch your web browser.
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Triggering

16

You can use port forwarding and port triggering to set up rules for Internet traffic for services and applications.
You need networking knowledge to set up these features.
This chapter includes the following sections:
•

Manage Port Forwarding to a Local Server for Services and Applications on page 236

•

Manage Port Triggering for Services and Applications on page 241
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Manage Port Forwarding to a Local Server for Services
and Applications
If a server is part of your network, you can allow certain types of incoming traffic to reach the server. For
example, you might want to make a local web server, FTP server, or game server visible and available to
the Internet.
The modem router can forward incoming traffic with specific protocols to computers on your local network.
You can specify the servers for applications and you can also specify a default DMZ server to which the
modem router forwards all other incoming protocols (see Set Up a Default DMZ Server on page 170).

Forward Incoming Traffic for a Default Service or Application
You can forward traffic for a default service or application to a computer on your network.

To forward incoming traffic for a default service or application:
1. Decide which type of service, application, or game you want to provide.
2. Find the local IP address of the computer on your network that will provide the service.
The server computer must always receive the same IP address. To specify this setting, use the reserved
IP address feature. See Manage Reserved LAN IP Addresses on page 174.
3. Launch a web browser from a computer or mobile device device that is connected to the network.
4. Enter http://www.routerlogin.net.
A login window opens.
5. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
6. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.

7. Make sure that the Port Forwarding radio button is selected.
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8. From the Service Name menu, select the service or application.
If the service or application that you want to add is not in the list, create a port forwarding rule with a
custom service or application (see Add a Port Forwarding Rule With a Custom Service or Application
on page 237).
9. In the Server IP Address field, enter the IP address of the computer that must provide the service or
that runs the application.
10. Click the Add button.
Your settings are saved and the rule is added to the table.

Add a Port Forwarding Rule With a Custom Service or
Application
The modem router lists default services and applications that you can use in port forwarding rules. If the
service or application is not predefined, you can add a port forwarding rule with a custom service or application.

To add a port forwarding rule with a custom service or application:
1. Find out which port number or range of numbers the service or application uses.
You can usually find this information by contacting the publisher of the service or application or through
user groups or news groups.
2. Launch a web browser from a computer or mobile device device that is connected to the network.
3. Enter http://www.routerlogin.net.
A login window opens.
4. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering page displays.
6. Make sure that the Port Forwarding radio button is selected.
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7. Click the Add Custom Service button.

8. Specify a new port forwarding rule with a custom service or application as described in the following
table.
Field

Description

Service Name

Enter the name of the custom service or application.

Service Type

Select the protocol (TCP or UDP) that is associated with the service or application.
If you are unsure, select TCP/UDP.

External Starting Port Enter the starting port number for the service or application.
External Ending Port If the service or application uses a single port, enter the same port number in the
External Ending Port field.
If the service or application uses a range of ports, enter the ending port number of the
range in the External Ending Port field.
Internal Starting Port Specify the internal ports by one of these methods:
Internal Ending Port

Internal IP address

•

If the external and internal ports are the same, leave the Use the same port range
for Internal port check box selected.

•

If the external and internal ports are different, in the Internal Starting Port field,
enter the starting port number for the service or application. The Internal Ending
Port field is populated automatically.

Either enter an IP address in the Internal IP address field or select the radio button
for an attached device that is listed in the table.
The modem router applies the new rule to the device that you select.

9. Click the Apply button.
Your settings are saved. The rule is added to the table on the Port Forwarding / Port Triggering page.
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Change a Port Forwarding Rule
You can change an existing port forwarding rule.

To change a port forwarding rule:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.

The previous figure shows two custom port forwarding rules.
5. Make sure that the Port Forwarding radio button is selected.
6. In the table, select the radio button for the service or application name.
7. Click the Edit Service button.
The Ports - Custom Services page displays.
8. Change the settings.
For information about the settings, see Add a Port Forwarding Rule With a Custom Service or Application
on page 237.
9. Click the Apply button.
Your settings are saved. The changed rule displays in the table on the Port Forwarding / Port Triggering
page.
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Remove a Port Forwarding Rule
You can remove a port forwarding rule that you no longer need.

To remove a port forwarding rule:
1. Launch a web browser from a computer or mobile that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.

The previous figure shows two custom port forwarding rules.
5. Make sure that the Port Forwarding radio button is selected.
6. In the table, select the radio button for the service or application name.
7. Click the Delete Service button.
The rule is removed from the table.

Application Example: Make a Local Web Server Public
If you host a web server on your local network, you can use port forwarding to allow web requests from
anyone on the Internet to reach your web server.
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To make a local web server public:
1. Assign your web server either a fixed IP address or a dynamic IP address using DHCP address
reservation.
In this example, your modem router always gives your web server an IP address of 192.168.0.33.
2. On the Port Forwarding / Port Triggering page, configure the modem router to forward the HTTP service
to the local address of your web server at 192.168.0.33.
HTTP (port 80) is the standard protocol for web servers.
3. (Optional) Register a host name with a Dynamic DNS service, and specify that name on the Dynamic
DNS page of the modem router.
Dynamic DNS makes it much easier to access a server from the Internet because you can enter the
name in the web browser. Otherwise, you must know the IP address that the ISP assigned, which
typically changes.

How the Modem Router Implements the Port Forwarding Rule
The following sequence shows the effects of a port forwarding rule:
1. When you enter the URL www.example.com in your browser, the browser sends a web page request
message with the following destination information:
•

Destination address. The IP address of www.example.com, which is the address of your modem
router.

•

Destination port number. 80, which is the standard port number for a web server process.

2. The modem router receives the message and finds your port forwarding rule for incoming port 80 traffic.
3. The modem router changes the destination IP address in the message to 192.168.0.123 and sends the
message to that computer.
4. Your web server at IP address 192.168.0.123 receives the request and sends a reply message to your
modem router.
5. Your modem router performs Network Address Translation (NAT) on the source IP address and sends
the reply through the Internet to the computer or mobile device device that sent the web page request.

Manage Port Triggering for Services and Applications
Port triggering is a dynamic extension of port forwarding that is useful in these cases:
•

An application must use port forwarding to more than one local computer (but not simultaneously).

•

An application must open incoming ports that are different from the outgoing port.

With port triggering, the modem router monitors traffic to the Internet from an outbound “trigger” port that
you specify. For outbound traffic from that port, the modem router saves the IP address of the computer
that sent the traffic. The modem router temporarily opens the incoming port or ports that you specify in your
rule and forwards that incoming traffic to that destination.
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Port forwarding creates a static mapping of a port number or range of ports to a single local computer. Port
triggering can dynamically open ports to any computer when needed and close the ports when they are no
longer needed.
Note If you use applications such as multiplayer gaming, peer-to-peer connections, real-time
communications such as instant messaging, or remote assistance, enable Universal
Plug-N-Play (UPnP). See Improve Network Connections With Universal Plug-N-Play on
page 128.

Add a Port Triggering Rule
The modem router does not provide default services and applications for port triggering rules. You must
define a custom service or application for each port triggering rule.

To add a port triggering rule:
1. Launch a web browser from a computer or mobile device device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering page displays.
5. Select the Port Triggering radio button.
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6. Click the Add Service button.

7. Specify a new port triggering rule with a custom service or application as described in the following
table.
Field

Description

Service
Service Name

Enter the name of the custom service or application.

Service User

From the Service User menu, select Any, or select Single address and enter the IP
address of one computer:
•

Any. This is the default setting and allows any computer on the Internet to use
this service.

•

Single address. Restricts the service to a particular computer.

Service Type

Select the protocol (TCP or UDP) that is associated with the service or application.

Triggering Port

Enter the number of the outbound traffic port that must open the inbound ports.

Inbound Connection
Connection Type

Select the protocol (TCP or UDP) that is associated with the inbound connection.
If you are unsure, select TCP/UDP.

Starting Port

Enter the start port number for the inbound connection.

Ending Port

Enter the end port number for the inbound connection.

8. Click the Apply button.
Your settings are saved and the rule is added to the Port Triggering Portmap Table on the Port Forwarding
/ Port Triggering page.
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Change a Port Triggering Rule
You can change an existing port triggering rule.

To change a port triggering rule:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering page displays.
5. Select the Port Triggering radio button.

The previous figure shows two port triggering rules.
6. In the Port Triggering Portmap Table, select the radio button for the service or application name.
7. Click the Edit Service button.
The Port Triggering - Services page displays.
8. Change the settings.
For information about the settings, see Add a Port Triggering Rule on page 242.
9. Click the Apply button.
Your settings are saved. The changed rule displays in the Port Triggering Portmap Table on the Port
Forwarding / Port Triggering page.
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Remove a Port Triggering Rule
You can remove a port triggering rule that you no longer need.

To remove a port triggering rule:
1. Launch a web browser from a computer or mobile that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering page displays.
5. Select the Port Triggering radio button.

The previous figure shows two port triggering rules.
6. In the Port Triggering Portmap Table, select the radio button for the service or application name.
7. Click the Delete Service button.
The rule is removed from the Port Triggering Portmap Table.

Specify the Time-Out for Port Triggering
The time-out period for port triggering controls how long the inbound ports stay open when the modem router
detects no activity. A time-out period is required because the modem router cannot detect when the service
or application terminates.
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To specify the time-out for port triggering:
1. Launch a web browser from a computer or mobile device device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering page displays.
5. Select the Port Triggering radio button.
The port triggering settings display.
6. In the Port Triggering Time-out field, enter a value up to 9999 minutes.
The default setting is 20 minutes.
7. Click the Apply button.
Your settings are saved.

Disable Port Triggering
By default, port triggering is enabled. You can disable port triggering temporarily without removing any port
triggering rules.

To disable port triggering:
1. Launch a web browser from a computer or mobile device device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering page displays.
5. Select the Port Triggering radio button.
The port triggering settings display.
6. Select the Disable Port Triggering check box.

Manage Port Forwarding and Port Triggering
246

AC5300 WiFi VDSL/ADSL Modem Router Model D8500

If this check box is selected, the modem router does not apply port triggering rules even if you specified
them.
7. Click the Apply button.
Your settings are saved.

Application Example: Port Triggering for Internet Relay Chat
Some application servers, such as FTP and IRC servers, send replies to multiple port numbers. Using port
triggering, you can tell the modem router to open more incoming ports when a particular outgoing port starts
a session.
An example is Internet Relay Chat (IRC).Your computer connects to an IRC server at destination port 6667.
The IRC server not only responds to your originating source port but also sends an “identify” message to
your computer on port 113. Using port triggering, you can tell the modem router, “When you initiate a session
with destination port 6667, you must also allow incoming traffic on port 113 to reach the originating computer.”
The following sequence shows the effects of this port triggering rule:
1. You open an IRC client program to start a chat session on your computer.
2. Your IRC client composes a request message to an IRC server using a destination port number of 6667,
the standard port number for an IRC server process. Your computer then sends this request message
to your modem router.
3. Your modem router creates an entry in its internal session table describing this communication session
between your computer and the IRC server.Your modem router stores the original information, performs
Network Address Translation (NAT) on the source address and port, and sends this request message
through the Internet to the IRC server.
4. Noting your port triggering rule and observing the destination port number of 6667, your modem router
creates another session entry to send any incoming port 113 traffic to your computer.
5. The IRC server sends a return message to your modem router using the NAT-assigned source port (for
example, port 33333) as the destination port and also sends an “identify” message to your modem router
with destination port 113.
6. When your modem router receives the incoming message to destination port 33333, it checks its session
table to see if a session is active for port number 33333. Finding an active session, the modem router
restores the original address information replaced by NAT and sends this reply message to your computer.
7. When your modem router receives the incoming message to destination port 113, it checks its session
table and finds an active session for port 113 associated with your computer. The modem router replaces
the message’s destination IP address with your computer’s IP address and forwards the message to
your computer.
8. When you finish your chat session, your modem router eventually senses a period of inactivity in the
communications. The modem router then removes the session information from its session table, and
incoming traffic is no longer accepted on port numbers 33333 or 113.
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This chapter provides information to help you diagnose and solve problems you might experience with your
modem router. If you do not find the solution here, check the NETGEAR support site at netgear.com/support
for product and contact information.
The chapter contains the following sections:
•

Reboot the Modem Router From Its Web Page on page 249

•

Quick Tips for Troubleshooting on page 249

•

Troubleshoot With the LEDs on page 250

•

You Cannot Log In to the Modem Router on page 252

•

Troubleshoot the Internet Connection on page 253

•

Changes Are Not Saved on page 256

•

Troubleshoot the WiFi Connectivity on page 256

•

Troubleshoot Your Network Using the Ping Utility on page 257
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Reboot the Modem Router From Its Web Page
You or NETGEAR technical support can reboot the modem router from its web page, either locally or
remotely, for example, when the modem router seems to be unstable or is not operating normally.

To reboot the modem router from its web page:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Click the ADVANCED tab.
The ADVANCED Home page displays.
5. In the Router Information pane, click the Reboot button.
A confirmation pop-up window displays.
6. Click the OK button.
The modem router reboots.

Quick Tips for Troubleshooting
If your network is unresponsive or does not function normally, try the following:
Restart your network:
1. If you use a cable modem, turn off and unplug the cable modem.
2. Turn off the modem router.
3. If you use a cable modem, plug in the cable modem, turn it on, and wait two minutes.
4. Turn on the modem router and wait two minutes.
If network problems still occur, make sure that your ISP does not require you to use the MAC address
of the computer that was used to initially register the ISP account. If your ISP does require that you do
this, you must change the modem router MAC address that the modem router uses. For more information,
see one of the following sections:
•

Manually Set Up an ADSL Internet Connection on page 36

•

Manually Set Up a VDSL Internet Connection on page 44

•

Manually Set Up a Cable Internet Connection on page 51

If you cannot connect over an Ethernet cable to the modem router, try the following:
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•

Make sure that the Ethernet cables are securely plugged in.

•

Make sure that your computer or device does not use a static IP address but is configured to receive
an IP address automatically with DHCP. (For most devices, DHCP is the default setting.)

If you cannot connect over WiFi to the modem router, try the following:
•

Make sure that the WiFi settings in your WiFi device and modem router match exactly.
For a device that is connected over WiFi, the WiFi network name (SSID) and WiFi security settings of
the modem router and WiFi computer must match exactly. The default SSID and password are on the
modem router label (see Product Label on page 14).

•

Make sure that your WiFi device supports the security that you are using for your WiFi network (WEP,
WPA, or WPA2). For information about WiFi security settings, see Manage the Basic WiFi Settings and
WiFi Security of the Main Network on page 86.

•

Make sure that the modem router is not too far from your WiFi device or too close. Move your WiFi
device near the modem router but at least 6 feet (1.8 meters) away and see if the signal strength
improves.

•

Make sure that the WiFi signal is not blocked by objects between the modem router and your WiFi
device.

•

Make sure that the WiFi LED on the modem router is not off.
If this LED is off, both WiFi radios might be disabled. For more information about the WiFi radios, see
Control the WiFi Radios on page 102.

•

Make sure that the modem router’s SSID broadcast is not disabled.
If the modem router’s SSID broadcast is disabled, the WiFi network name is hidden and does not display
in your WiFi device’s scanning list. To connect to a hidden network, you must enter the network name
and the WiFi password. For more information about the SSID broadcast, see Manage the Basic WiFi
Settings and WiFi Security of the Main Network on page 86.

•

Make sure that your WiFi device does not use a static IP address but is configured to receive an IP
address automatically with DHCP. (For most devices, DHCP is the default setting.)

Troubleshoot With the LEDs
When you turn on the power, the LEDs light as described here:
1. The Power LED
lights solid amber for about two minutes and then turns solid white, indicating that
the startup procedure is complete and the modem router is ready.
2. When the Power LED lights solid white, verify the following:
•

The DSL/Internet LED

•

All WiFi LEDs

•

A USB port LED

•

An Ethernet port LED
connected Ethernet device.

is solid white.
are solid white (unless the WiFi radios are turned off).
is solid white for a connected USB device.
is solid white or solid amber for a
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•

The LED on the WIFI button is solid blue (unless the WiFi radios are turned off).

•

The LED on the WPS button is solid blue (unless the WiFi radios are turned off).

You can use the LEDs for troubleshooting. For more information, see the following sections:
•

Power LED Is Off on page 251

•

Power LED Remains Solid Amber or Blinks White on page 251

•

2.4 GHz, 5 GHz 1, and 5 GHz 2 WiFi LEDs Are Off on page 251

•

Troubleshoot the DSL/Internet Link on page 253

Power LED Is Off
The Power LED

could remain off for a number of reasons. Check the following:

•

Make sure that the Power On/Off button on the back is in the on position, that is, it is pushed in.

•

Make sure that the power adapter is securely connected to your modem router and securely connected
to a working power outlet.

•

Make sure that you are using the power adapter that NETGEAR supplied for this product.

If the error persists, a hardware problem might exist. For help with a hardware problem, contact technical
support at netgear.com/support.

Power LED Remains Solid Amber or Blinks White
The Power LED
lights solid amber for about two minutes and then turns solid white, indicating that the
startup procedure is complete and the modem router is ready. If the Power LED remains solid amber and
does not turn solid white, a failure occurred or the modem router is malfunctioning.
If the Power LED blinks white slowly and continuously, the modem router firmware is corrupted. This can
happen if a firmware upgrade is interrupted, or if the modem router detects a problem with the firmware.
If the Power LED does not turn solid white, do the following:
1. Turn the power off and back on and wait several minutes to see if the modem router recovers.
2. If the modem router does not recover, press and hold the Reset button to return the modem router to
its factory settings.
If the error persists, a hardware problem might exist. For recovery instructions or help with a hardware
problem, contact technical support at netgear.com/support.

2.4 GHz, 5 GHz 1, and 5 GHz 2 WiFi LEDs Are Off
By default, the WiFi radios are enabled and the WiFi LEDs light solid white. If these LEDs stay off, check
to see if someone pressed the WIFI button on the front of the modem router. This button turns the WiFi
radios in the modem router on and off. These LEDs are lit when the WiFi radios are turned on.
For more information, see Control the WiFi Radios on page 102 and Set Up a WiFi Schedule on page 214.
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An Ethernet Port LED Is Off
If an Ethernet port LED does not light when an Ethernet connection is made, check the following:
•

Make sure that the Ethernet cable connections are secure at the modem router and at the modem or
computer.

•

Make sure that power is turned on to the connected modem or computer.

•

Be sure that you are using the correct cable.

When connecting the modem router’s VDSL port to a DSL modem or the Internet port to a cable modem,
use the cable that was supplied with the DSL or cable modem.

You Cannot Log In to the Modem Router
If you are unable to log in to the modem router from a computer on your local network and use the modem
router web pages, check the following:
•

If you are using an Ethernet-connected computer, check the Ethernet connection between the computer
and the modem router.

•

Make sure that the IP address of your computer is on the same subnet as the modem router. If you are
using the recommended addressing scheme, your computer’s address is in the range of 192.168.0.2
to 192.168.0.254.

•

Make sure that your computer can reach the modem router’s DHCP server. Recent versions of Windows
and Mac OS generate and assign an IP address if the computer cannot reach a DHCP server. These
autogenerated addresses are in the range of 169.254.x.x. If your IP address is in this range, check the
connection from the computer to the modem router and reboot your computer.

•

If your modem router’s IP address was changed and you do not know the current IP address, use an
IP scanner application to detect the IP address. If you still cannot find the IP address, clear the modem
router’s configuration to factory defaults. This sets the modem router’s IP address to 192.168.0.1. For
more information, see Return the Modem Router to Its Factory Default Settings on page 189 and Factory
Settings on page 260.

•

Make sure that Java, JavaScript, or ActiveX is enabled in your browser. If you are using Internet Explorer,
click the Refresh button to be sure that the Java applet is loaded.

•

Try quitting the browser and launching it again.

•

Make sure that you are using the correct login information. The user name is admin, and the default
password is password. Make sure that Caps Lock is off when you enter this information.

•

If you are attempting to set up your modem router behind an existing router in your network, set up the
modem router as a WiFi access point (see Use the Modem Router as a WiFi Access Point Only on page
222.
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Troubleshoot the Internet Connection
If your modem router cannot access the Internet, check the DSL connection, then the WAN TCP/IP connection.

Troubleshoot the DSL/Internet Link
If your modem router is unable to access the Internet, first determine if the DSL or cable link with the service
provider is working. The DSL/Internet LED indicates the state of this connection.

DSL/Internet LED Is Solid White
If the DSL/Internet LED
lights solid white, the DSL or cable connection is good. You can be confident
that the service provider connected your line correctly and that your wiring is correct.

DSL/Internet LED Is Solid Amber
For a DSL connection, if the DSL/Internet LED
is solid amber and does not turn solid white, disconnect
all telephones on the line. If this solves the problem, reconnect the telephones one at a time, being sure to
use a microfilter on each telephone. If the microfilters are connected correctly, you can connect all your
telephones.
If disconnecting telephones does not result in a solid white DSL/Internet LED, a problem with your wiring
might exist. If the telephone company tested the DSL signal at your network interface device (NID), then
wiring in your house might be of poor quality.

DSL/Internet LED Is Off
If the DSL/Internet LED
is off, the modem router cannot connect to the Internet or to your Internet
service provider (ISP). To resolve the problem, you can try the following steps.

To reenable the modem router to connect to the Internet or your ISP:
1. If you are using a DSL connection to your ISP, do the following:
a. Disconnect all telephones on the line. If this solves the problem, reconnect the telephones one at
a time, being sure to use a microfilter on each telephone. If the microfilters are connected correctly,
you can connect all your telephones.
b. Check to see that the telephone company made the connection to your line and tested it.
c. Verify that you are connected to the correct telephone line. If more than one phone line is installed,
be sure that you are connected to the line with the DSL service. It might be necessary to use a
swapper if your DSL signal is on pins 1 and 4 or the RJ-11 jack. The modem router uses pins 2 and
3.
2. If you are using a cable connection to your ISP, check to see if all cable connections between the modem
router and the cable modem are good. All cables should be fully inserted in the ports.
3. Check to see that your login credentials are correct or that the information you entered for the ISP
connection is correct.
For more information, see one of the following sections:
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•

Manually Set Up an ADSL Internet Connection on page 36

•

Manually Set Up a VDSL Internet Connection on page 44

•

Manually Set Up a Cable Internet Connection on page 51

4. Check to see if your ISP is experiencing a problem—it might not be that the modem router cannot
connect to the Internet, but rather that your ISP cannot provide an Internet connection.

Obtain an Internet IP Address
If the modem router cannot access the Internet but the DSL/Internet LED
lights solid white, see if the
modem router can obtain an Internet IP address from the ISP. Unless the modem router is assigned a static
IP address, the modem router requests an IP address from the ISP. You can determine whether the request
was successful using the modem router web pages.

To check the Internet IP address:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED.
The ADVANCED Home page displays.
5. In the Internet Port pane, check to see that the IP Address field shows a valid IP address.
If the field shows 0.0.0.0, your modem router did not obtain an IP address from your ISP.
If your modem router cannot obtain an IP address from the ISP, the problem might be one of the following:
•

Your Internet service provider (ISP) might require a login program. Ask your ISP whether they require
PPP over Ethernet (PPPoE) or some other type of login.

•

If you selected a login program, the service name, user name, or password could be incorrectly set.
Before you make any changes, verify that the modem router can get a PPPoE, PPPoA, PPTP, or L2TP
connection (see Verify the PPPoE, PPPoA, PPTP, or L2TP Connection on page 255).

•

Your ISP might check for your computer’s host name. Assign the computer host name of your ISP
account as the account name. For more information, see one of the following sections:
-

Manually Set Up an ADSL Internet Connection on page 36

-

Manually Set Up a VDSL Internet Connection on page 44

-

Manually Set Up a Cable Internet Connection on page 51
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•

If your ISP allows only one Ethernet MAC address to connect to Internet and checks for your computer’s
MAC address, inform your ISP that you bought a new network device and ask them to use the modem
router’s MAC address.

•

Configure your modem router to clone your computer’s MAC address. For more information, see one
of the following sections:
-

Manually Set Up an ADSL Internet Connection on page 36

-

Manually Set Up a VDSL Internet Connection on page 44

-

Manually Set Up a Cable Internet Connection on page 51

Verify the PPPoE, PPPoA, PPTP, or L2TP Connection
If you use a PPPoE, PPPoA, PPTP, or L2TP connection to your ISP, make sure that the connection works.

To verify that your PPPoE, PPPoA, PPTP, or L2TP connection is working:
1. Launch a web browser from a computer or mobile device that is connected to the network.
2. Enter http://www.routerlogin.net.
A login window opens.
3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and password are
case-sensitive.
The BASIC Home page displays.
4. Select ADVANCED.
The ADVANCED Home page displays.
5. In the Internet Port pane, check to see that the IP Address field shows a valid IP address and that the
Connection field shows the protocol that your connection is using (PPPoE, PPPoA, PPTP, or L2TP).
6. In the Internet Port pane, click the Connection Status button.
The Connection Status page displays.
7. Check the following:
•
•

The Connection Status field shows Connected.
The Connection Time field does not show 00:00:00.

8. If the Connection Status field does not show Connected, try to reconnect by clicking the Connect button.
If the PPPoE, PPPoA, PPTP, or L2TP connection is not working, make sure that your service name, user
name, and password are set correctly. Or your ISP might not be able to provide an Internet connection. For
more information, see one of the following sections:
•

Specify an ADSL Connection With a Login and PPPoA or PPPoE Service on page 39

•

Specify a VDSL Connection With a Login and PPPoE Service on page 47
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•

Specify a Cable Connection With a Login and PPPoE Service on page 55

•

Specify a Cable Connection With a Login and PPTP or L2TP Service on page 59

Troubleshoot Internet Browsing
If your modem router can obtain an IP address but your computer is unable to load any web pages from the
Internet, it might be for one of the following reasons:
•

The traffic meter is enabled, and the limit was reached.
By configuring the traffic meter not to block Internet access when the traffic limit is reached, you can
resume Internet access (see Unblock the Traffic Meter After the Traffic Limit Is Reached on page 210).
If your ISP sets a usage limit, they might charge you for the overage.

•

Your computer might not recognize any DNS server addresses.
A DNS server is a host on the Internet that translates Internet names (such as www addresses) to
numeric IP addresses. Typically your ISP provides the addresses of one or two DNS servers for your
use. If you entered a DNS address when you set up the modem router, reboot your computer and verify
the DNS address. Alternatively, you can configure your computer manually with DNS addresses, as
explained in your operating system documentation.

•

The modem router might not be configured as the TCP/IP router on your computer.
For information about TCP/IP problems, see Troubleshoot Your Network Using the Ping Utility on page
257.
If your computer obtains its information from the modem router by DHCP, reboot the computer and
verify the modem router address.

Changes Are Not Saved
If the modem router does not save the changes that you make on a modem router web page, do the following:
•

When entering configuration settings, always click the Apply button before moving to another page or
tab or your changes are lost.

•

Click the Refresh or Reload button in the web browser. It is possible that the changes occurred but
that the old settings remain in the web browser’s cache.

Troubleshoot the WiFi Connectivity
If you are experiencing trouble connecting over WiFi to the modem router, try to isolate the problem:
•

Make sure that the WiFi settings in your WiFi device and modem router match exactly.
For a device that is connected over WiFi, the WiFi network name (SSID) and WiFi security settings of
the modem router and WiFi computer must match exactly. The default SSID and password are on the
modem router label (see Product Label on page 14).

•

Does the WiFi device that you are using find your WiFi network?
If not, check the WiFi LEDs on the top of the modem router. If these LEDs are off, the WiFi radios might
be disabled. For more information about the WiFi radios, see Control the WiFi Radios on page 102 and
Set Up a WiFi Schedule on page 214.

Troubleshooting
256

AC5300 WiFi VDSL/ADSL Modem Router Model D8500

•

If you disabled the modem router’s SSID broadcast, your WiFi network is hidden and does not display
in your WiFi client’s scanning list. (By default, SSID broadcast is enabled.) For more information, see
Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 86.

•

Does your WiFi device support the security that you are using for your WiFi network (WEP, WPA, or
WPA2)? For information about changing the WiFi security, see Manage the Basic WiFi Settings and
WiFi Security of the Main Network on page 86.
Tip If you want to change the WiFi settings of the modem router’s main network, use a wired
connection to avoid being disconnected when the new WiFi settings take effect.

If your WiFi device finds your network but the signal strength is weak, check these conditions:
•

Is your modem router too far from your WiFi device or too close? Place your WiFi device near the modem
router but at least 6 feet (1.8 meters) away and see whether the signal strength improves.

•

Are objects between the modem router and your WiFi device blocking the WiFi signal?

Troubleshoot Your Network Using the Ping Utility
Most network devices and routers contain a ping utility that sends an echo request packet to the designated
device. The device then responds with an echo reply. You can easily troubleshoot a network using the ping
utility in your computer or workstation.

Test the LAN Path to Your Modem Router
You can ping the modem router from your computer to verify that the LAN path to your modem router is set
up correctly.

To ping the modem router from a Windows computer:
1. From the Windows taskbar, click the Start button and select Run.
2. In the field provided, enter ping followed by the IP address of the modem router, as in this example:
ping 192.168.0.1
3. Click the OK button.
A message such as the following one displays:
Pinging <IP address> with 32 bytes of data

If the path is working, you see this message:
Reply from < IP address >: bytes=32 time=NN ms TTL=xxx

If the path is not working, you see this message:
Request timed out

If the path is not functioning correctly, one of the following problems might be occurring:
•

Wrong physical connections
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For a wired connection, make sure that the numbered LAN LED is lit for the port to which you are
connected.
Check that the appropriate LEDs are on for your network devices. If your modem router and computer
are connected to a separate Ethernet switch, make sure that the link LEDs are lit for the switch ports
that are connected to your computer and modem router.
•

Wrong network configuration
Verify that the Ethernet card driver software and TCP/IP software are both installed and configured on
your computer.
Verify that the IP address for your modem router and your computer are correct and that the addresses
are on the same subnet.

Test the Path From Your Computer to a Remote Device
After you verify that the LAN path works correctly, test the path from your computer to a remote device.

To test the path from your computer to a remote device:
1. From the Windows toolbar, click the Start button and select Run.
2. In the field provided, enter ping -n 10 IP address.
IP address is the IP address of a remote device such as your ISP’s DNS server.
If the path is functioning correctly, replies as described in Test the LAN Path to Your Modem Router on page
257 display. If you do not receive replies, do the following:
•

Check to see that the IP address of your modem router is listed as the default router in your computer.
If the IP configuration of your computer is assigned by DHCP, this information is not visible in your
computer’s Network Control Panel. Verify that the IP address of the modem router is listed as the default
router.

•

Check to see that the network address of your computer (the portion of the IP address specified by the
netmask) is different from the network address of the remote device.

•

If your ISP assigned a host name to your computer, enter that host name as the account name. For
more information, see one of the following sections:

•

-

Manually Set Up an ADSL Internet Connection on page 36

-

Manually Set Up a VDSL Internet Connection on page 44

-

Manually Set Up a Cable Internet Connection on page 51

Your ISP might be rejecting the Ethernet MAC addresses of all but one of your computers.
Many broadband ISPs restrict access by allowing traffic only from the MAC address of your modem,
but some additionally restrict access to the MAC address of a single computer connected to that modem.
In this case, configure your modem router to clone or spoof the MAC address from the authorized
computer. For more information, see one of the following sections:
-

Manually Set Up an ADSL Internet Connection on page 36

-

Manually Set Up a VDSL Internet Connection on page 44

-

Manually Set Up a Cable Internet Connection on page 51
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Supplemental Information

This appendix covers the following topics:
•

Factory Settings on page 260

•

Technical Specifications on page 262
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AC5300 WiFi VDSL/ADSL Modem Router Model D8500

Factory Settings
You can reset the modem router to the factory default settings that are shown in the following table.
For more information about resetting the modem router to its factory settings, see Return the Modem Router
to Its Factory Default Settings on page 189.

Table 4. D8500 modem router factory default settings
Feature

Default Setting

Router login
User login URL

www.routerlogin.net (or www.routerlogin.com or 192.168.0.1)

User name (case-sensitive)

admin

Login password
(case-sensitive)

password

Internet connection
WAN MAC address

Use default hardware address

WAN MTU size

Determined by the protocol that is used for the Internet connection (see MTU
Concepts on page 77)

Port speed

Autosensing

Local network (LAN)
LAN IP address

192.168.0.1

Subnet mask

255.255.255.0

DHCP server

Enabled

DHCP range

192.168.0.2 to 192.168.0.254

DHCP starting IP address

192.168.0.2

DHCP ending IP address

192.168.0.254

DMZ

Disabled

Time zone

North America: Pacific Standard Time
Europe: GMT
Other continents: Varies by region

Time adjusted for daylight
saving time

Disabled

Firewall
Inbound (communications
coming in from the Internet)

Disabled (except traffic on port 80, the HTTP port)
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Table 4. D8500 modem router factory default settings (Continued)
Feature

Default Setting

Outbound (communications
going out to the Internet)

Enabled (all)

Source MAC filtering

Disabled

Main WiFi networks
WiFi communication

Enabled

SSID name

See modem router label

Security

WPA2-PSK (AES)

WiFi passphrase

See modem router label

Country/region

North America: United States
Europe: Europe
Other continents: Varies by region

RF channel

Auto. The available channels depend on the region.

Transmission speed

Auto
Note that the throughput can vary. Network conditions and environmental factors,
including volume of network traffic, building materials and construction, and network
overhead, affect the data throughput rate.

Operating mode

Up to 1000 Mbps at 2.4 GHz
Up to 2165 Mbps at 5 GHz (both 5 GHz bands)

Transmit power

100%

Guest WiFi networks
WiFi communication

Disabled

SSID name

2.4 GHz band: NETGEAR-Guest
First 5 GHz band: NETGEAR-5G-Guest
Second 5 GHz band: NETGEAR-5G-2-Guest

Security

None (open network)

Allow guests to access main
network

Disabled

General WiFi settings
Radio transmission power

100%

20/40 MHz coexistence

Enabled

Supplemental Information
261

AC5300 WiFi VDSL/ADSL Modem Router Model D8500

Table 4. D8500 modem router factory default settings (Continued)
Feature

Default Setting

Fragmentation length

2346

CTS/RTS threshold

2347

Preamble mode

Automatic

WPS
WPS capability

Enabled

Modem router’s PIN

Enabled; see the modem router web pages (select ADVANCED > Advanced
Setup > Wireless Settings)

Keep Existing Wireless
Settings

Enabled

Technical Specifications
Table 5. D8500 modem router specifications
Feature

Description

Data and routing protocols

TCP/IP, RIP-1, RIP-2, DHCP, PPPoE, PPPoA, PPTP, L2TP, Dynamic DNS, UPnP,
and SMB

Power adapter

North America: 100V, 50/60 Hz, input
UK, Australia: 220V, 50/60 Hz, input
Europe: 100–240V, 50/60 Hz, input
All regions: 19V @ 3.16 ADC output

Dimensions

Dimensions: 316 x 264 x 62 mm (12.44 x 10.39 x 2.44 in.)

Weight

Weight: 2.27 kg (5.0 lb)

Operating temperature

0° to 40°C (32º to 104ºF)

Operating humidity

90% maximum relative humidity, noncondensing

Electromagnetic emissions

EN 55 022 (CISPR 22), Class B C-Tick N10947

DSL

One RJ-11 asynchronous DSL (ADSL/VDSL) port

WAN

One RJ-45 port supporting 10BASE-T, 100BASE-TX, and 1000BASE-T

LAN

Six RJ-45 ports supporting 10BASE-T, 100BASE-TX, and 1000BASE-T

USB

One UDB 3.0 port and one USB 2.0 port
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Table 5. D8500 modem router specifications (Continued)
Feature

Description

WiFi

Maximum WiFi signal rate complies with the IEEE 802.11 standard.
Note that the throughput can vary. Network conditions and environmental factors,
including volume of network traffic, building materials and construction, and network
overhead, affect the data throughput rate.

Radio data rates

Auto-rate sensing

Data encoding standards

EEE® 802.11 b/g/n 2.4 GHz 1024 QAM support
IEEE® 802.11 a/n/ac 5.0 GHz 1024 QAM support

Maximum computers per WiFi Limited by the amount of WiFi network traffic generated by each node (typically
network
50–70 nodes)
Operating frequency range

2.4 GHz band:
•

US: 2.412–2.462 GHz

•

Europe: 2.412–2.472 GHz

•

Australia: 2.412–2.472 GHz

•

Japan: 2.412–2.472 GHz

5 GHz band:
•

US: 5.18–5.24 + 5.745–5.825 GHz and DFS (5.25–5.35 + 5.50–5.70)

•

Europe: 5.18–5.24 GHz and DFS (5.25–5.35 + 5.50–5.70)

•

Australia: 5.18–5.24 + 5.745–5.825 GHz and DFS (5.25–5.35 + 5.50–5.70)

•

Japan: 5.18–5.24 GHz and DFS (5.25–5.35 + 5.50–5.70)
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Table 5. D8500 modem router specifications (Continued)
Feature

Description

802.11 security

WPA2-PSK, WPA-PSK, WPA/WPA2 (mixed mode), WPA/WPA2 Enterprise, and
WEP

xDSL data rate

VDSL2, VDSL, ADSL2+, ADSL2, and ADSL multimode
Up to 100 Mbps, both upstream and downstream
Supports Annex A, L, and M
Supports all VDSL2 profiles: 8a, 8b, 8c, 8d, 12a, 12b, and 17a
VDSL2 interface compliance with ITU-T993.2
G.992.1 (G.dmt), Annex A compliant
G.992.2 (G.lite), Annex A compliant
ANSI T1.413 compliant
G.992.3 (ADSL2) compliant, Annex A, L, and M
G.992.5 (ADSL2+) compliant, supporting Annex A and M
G.993.2 compliant, Annex A
G.993.5 (Vectoring)
ATM and PTM (dual-priority)

Note For more information, see the data sheet for the D8500 modem router, which is
available at downloadcenter.netgear.com.
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